Administrator Guide

Version 7.0 Service Pack 2
THIS SOFTWARE AND DOCUMENTATION ARE PROVIDED “AS IS” AND WITHOUT EXPRESS OR LIMITED WARRANTY OF ANY KIND BY EITHER MICROSTRATEGY INCORPORATED OR ANYONE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE OR DOCUMENTATION, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, GOOD TITLE AND NONINFRINGEMENT, QUALITY OR ACCURACY. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE AND DOCUMENTATION IS WITH YOU. SHOULD THE SOFTWARE OR DOCUMENTATION PROVE DEFECTIVE, YOU (AND NOT MICROSTRATEGY, INC. OR ANYONE ELSE WHO HAS BEEN INVOLVED WITH THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE OR DOCUMENTATION) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

In no event will MicroStrategy, Inc. or any other person involved with the creation, production, or distribution of the Software be liable to you on account of any claim for damage, including any lost profits, lost savings, or other special, incidental, consequential, or exemplary damages, including but not limited to any damages assessed against or paid by you to any third party, arising from the use, inability to use, quality, or performance of such Software and Documentation, even if MicroStrategy, Inc. or any such other person or entity has been advised of the possibility of such damages, or for the claim by any other party. In addition, MicroStrategy, Inc. or any other person involved in the creation, production, or distribution of the Software shall not be liable for any claim by you or any other party for damages arising from the use, inability to use, quality, or performance of such Software and Documentation, based upon principles of contract warranty, negligence, strict liability for the negligence of indemnity or contribution, the failure of any remedy to achieve its essential purpose, or otherwise. The entire liability of MicroStrategy, Inc. and your exclusive remedy shall not exceed, at the option of MicroStrategy, Inc., either a full refund of the price paid, or replacement of the Software. No oral or written information given out expands the liability of MicroStrategy, Inc. beyond that specified in the above limitation of liability. Some states do not allow the limitation or exclusion of liability for incidental or consequential damages, so the above limitation may not apply to you.

The information contained in this manual (the Documentation) and the Software are copyrighted and all rights are reserved by MicroStrategy, Inc. MicroStrategy, Inc. reserves the right to make periodic modifications to the Software or the Documentation without obligation to notify any person or entity of such revision. Copying, duplicating, selling, or otherwise distributing any part of the Software or Documentation without prior written consent of an authorized representative of MicroStrategy, Inc. are prohibited. U.S. Government Restricted Rights. It is acknowledged that the Software and Documentation were developed at private expense, that no part is public domain, and that the Software and Documentation are Commercial Computer Software provided with RESTRICTED RIGHTS under Federal Acquisition Regulations and agency supplements to them. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFAR 252.227-7013 et. seq. or subparagraphs (c)(1) and (2) of the Commercial Computer Software—Restricted Rights at FAR 52.227-19, as applicable. Contractor is MicroStrategy, Inc., 8000 Towers Crescent Drive, Vienna, Virginia 22182. Rights are reserved under copyright laws of the United States with respect to unpublished portions of the Software.


093601100   Published November 2000
## Contents

**Administrator Overview**  xiii  
Using this guide  xiv  

### Section I  Administrator concepts  1

#### Chapter 1  Administration Fundamentals  3

- MicroStrategy Intelligence Server service  3
  - MicroStrategy Intelligence Server startup  3
  - MicroStrategy Intelligence Server shutdown  4
- Governing  4
  - Server level governors  4
  - Project level governors  5
- Project registration  5
- Project modes  5
  - Loaded  6
  - Execution idle  6
  - Request idle  6
  - Full idle  6
  - Unload pending  6
  - Unloaded  7
- Monitoring  7
- History list  7
- To learn about...  8

#### Chapter 2  Database Connectivity  9

- Basic database structure  9
- Communicating with databases  10
- Centralized database access control  11
- Databases and MicroStrategy Intelligence Server  12
  - Database instance  12
  - VLDB properties  13
- Database connection caching  14
- To learn about...  14

#### Chapter 3  Job Processing  17

- Job processing system overview  17
  - User requests  18
  - Tasks and components  18
  - Job processing flow  19
- Report execution  20
  - Basic report execution  21
Report execution with caching 22
Report execution with a prompt 23
Drilling 24
Object browsing 25
Element browsing 25
Document execution 25
Job execution from MicroStrategy Web 26
Job prioritization 26
   Defining job prioritizations 27
To learn about... 28

Chapter 4  Security 29
Database level security 29
   Security views 30
   Partitioned fact tables 30
   Split fact tables 31
Network and operating system security 32
MicroStrategy Intelligence Server authentication modes 32
   Standard authentication 32
   Windows NT authentication 33
   Anonymous authentication 33
   Database authentication 33
MicroStrategy Intelligence Server access control 34
   Privileges 34
   Permissions 34
   User and group administration 36
   Security roles 37
   Security filters 37
   Connection mapping 38
To learn about... 38

Chapter 5  Caching 41
Introduction to caching 41
Caching job results 42
   Where are caches stored? 42
   Job execution with caching 42
Pre-calculated data 43
Database connection caching 43
Cache administration 44
To learn about... 44

Chapter 6  Scheduling 45
Scheduling introduction 45
Report scheduling 45
   Time-triggered report scheduling 46
Chapter 13  Database Instance Manager  75
Database Instance Manager layout  76

Chapter 14  Database Instance Wizard  77
Database Instance Wizard layout  78
  Introduction  78
  Database Instance Definition  78
  Database Connection Definition  78
  Summary  78

Chapter 15  Diagnostics Configuration Editor  79
Diagnostics Configuration Editor layout  80
  Diagnostics Configuration Editor: Trace tab  80
  Diagnostics Configuration Editor: Advanced tab  80
  Diagnostics Configuration Editor: Errors tab  81
Diagnostics Configuration Editor toolbar and menu options  81

Chapter 16  Event Viewer  83
Event Viewer layout  83
Event Viewer toolbar and menu options  84

Chapter 17  Group Editor  85
Group Editor layout  86
  Group Editor: General tab  86
  Group Editor: Privileges tab  86

Chapter 18  Job Monitor  87
Job Monitor layout  88

Chapter 19  Job Prioritization Wizard  91
Job Prioritization Wizard layout  92
  Priority Options  92
  Priority By Job Cost  93
  Priority By User Group  93
  Priority By Project  93
  Summary  93

Chapter 20  MicroStrategy Server Configuration Editor  95
MicroStrategy Server Configuration Editor layout  96
  MicroStrategy Server Configuration Editor: General tab  96
  MicroStrategy Server Configuration Editor: Advanced tab  96
  MicroStrategy Server Configuration Editor: Projects tab  97

Chapter 21  MicroStrategy Intelligence Server Service
Manager 99

Chapter 22 MicroStrategy Web Administrator page 101
Administrator page layout 102
  Connected servers list 102
  Unconnected servers list 103
  Available servers list 104
  Web Server box 104

Chapter 23 Project Configuration Editor 105
Project Configuration Editor layout 106
  Project Configuration Editor: General tab 107
  Project Configuration Editor: Governing tab 107
  Project Configuration Editor: Caching tab 107
  Project Configuration Editor: Connection Mapping tab 108
  Project Configuration Editor: Statistics tab 108
  Project Configuration Editor: Security Roles tab 108
  Project Configuration Editor: Security Filter tab 108
  Project Configuration Editor: SQL Generation tab 109
  Project Configuration Editor: Advanced tab 109

Chapter 24 Project Monitor 111
Project Monitor layout 112

Chapter 25 Project Mover Wizard 113
Project Mover Layout 114
  Introduction 114
  Transfer Options 114
  Project Selection 114
  Metadata Repository Location 114
  Warehouse Location 115
  Metadata Repository Connection 115
  Summary 115

Chapter 26 Schedule Manager 117
Schedule Manager layout 118

Chapter 27 Schedule Monitor 119
Schedule Monitor layout 120

Chapter 28 Schedule Wizard 123
Schedule Wizard layout 124
  Welcome 124
  Name & Description 124
Chapter 29  Security Role Editor 127
Security Role Editor layout 127

Chapter 30  User Connection Monitor 129
User Connection Monitor layout 130

Chapter 31  User Editor 131
User Editor layout 132
User Editor: General tab 132
User Editor: Privileges tab 132
User Editor: Groups tab 132

Chapter 32  User Manager 133
User Manager layout 134

Chapter 33  User Manager Integrity Checker 135
User Manager Integrity Checker layout 135

Section III  How do I...? 137

Chapter 34  Access control lists 139
Modify an object’s access control list 139
Take ownership of an object 139
View an object’s access control list 139

Chapter 35  Caches 141
Configure cache memory usage 141
Configure caching in a MicroStrategy Intelligence Server cluster 141
Configure report cache duration 142
Delete a report cache 142
Disable MicroStrategy Intelligence Server caching 143
Enable MicroStrategy Intelligence Server caching 143
Load a report cache from disk 143
Unload a report cache to disk 144
Chapter 36 Database Connections 145
Change the default database login for a database connection 145
Change the default ODBC DSN for a database connection 145
Create a database connection 146
Delete a database connection 146
Disconnect a connection to a database 147
Modify a database connection 147
Modify advanced ODBC options for a database connection 147
Modify database connection caching options 148
Rename a database connection 148

Chapter 37 Database Instances 149
Change the default database connection for a database instance 149
Create a database instance 149
Create a database instance with the Database Instance Editor 149
Create a database instance with the Database Instance Wizard 150
Delete a database instance 151
Modify a database instance 151

Chapter 38 Database logins 153
Change the database login for particular user 153
Create a database login 153
Delete a database login 154
Modify a database login 154

Chapter 39 Diagnostics 157
Color code information in a log file 157
Create a log file 158
Filter information in a log file 158
Save a log file 159
Save a log file color code 159
Save a log file filter 160
Save a log file sort 160
Sort information in a log file 160
View active tracing information 161

Chapter 40 Governors 163
Limit report execution time 163
Limit the number of jobs per project 163
Limit the number of jobs per user account 163
Limit the number of jobs per user session 164
Limit the number of user sessions per project 164
Chapter 41 Groups 165
Add members to a group 165
Create a group 165
Import a group from Windows NT 166
Import users and groups from a text file 166
Modify a group 167
Remove members from a group 168

Chapter 42 Job prioritizations 169
Create a job prioritization 169
Create a job prioritization based on cost 170
Create a job prioritization based on group 170
Create a job prioritization based on project 171
Delete a job prioritization 171
Modify a job prioritization 172

Chapter 43 Jobs 173
Cancel an executing job 173

Chapter 44 MicroStrategy Intelligence Servers 175
Add an additional MicroStrategy Intelligence Server to a cluster 175
Allow anonymous access to a MicroStrategy Intelligence Server 175
Configure MicroStrategy Intelligence Server 176
Display a list of available MicroStrategy Intelligence Servers with Test Listener 176
Ping a MicroStrategy Intelligence Server with Test Listener 176
Remove a MicroStrategy Intelligence Server from a cluster 177
Refresh MicroStrategy Intelligence Server status 177
Start MicroStrategy Intelligence Server 177
Stop MicroStrategy Intelligence Server 178
View details about a MicroStrategy Intelligence Server using Test Listener 178
View the MicroStrategy Intelligence Server workload 178

Chapter 45 MicroStrategy Web 179
Connect MicroStrategy Web to a MicroStrategy Intelligence Server 179
Disconnect MicroStrategy Web from a MicroStrategy Intelligence Server 180

Chapter 46 Passwords 181
Change a user’s password 181
Configure password expiration criteria 181

Chapter 47 Projects 183
Change a project’s status 183
Configure a project 183
Allow anonymous access to a project 183
Load a project 184
Register a 6.x project 184
Register a MicroStrategy Desktop project 184
Unload a project 185

Chapter 48 Schedules 187
Create a schedule 187
Create a time-triggered schedule 187
Create an event 188
Create an event-triggered schedule 188
Delete a schedule 189
Delete a schedule request 189
Delete an event 189
Modify a schedule 190
Rename a schedule 190
Rename an event 190
Trigger an event 191

Chapter 49 Security Filters 193
Apply a security filter to a user 193

Chapter 50 Security roles 195
Apply a security role to a group 195
Apply a security role to a user 195
Create a security role 196
Delete a security role 196
Modify a security role 197
Rename a security role 197

Chapter 51 SQL 199
View SQL for an executing job 199

Chapter 52 Statistics 201
Configure statistics collection 201
Purge statistics 201

Chapter 53 Users 203
Create a user 203
Delete a user 203
Disable a user 203
Disconnect a user 204
Enable a user 204
Import a user from Windows NT 204
Link a user to a Windows NT user 205
Modify a user 205

Section IV  Appendixes 207

Appendix A  Statistics 209
  The statistics schema 209
  Statistics table 211

Appendix B  Diagnostics 217
  Log files 217
  Performance counters 218
  Active tracing 218
  Sample log file 218

Appendix C  VLDB Properties 223
  VLDB Hierarchy 223
  VLDB Properties Editor 224
  VLDB Properties 226
    Analytical Engine 226
    Governing 226
    Indexing 227
    Joins 227
    Metrics 228
    Pre/Post Statements 230
    Query Optimizations 230
    Select/Insert 231
    Tables 232
    Default VLDB properties for specific databases 233

Appendix D  Permissions and Privileges 239
  Permission groupings 239
  Permissions for server objects 240
  Privileges 241

Appendix E  Administrative Utilities 245
  License Manager 245
    License Manager layout 246
    License Manager How do I . . . ? topics 246
  Log Viewer 248
    Log Viewer layout 249
    Log Viewer toolbar and menu options 249
  Test Listener 251
    Test Listener layout 252

Section V  Index 253
As the administrator of a MicroStrategy system you have numerous responsibilities such as:

• Installing and configuring the system
• Creating and enforcing security strategies
• Monitoring usage
• Maintaining stability
• Analyzing and improving performance
• Troubleshooting problems

MicroStrategy Intelligence Server provides you with the ability to monitor, control, and troubleshoot nearly every aspect of the system. It is the heart of the MicroStrategy architecture and allows you to:

• Manage and organize users, groups, projects, and database connections
• Coordinate and prioritize user requests
• Allocate the resources necessary to complete user requests
• Create schedules and manage schedule requests
• Manage security
• Monitor and analyze the daily activity of the system

The easiest way to understand all that you can do with MicroStrategy Intelligence Server is to view it as a collection of sub-systems. Each subsystem provides you with the ability to control a different area of the overall system. A short description of each sub-system is listed below:

• Database connectivity: Controls all connections to databases.
• Job processing: Responsible for processing most user requests, including object browsing, report processing, and element browsing.
• Monitoring and administration: Allows you to monitor all system activity and respond to potential problems or emergencies.
• Security: Provides a complete security architecture that allows you to easily control access to the system at a variety of different levels.
• Caching: Speeds up processing time by storing previously accessed information for later use. Everything from result sets to object definitions to database connections can be cached.

• Scheduling: Allows you to schedule reports to run at certain times or after the occurrence of certain events.

• Clustering: Allows you to divide the system processing load across multiple machines for increased performance. In addition, the clustering sub-system is responsible for handling a variety of failures with minimal loss of data and with little effect on the end user.

• MicroStrategy Web administration: Most MicroStrategy Web administrative tasks are handled by MicroStrategy Intelligence Server functionality; however, there are a few tasks that you will need to perform in MicroStrategy Web.

Using this guide

This guide is a resource for every task you have to complete. This guide is divided into the following sections:

• **Concepts.** This section provides you with the key concepts about the objects you are working with.

• **Interface.** Refer to this section for interface-specific information. This section explains the interfaces you are using to create objects such as attributes, facts, hierarchies, partition mappings, and transformations.

• **How do I.** This is where procedural information is found. This section provides the answers to the How do I? questions you encounter while using MicroStrategy Desktop.
Topics for this section include:

- Administration fundamentals
- Database connectivity
- Job processing
- Security
- Caching
- Scheduling
- Clustering
- Web administration
- MicroStrategy Object Manager
CHAPTER 1

Administration Fundamentals

Basic administration topics include:

• MicroStrategy Intelligence Server service
• governing
• project registration
• project modes
• monitoring
• history list

MicroStrategy Intelligence Server service

MicroStrategy Intelligence Server runs as a Windows NT service. This allows you to start up and shut down MicroStrategy Intelligence Server from a remote machine. In addition, you can configure the service to start automatically when the machine on which it is running starts up.

Once the service is started, it is designed to run constantly. However, there are a variety of different reasons why it may need to be shut down and restarted from time to time. Routine maintenance on the MicroStrategy Intelligence Server machine, potential power outages due to storms or planned building maintenance, and user error are all reasons why MicroStrategy Intelligence Server may need to be shut down and restarted. Additionally, you must restart the server any time you change a server-level setting such as changing a governor or registering a project.

MicroStrategy Intelligence Server startup

When MicroStrategy Intelligence Server starts it recovers its previous state from the most recent backup files, if they exist.
MicroStrategy Intelligence Server shutdown

When MicroStrategy Intelligence Server shuts down, all projects are idled immediately. It stops accepting new client requests and cancels all currently executing jobs. These canceled jobs are saved and will be executed when MicroStrategy Intelligence Server starts up again.

During the shutdown process the MicroStrategy Intelligence Server service is stopped and all projects are unloaded from the server. The current server state is captured and saved to disk so it can be restored when the server starts again.

---

**Note:** In the event of a system or power failure, MicroStrategy Intelligence Server cannot capture its current state. The next time the server is started, it will use the state information from the last complete backup.

---

Governing

A **governor** is a setting that prevents a job from executing or prevents a user from making a connection when certain conditions exist. Governors are used to limit users’ access to system resources and to provide a way of controlling the MicroStrategy environment.

For example, a user may inadvertently execute a complex report that takes an hour to run and returns five million rows. Such a report could cause a number of problems by tying up resources in the data warehouse, in MicroStrategy Intelligence Server, and in the network. To avoid such problems, governors limit factors such as the amount of time that any one job may take to execute and the amount of rows that a job may return. MicroStrategy Intelligence Server checks all incoming jobs to make sure they comply with the governors and rejects any jobs that exceed the thresholds defined by these governors.

Governors may apply at the following levels within the system:

- Server-level governors apply to all jobs processed by MicroStrategy Intelligence Server, regardless of project.
- Project-level governors apply to all jobs submitted for a given project, regardless of the user who submitted the job.

In addition to these governors, there is a governor set in the VLDB Properties Editor which limits the maximum number of rows that can be returned to the Analytical Engine from the database.

Server level governors
Using the MicroStrategy Intelligence Server Configuration Editor, you can set the following server level governors:

- maximum number of jobs
- maximum number of client connections
- user session idle time

**Project level governors**

Using the Project Configuration Editor, you can set the following project level governors:

- warehouse result set governing
  - report execution time
  - number of result rows
- job governing
  - jobs per user account
  - jobs per user session
  - jobs per project
- user session governing
  - user sessions per project

**Project registration**

Once a project is created, it must be registered with MicroStrategy Intelligence Server. Users cannot access a project until it has been registered. You register projects using the MicroStrategy Intelligence Server Configuration Editor.

When you register a project, you can choose to have the project load at startup. This means that the project is automatically loaded every time the server starts.

**Project modes**

Each project registered with MicroStrategy Intelligence Server may operate in one of several modes. **Project modes** allow for various system administration tasks to occur without interrupting MicroStrategy Intelligence Server operation for other projects. You use the Project Monitor to change a project’s mode at any time.

The different project modes are:

- loaded
• execution idle
• request idle
• full idle
• unload pending
• unloaded

**Loaded**

This is the typical project mode. When a project is loaded, MicroStrategy Intelligence Server accepts requests from users and submits jobs to the database for processing.

**Execution idle**

In this mode, MicroStrategy Intelligence Server continues to accept requests from clients for the project but does not submit any SQL to the database. All database connections associated with the project are closed. This mode allows you to perform maintenance tasks on the warehouse while users continue to access non-database dependent functionality.

For example, users can run cached reports, but they will not be able to drill because drilling requires additional SQL to be submitted to the warehouse.

**Request idle**

In this mode, MicroStrategy Intelligence Server stops accepting new user requests from clients for the project. However, jobs that are already being processed continue to be processed and SQL is submitted to the database.

**Full idle**

In this mode, users cannot access the project and no jobs from the project can be sent to the database. Users cannot submit requests to MicroStrategy Intelligence Server and all database connections associated with the project are closed. Once all connections are closed, MicroStrategy Intelligence Server makes a complete backup of all necessary files.

**Unload pending**
This mode occurs when you have requested to unload the project, but MicroStrategy Intelligence Server is creating a backup. No new requests are accepted. As soon as the backup is created, the project mode changes to unloaded.

**Unloaded**

In this mode, the project is completely off-line. Nothing can be done in the project until it is loaded again.

**Monitoring**

You can monitor MicroStrategy Intelligence Server using the monitoring tools provided by MicroStrategy Desktop. These tools allow you view the current state of the server across all projects:

- **Job Monitor** allows you to view the status of all currently executing jobs.
- **Project Monitor** allows you to view the status of all registered projects.
- **User Connection Monitor** allows you to view the status of all connected users.
- **Database Connection Monitor** allows you to view the status of all connections to databases.
- **Schedule Monitor** allows you to view the status of all schedules.
- **Cache Monitor** allows you to view the status of all report caches.
- **Cluster Monitor** allows you to view the status of clustered MicroStrategy Intelligence Servers.

For more information about these monitoring tools, see the related topics in the Interfaces section.

**History list**

The history list is a folder where messages about the status of a report execution request can be stored. You can find the history list in a project’s Folder List. The most common uses of the history list are:

- MicroStrategy Intelligence Server uses the history list to notify users when a scheduled report is complete.
- If a user executes a report but exits MicroStrategy Desktop or MicroStrategy Web before the report is finished, a message will appear in the user’s history list allowing him to retrieve the results the next time he logs in.
• A user may wish to execute a report, but does not want to immediately see the results; he wants to cache the results for analysis later. To do this in MicroStrategy Desktop, right-click the report and select Send to History. In MicroStrategy Web, run the report and select Add to History List.

If the report execution is successful, the history list message contains a link to the results of the report; if the report execution failed, a short description of the error is included in the message.

To learn about...

...the editors, wizards and monitors used to perform fundamental administration tasks, see the following Interfaces topics:

• Cache Monitor
• Cluster Monitor
• Database Connection Monitor
• Job Monitor
• MicroStrategy Intelligence Server Configuration Editor
• MicroStrategy Intelligence Server Service Manager
• Project Configuration Editor
• Project Monitor
• Schedule Monitor
• User Connection Monitor

...fundamental administration tasks you can perform using MicroStrategy Desktop, see the following How do I...? topics:

• Governors
• MicroStrategy Intelligence Servers
• Projects
CHAPTER 2

Database Connectivity

Database connectivity topics include:
- Basic database structure
- Communicating with databases
- Centralized database access control
- Databases and MicroStrategy Intelligence Server
- Databases connection caching

Basic database structure

Different databases may use different terminology to describe their particular architecture and organization, but for the most part, the basic terms and concepts remain the same for all database servers. For more specific information on a particular database, refer to the documentation provided by your database vendor.

The following terms and concepts are common to most databases:
- **Database server**: In general, database server software running on a particular machine is referred to as a “database server.” Though it is technically possible to have more than one database server running on a single machine, there is usually only one per machine.
- **Database**: A database server can have one or more databases. This is the level at which you usually interact with a database server.
- **Table**: A database typically contains one or more tables, although you can have an empty database. Tables are where data is stored.
- **System catalog**: Every database server has the concept of a system catalog. The catalog is a special set of tables, called system tables, that contain detailed information about the database server and the objects that it contains. Information stored in a catalog includes:
  - a list of all tables in the database server
  - the number of rows and columns that each table contains
  - whether or not a table has an index associated with it
  - security access rules
Every database has a catalog and some database servers keep a set of system tables for each database.

The basic structure of a database looks like this:

![Database structure diagram]

**Communicating with databases**

**ODBC** (Open Database Connectivity) is the standard method of communicating with database servers. MicroStrategy Intelligence Server uses ODBC to connect to and communicate with all database servers in the system. There are four pieces to an ODBC connection:

- **Data source name**: A data source name (DSN) stores all of the necessary information for locating and logging into a database. A DSN generally includes such information as host machine name or IP address, instance name, and database name. The exact information included in a DSN varies depending on the type of database server.

- **ODBC driver**: An ODBC driver is a type of software that translates information between the client application (MicroStrategy Intelligence Server) and the database server API. Database servers “speak” through different APIs; Informix database servers use one API (Informix CLI), ORACLE database servers use a different API (Oracle SQL*Net), Sybase database servers use another, and so on.

- **Connection string**: A connection string stores the information required to connect to a database server. A connection string usually includes a DSN and the user ID and password required to log in to the database server. This information varies depending on the particular database server.
• **ODBC driver manager**: The ODBC driver manager coordinates communication between a client application and database server. The client application tells the driver manager that it needs to connect using a particular connection string. The DSN found in this connection string provides the driver manager with the type of database server to which the application needs access. From this information, the driver manager decides what driver to use and initiates the communication.

MicroStrategy software uses ODBC to access different types of databases like this:

Centralized database access control

All database connectivity is handled by MicroStrategy Intelligence Server, which provides centralized control of database access. The advantages of centralized control include:

• Connectionless client: All connections to databases in the system are made through MicroStrategy Intelligence Server. This means that only the MicroStrategy Intelligence Server machine needs to have database connectivity. It also eliminates the need to rely on identically configured connections on client and server machines. This makes it easy to set up, deploy, and manage large systems.

• Connection caching: Connecting to and disconnecting from databases incurs a small amount of overhead that may cause a small yet noticeable decrease in performance in high-concurrency systems. With connection caching, MicroStrategy Intelligence Server is able to reuse database connections. This minimizes the overhead associated with repeated connecting to and disconnecting from databases.
• Load balancing: Since only MicroStrategy Intelligence Server connects to databases, it can make sure that no single database becomes overloaded with user requests. This is particularly important for the data warehouse.

• User connection mapping: MicroStrategy Intelligence Server can map MicroStrategy users to database logins. This allows multiple users to access the database using a single database login.

• Ease of administration/monitoring: Since all database connectivity is handled by MicroStrategy Intelligence Server, it is easy to keep track of all connections to all databases in the system.

• Prioritized access to databases: You can set access priority based on user, project, estimated job cost, or any combination of these.

• Multi-process execution: The ability to run in multi-process mode means that if one process fails, such as a lost or hung database access thread, the others are not affected.

• Database optimizations: Using VLDB properties, MicroStrategy Intelligence Server is able to take advantage of the unique performance optimizations that different database servers offer.

## Databases and MicroStrategy Intelligence Server

In a typical system, MicroStrategy Intelligence Server connects to three databases:

• **Data warehouse** stores the data that users of the system need to analyze in order to track and respond to business trends and facilitate forecasting and planning efforts.

• **Metadata repository** stores the warehouse schema as well as project and MicroStrategy Intelligence Server configuration information.

• **Statistics database** stores a record of historical information about MicroStrategy Intelligence Server and system activity.

MicroStrategy Intelligence Server uses a database instance to connect to databases.

### Database instance

A **database instance** is the MicroStrategy Intelligence Server logical representation of a physical database in the system.

---

**Important:** Do not confuse MicroStrategy Intelligence Server database instances with the generally understood concept of a database server instance. Though they are related concepts, they are not the same thing.
A database instance stores the following information:

- Type of database represented by the database instance (such as Oracle, Teradata, Tandem, and so on)
- Maximum number of connections allowed for the database instance
- Location for intermediate table storage
- Prioritization scheme to be used when submitting jobs to the database
- Database-specific optimizations called VLDB properties
- Database gateway support, used for distributed databases
- Default database connection

A database connection specifies all of the information necessary for MicroStrategy Intelligence Server to connect to a database. This information includes:

- The system DSN that points to the database
- ODBC options such as driver mode, maximum cancel attempt time, and maximum query execution time
- Database connection caching options
- Default database login

**Rule:** You must include a database connection as part of a database instance definition.

A database login contains the login ID and password used to access a database. Database logins allow you to map different users to different database login ID/password combinations.

**Rule:** You must include a database login as part of a database connection definition.

**VLDB properties**

VLDB properties allow MicroStrategy Intelligence Server to take advantage of the unique optimizations that different databases offer. There are over fifty settings that, depending on the database type, affect how MicroStrategy Intelligence Server handles things like:

- Data type conversions
• Join options, such as the star join and full outer join
• Metric calculation options, such as when to check for NULLs and zeros
• Pre-and-post SQL statements
• Query optimizations, such as sub queries and driving tables
• Table types, such as temporary tables or derived tables

Default VLDB properties are set based on the database type specified in the database instance. Updates for the default settings may be made available periodically as database vendors add new functionality.

For more information about VLBD properties, see the following appendix:
Appendix B: VLDB Properties

Database connection caching

Connecting to and disconnecting from databases incurs a small amount of overhead that may cause a small yet noticeable decrease in performance in high-concurrency systems. With connection caching, MicroStrategy Intelligence Server is able to reuse database connections. This minimizes the overhead associated with repeated connecting to and disconnecting from databases.

Connections may exist in one of two states:
• busy: connections that are actively submitting a query to a database
• cached: connections that are still connected to a database but not actively submitting a query to a database

A cached connection will be used for a job if the following criteria are satisfied:
• The connection string for the cached connection must match the connection string that would be used for the job.
• The execution mode matches synchronous versus asynchronous.

Important: MicroStrategy Intelligence does not cache any connections that have pre-or- post SQL statements associated with them because these options may drastically alter the state of the connection.

To learn about...

...the editors, wizards, and monitors used to configure and manage database connectivity, see the following Interfaces topics:
• Database Connection Monitor
• Database Instance Editor
• Database Instance Manager
• Database Instance Wizard

...database connectivity tasks you can perform using MicroStrategy Desktop, see the following How do I...? topics:
• Database Instances
• Database Connections
• Database Logins
Job processing topics include:
- Jobs, tasks, and other job processing concepts
- Report execution
- Object browsing
- Element browsing
- Document execution
- Job execution from MicroStrategy web
- Job prioritization

Job processing system overview

The job processing system is the most technically complex MicroStrategy Intelligence Server system and is perhaps the most important. Most MicroStrategy Intelligence Server activity takes place in this system because the most common user requests—executing a report, browsing objects, and browsing elements—go through the job processing system.

What is a job?

A job is a type of user request. The user that made the request is called the owner of the job. All jobs are made up of tasks. Tasks are carried out by components of MicroStrategy Intelligence Server.
User requests

MicroStrategy Intelligence Server handles many different types of user requests. Some of these user requests become jobs that go through the job processing system, others do not. User requests that become jobs are:

- browse, create, delete, or update any metadata objects
- browse elements
- execute a report
- execute a document

Some user requests may consist of more than one job, such as a batch report execution request which may contain many report requests, each of which is a separate job.

As a general rule, monitoring and other administrative commands do not become jobs. Some examples of these types of commands are:

- list currently executing jobs, current user connections, or registered projects
- cancel an executing job or set of jobs
- change the status of a project
- log into or log out from a project
- log a user out from a project or from MicroStrategy Intelligence Server
- stop or start MicroStrategy Intelligence Server
- backup MicroStrategy Intelligence Server
- change MicroStrategy Intelligence Server configuration

Tasks and components

A task is the smallest logical unit of work that MicroStrategy Intelligence Server performs when processing a job. For example, some tasks that might be involved in processing a report include generating SQL, submitting SQL to a database, crosstabbing data, and analyzing data.

There is a MicroStrategy Intelligence Server component responsible for executing each specific task. For example, the SQL Engine is responsible for the task of generating SQL while the Resolution Server is responsible for resolving report definitions.
The possible tasks that MicroStrategy Intelligence Server may need to perform when processing a job are, in no particular order:

<table>
<thead>
<tr>
<th>Task</th>
<th>MicroStrategy Intelligence Server component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolve report definition</td>
<td>Resolution Server</td>
</tr>
<tr>
<td>Look for a report cache</td>
<td>Report Server</td>
</tr>
<tr>
<td>Look for objects in the metadata</td>
<td>Object Server</td>
</tr>
<tr>
<td>Add user input from a prompt</td>
<td>Resolution Server</td>
</tr>
<tr>
<td>Generate SQL</td>
<td>SQL Engine</td>
</tr>
<tr>
<td>Execute SQL against the data warehouse</td>
<td>Query Engine</td>
</tr>
<tr>
<td>Perform analytical processing on results</td>
<td>Analytical Engine</td>
</tr>
<tr>
<td>Update report cache with new report results</td>
<td>Report Server</td>
</tr>
<tr>
<td>Look up elements</td>
<td>Element Server</td>
</tr>
<tr>
<td>Send output to the client application</td>
<td>Message Sender</td>
</tr>
</tbody>
</table>

**Job processing flow**

Jobs are processed like this:

1. A user makes a request from a client application such as MicroStrategy Desktop or MicroStrategy Web.
2. The client application sends the request to MicroStrategy Intelligence Server.
3. MicroStrategy Intelligence Server receives the request. It determines what type of request it is and performs a variety of different functions to prepare for processing.

4. The job moves through MicroStrategy Intelligence Server much like a car moves through an assembly line. Various MicroStrategy Intelligence Server components perform different tasks along the way until the job reaches the end and a final result is achieved.

5. The result is sent back to the client application, which presents the results to the user.

Report execution

All report execution jobs have the following pieces:

• Report instance: A “container” for all objects and information needed and produced during report execution including templates, filters, prompt answers, generated SQL, report results and so on. The report instance is passed from one MicroStrategy Intelligence Server component to another as a report execution progresses.

• Task list: A list of the tasks that need to be accomplished in order to complete a job. All jobs have a task list associated with them.

A report execution request may be a single report, a scheduled report, a group of reports, ad-hoc reports, or drills.

The following topics are examples of common report executions

• Basic report execution
• Report execution with caching
• Report execution with a prompt
• Drilling
Basic report execution

1. The client application sends a request message to MicroStrategy Intelligence Server. The message indicates that this particular request is a report execution request.

2. The Network Dispatcher receives the message. MicroStrategy Intelligence Server performs a variety of administrative tasks, such as checking the user’s report execution privileges, verifying governing parameters, and updating statistics. If any of these tasks fail an error message is sent to the client application and the process ends.

3. The Job Executor looks at the first step in the job’s task list—report resolution—and sends the job to the Resolution Server.

4. The Resolution Server checks to see if all the objects needed for the report are in memory. If not, it asks the Object Server for any missing object definitions.
5. The Object Server checks to see if there is a valid cache for the requested object definition. If there is, it returns the object definition. Otherwise, it calls on the Metadata Server to load the object definition from the metadata database. Then it saves the object definition in its cache and returns the definition to the Resolution Server.

6. Once it has all the necessary objects loaded, the Resolution Server returns the job to the Job Executor. The Job Executor sends the job to the next step in the job’s task list, SQL generation. The SQL Engine generates the SQL and passes the job back to the Job Executor.

7. The Job Executor passes the job to the Query Engine, which submits the SQL to the warehouse.

8. The Query Engine opens a connection to the warehouse and submits the SQL. After the SQL is executed and data is returned the Query Engine passes the job back to the Job Executor.

9. If the task list indicates that additional analytical processing or crosstabbing is required, the Job Executor passes the job to the Analytical Engine, which performs any additional calculations, crosstabs the data, and returns the job to the Job Executor.

10. The Job Executor passes the job to the Result Sender which sends the complete report results to the client and returns the job back to the Job Executor. The Job Executor officially closes the job and the process ends.

**Report execution with caching**

If you have server caching turned on, a few additional steps are added to the basic report execution:
Report execution with caching

1. MicroStrategy Intelligence Server checks to see if there is a valid report cache for this particular report. If a valid cache exists, MicroStrategy Intelligence Server returns the results to the client application and the process ends. If a valid cache does not exist because there is no cache or the cache is expired, MicroStrategy Intelligence Server creates a new job with a report instance and an associated task list.

Steps 3-9 are the same as a typical report execution.

2. The Job Executor passes the job to the Result Sender which sends the complete report results back to the client and returns the job back to the Job Executor. If there was no cache, MicroStrategy Intelligence Server creates a new one. If there was a cache but it was expired, MicroStrategy Intelligence Server updates the cache. The Job Executor officially closes the job and the process ends.

Report execution with a prompt

When processing a report that contains a prompt, job execution is delayed until the user supplies the necessary filtering criteria. When this happens, job execution is put into a sort of “sleep mode” while it waits for user input. In this case, the report resolution task has a few additional steps:

1. The Job Executor sends the job to the Resolution Server. The Resolution Server discovers that the report definition contains a prompt. It returns the job to the Job Executor telling it to prompt the user for the necessary information.
2. MicroStrategy Intelligence Server puts the job into sleep mode. The Job Executor tells the Result Sender to send a message to the client application prompting the user for the information.

3. The user completes the prompt and the client application sends the user’s prompt selections back to MicroStrategy Intelligence Server.

4. MicroStrategy Intelligence Server performs a variety of security and governing checks and updates the statistics. It then “wakes up” the sleeping job, adds the user’s prompt reply to the job’s report instance, and passes the job to the Job Executor.

5. The Job Executor passes the job to the Resolution Server again. This cycle repeats until all prompts in the report are resolved.

---

**Important:** A sleeping job “times out” after a certain period of time or if the connection to the client is lost. If the prompt reply comes back after the job has timed out, an error message is sent back to the user.

---

After the prompt is resolved, steps 4-10 are the same as a typical report execution.

**Drilling**

A **drill** is processed much like a typical report except that it uses a drill instance. A drill instance is the same thing as a reports instance except that it stores additional information about the user’s drill selection and the report on which the user drilled.

Here is what happens when a user drills on a report:

1. The request is sent to MicroStrategy Intelligence Server.

2. If the job is submitted from MicroStrategy Web, MicroStrategy Intelligence Server creates the drill instance. If the job is submitted from MicroStrategy Desktop, the drill instance is sent to the server along with the drill request. The drill instance stores a copy of the original template and filter on which the user drilled along with the user’s drill selection information.

3. Based on the user’s drill selection, MicroStrategy Intelligence Server makes the appropriate changes to the template and filter definitions.

4. The rest of the job is processed exactly like a basic report execution.
Object browsing

The definitions for all objects displayed in the folder list, such as folders, metrics, attributes, reports, and so on, are stored in the metadata. Whenever you expand or select a folder, MicroStrategy Intelligence Server must retrieve the objects from the metadata before it can display them in the folder list and the object viewer. This process is called **object browsing** and it is the reason for the slight delay you may notice the first time you expand or select a folder. The object definitions are cached in memory so that the information is displayed immediately the next time you browse the same folder.

Element browsing

When a user wishes to view attribute elements in the folder browser, or anywhere else in MicroStrategy Desktop, MicroStrategy Intelligence Server must retrieve the information from the data warehouse. The data is typically stored in a lookup table and a simple SQL query is submitted to the warehouse. This process is called **element browsing** and it is the reason for the slight delay you may notice the first time you view the elements of an attribute. The data is cached in memory so that the information is displayed immediately the next time you view the same attribute elements.

Document execution

A **document** is a container for formatting, displaying, and distributing multiple reports within a project. Documents are based on an HTML template, which allows them to contain any combination of text, images, hyperlinks, tables, grid reports, and graph reports. Any reports included in a document are called the child reports of the document.

Because documents are collections of multiple reports, they are executed a bit differently from single reports. The most notable differences are:

- The introduction of a document instance. A document instance is similar to a report instance. It contains the report instances for all the child reports, the XML results for the child reports, and any prompt information that may be included in the child reports.

- If the child reports contain prompts, all their prompt questions are combined into a single prompt. Any identical prompts are merged so that the resulting single prompt contains only one copy of each prompt question. Combining all the report prompt questions into a single prompt means that the user only needs to answer a single set of questions when executing a Document.
- Each child report is executed in parallel as a separate report. These child reports are processed just like any other report.

## Job execution from MicroStrategy Web

Requests from MicroStrategy Web are processed like this:

1. The user makes a request from a web browser. The request is sent to the web server via HTTP.
2. An active server page (ASP) receives the request and calls the MicroStrategy Web API.
4. MicroStrategy Intelligence Server sends the results back to the MicroStrategy Web API via XML.
5. The XML is converted to HTML using XSL or ASP.
6. The HTML is sent back to the client’s browser where the results are displayed.

## Job prioritization

**Job priority** defines the order in which jobs are processed by MicroStrategy Intelligence Server. Jobs are usually executed on a first-come-first-served basis, but there are numerous situations in which you may wish to modify the order.

For example, one of your projects may be primarily for your organization’s financial planners, but other users may have access to this project as well. In this case, it may make sense to set up a job prioritization so that any jobs submitted by a user in the financial planning group would be executed before any other jobs.
There are three possible priorities: high, medium and low. As the administrator, you decide which variables are used to determine a job’s priority.

**Defining job prioritizations**

To define a job prioritization, you must determine which variables should be considered in determining job priority. The possible variables are

- report cost
- group
- project

---

**Rule:** Job prioritizations are only used if the database instance for which they are created represents a warehouse. You cannot apply job prioritizations to metadata or statistics databases. In addition, job prioritizations are not applied to object or element browsing jobs.

---

**Report cost**

*Report cost* is an arbitrary value you can assign to a particular report to help determine priority. If you choose to use report cost as a priority variable, you must define a set of priority groups based on report cost. For example:

- report cost between 0 and 400
- report cost between 401 and 800
- report cost between 801 and 1000

The set of cost groupings must cover all values from 0 to 1000. Once you determine the cost groupings, you can set the report cost value on individual reports.

For example, suppose you have created cost groupings as shown above, making the first group high priority, the middle group medium priority and the last group low priority. You notice that a particular report requires significantly more processing time than most other reports. For this reason, you assign it a report cost of 900. This way, the report will have a low priority based on report cost and will be executed later when the system is not as busy.
Group

If you choose to use group as a priority variable, you must select the groups that will be used. All groups in the system may not necessarily be appropriate for defining priority. You should select only those groups that need to be considered for establishing priority.

Note: If a job is submitted by a user who belongs to more than one group the highest possible priority is used.

Project

If you choose to use project as a priority variable, you must select the projects that will be used. All projects in the system may not necessarily be appropriate for defining priority. You should select only those projects that need to be considered for establishing priority.

To learn about...

...the wizards and monitors used to manage job processing, see the following Interfaces topics:

- Job Monitor
- Job Prioritization Wizard

...job processing tasks you can perform using MicroStrategy Desktop, see the following How do I...? topics:

- Job Prioritizations
- Jobs
CHAPTER 4

Security

Security is a major concern in any system. Large systems typically provide users with access to a wealth of information, not all of which is meant to be seen by everyone. Consequently, a strong, system-wide security architecture needs to be implemented.

In general, security systems have the following components:

- **Authentication**: A way to identify yourself to the system
- **Access control**: What you are allowed to see and do once you have identified yourself
- **Auditing**: A record of what you saw and did

In the MicroStrategy environment, security must be implemented in the following places:

- the database
- the network/operating system
- the MicroStrategy applications

Database level security

Security at the database level is extremely important because anyone can bypass MicroStrategy security measures by using a simple, non-secure query tool to access the database. Fortunately, most database servers have their own security architectures that provide authentication, access control and auditing. Refer to your vendor’s documentation for information about your particular database server’s security features.

In addition to the unique security features that different database servers offer, MicroStrategy supports general database security techniques such as:

- Security views
- Partitioned fact tables
- Split fact tables
Security views

Most databases provide a way to restrict access to data. For example, a user may be able to access only certain tables or he may be restricted to certain rows and columns within a table. The subset of data available to a user is called the user’s security view.

Note that restrictions on tables, or rows and columns within tables, may not be directly evident to a user. They do, however, affect the values displayed in a report. You need to inform users as to which data they have access so that they do not inadvertently run a report that yields misleading final results. For example, if a user only has access to half of the sales data in the warehouse but runs a summary report on all sales, the summary will only reflect half the sales. Reports do not indicate the database security view used to generate the report.

Consult your database vendor’s product documentation to learn how to create security views for your particular database.

Partitioned fact tables

You can partition a fact table in order to group rows together. The resultant partitioned tables are physically distinct tables in the data warehouse and security administration is easy because permissions are granted to entire tables rather than rows and columns.

For example, suppose a fact table contains the key labeled Customer ID and fact columns:

<table>
<thead>
<tr>
<th>Customer ID</th>
<th>Customer Address</th>
<th>Member Bank</th>
<th>Transaction Amount ($)</th>
<th>Current Balance ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>123456</td>
<td>12 Elm St.</td>
<td>1st National</td>
<td>400.80</td>
<td>40,450.00</td>
</tr>
<tr>
<td>945940</td>
<td>888 Oak St.</td>
<td>Eastern Credit</td>
<td>150.00</td>
<td>60,010.70</td>
</tr>
<tr>
<td>908974</td>
<td>45 Crest Dr.</td>
<td>People’s Bank</td>
<td>3,000.00</td>
<td>100,009.00</td>
</tr>
<tr>
<td>886580</td>
<td>907 Grove Rd.</td>
<td>1st National</td>
<td>76.35</td>
<td>10,333.45</td>
</tr>
<tr>
<td>562055</td>
<td>1 Ocean Blvd.</td>
<td>Eastern Credit</td>
<td>888.50</td>
<td>1,000.00</td>
</tr>
</tbody>
</table>
The table for the 1st National partition would look like:

<table>
<thead>
<tr>
<th>Customer ID</th>
<th>Customer Address</th>
<th>Member Bank</th>
<th>Transaction Amount ($)</th>
<th>Current Balance ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td>123456</td>
<td>12 Elm St.</td>
<td>1st National</td>
<td>400.80</td>
<td>40,450.00</td>
</tr>
<tr>
<td>886580</td>
<td>907 Grove Rd.</td>
<td>1st National</td>
<td>76.35</td>
<td>10,333.45</td>
</tr>
</tbody>
</table>

This makes it easy to grant permissions by table to managers or account executives who should only be looking at customers for a certain bank.

Partitioned fact tables are invisible to system users. Although there are many physical tables, the system “sees” one logical fact table.

Support for partitioned fact tables for security reasons should not be confused with the support that MicroStrategy Intelligence Server provides for partitioned fact tables for performance benefits.

**Split fact tables**

**Split fact tables** are the creation of two or more physical fact tables from one logical fact table. Each new table contains the same primary key, but is a subset of the fact columns of the original fact table. Splitting fact tables allows fact columns to be grouped based on user community. This makes security administration easy because permissions are granted to entire tables rather than to columns.

For example, suppose a fact table contains the key labeled Customer ID and fact columns as follows:

<table>
<thead>
<tr>
<th>Customer ID</th>
<th>Customer Address</th>
<th>Member Bank</th>
<th>Transaction Amount ($)</th>
<th>Current Balance ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can split the table into two tables, one for the marketing department and one for the finance department. The marketing fact table would contain everything except the financial fact columns as follows:

<table>
<thead>
<tr>
<th>Customer ID</th>
<th>Customer Address</th>
<th>Member Bank</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The second table would contain the financial fact columns but not the marketing-related information as follows:

<table>
<thead>
<tr>
<th>Customer ID</th>
<th>Transaction Amount ($)</th>
<th>Current Balance ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Network and operating system security**

The network controls access to computers while the operating system controls access to the files and applications that are stored on a particular computer. It is important to protect computers, sensitive files and other information from inadvertent or malicious tampering.

Consult your vendor’s product documentation for information on controlling security on the network and on individual machines.

**MicroStrategy Intelligence Server authentication modes**

The following is a list of the different types of authentication modes in the MicroStrategy environment:

- standard
- Windows NT
- anonymous
- database

The authentication mode is set for each project source using the Project Source Manager. For more details about the Project Source Manager, see the following Getting Started interface topic:

MicroStrategy 7 Project Source Manager

**Standard authentication**

Standard authentication allows users to identify themselves using a system login ID and password. The system login ID is unique across the entire system.
When a project source is configured to use standard authentication, users must enter a valid login ID and password combination before they can access the project source.

**Windows NT authentication**

Windows NT assigns a unique security ID (SID) to every user in the NT network. With Windows NT authentication, users are identified by their Windows NT security ID (SID) and they are not prompted to enter a login ID and password.

To allow Windows NT authentication, you must link the users in the MicroStrategy environment to Windows NT users. Linking allows MicroStrategy Intelligence Server to map a Windows NT user to a MicroStrategy user.

For more details, see the following How do I...? topic:

Users

**Anonymous authentication**

Anonymous authentication allows users to access the system as a Guest user with a minimum set of privileges. Guest users inherit their privileges from the Public group and they are not part of the Everyone group.

To allow anonymous access to a server, you must grant connect access to the Public group. To allow anonymous access to a project, you must include the Public group in one of the project’s security roles.

For more details, see the following How do I...? topic:

Groups

**Database authentication**

Rule: Database authentication is only available for connecting to 6.X project sources.

Database authentication identifies users using a login ID and password for the metadata and warehouse databases.

When a project source is configured to use database authentication, the user is prompted for a login ID and password combination for both databases. MicroStrategy Intelligence Server passes the login information to the databases and the databases determine whether or not the information is valid.
MicroStrategy Intelligence Server access control

Access control determines what you are allowed to see and do once you have identified yourself to the system. There are two types of access control in the MicroStrategy environment:

- Privileges
- Permissions

MicroStrategy Intelligence Server provides the following security services to implement access control:

- User and group administration
- Security roles
- Security filters
- Connection mapping

Privileges

Privileges define the types of actions that particular users and groups may perform in the system. There are three types of privileges:

- **Object creation privileges** specify the types of objects a user may create.
- **Application access privileges** specify the editors, dialogs and wizards with which a user may interact.
- **System privileges** system-wide privileges such as whether a user is allowed to backup the system, take ownership of an object, log another user out of the system, and so on. These privileges are independent of a specific project.

For details about the specific privileges available in the MicroStrategy environment, see the following appendix:

Appendix D: Permissions and privileges

Permissions

Permissions define which users and groups have access to what objects and the degree to which they can access those objects.

MicroStrategy Intelligence Server uses the following to enforce permissions for an object:

- the authenticated user attempting to access the object
- the owner of the object
- the access control list of the object
Authenticated user

The authenticated user provides the following information to MicroStrategy Intelligence Server:

- **User identity**: Determines an object’s owner. Also determines whether or not a user has been granted the right to access an object.
- **Group membership**: A user is granted access to an object if he belongs to a group which has access to the object.
- **Special privileges**: A user may possess a special privilege which causes the normal access checks to be bypassed.

Object owner

Objects keep a record of their current owner. Typically, the owner is the user who created the object. The owner or an administrator decides who may access the object and what type of access is granted.

Access control list

The access control list of an object is a list of users and groups and the permissions that each one has for the particular object. Access control lists have the following information:

- **User**: The name of the user or group which is granted or denied access to the object.
- **Permissions**: The degree to which the user or group is granted or denied access to the object. The available permissions are:
  - **Browse**: Allows you to see an object in the Folder List and Object Viewer.
  - **Use/Execute**: Allows you to use an object needed for execution for example, a filter that needs to be used in a report execution.
  - **Read**: Allows you to view the object’s definition and access control list.
  - **Write**: Allows you to modify the object definition, but not the object’s access control list.
  - **Delete**: Allows you to delete the object.
  - **Control**: Allows you to modify the access control list of an object and take ownership of an object.
- **Inheritable**: Applies only to folders. If set, any objects placed in the folder will inherit the folder’s entry in the access control list.

For more details about the permissions available in the MicroStrategy environment, see the following appendix:

Appendix D: Permissions and privileges
User and group administration

MicroStrategy Intelligence Server allows you to create, modify, and delete users and groups. You can assign privileges to or revoke privileges from individual users or entire groups of users.

You can import user and group definitions from an existing Windows NT network or from a plain text file. For more details, see the following How do I...? topics:

- Users
- Groups

The following groups are provided by default:

- **Everyone**: All users except for guest users are automatically members of the Everyone group. The Everyone group is provided to make it easy for you to assign privileges, security role memberships, and so on to everyone in the system.

- **Public**: The Public group provides the capability for anonymous logins and is used to manage the access rights of guest users. If you choose to allow anonymous authentication, each guest user assumes the profile defined by the Public group. When a user logs in as a guest, a new user is created dynamically and becomes a member of the Public group.

- **System Monitors**: The System Monitors group provides an easy way to give users basic administrative privileges in the system. Users in the System Monitors group have access to all of the monitoring tools under the Administration section of a project source's folder list. However, System Monitors cannot modify any configuration objects such as database instances, server configurations, governors, and so on.

- **System Administrators**: The System Administrators group is a group within the System Monitors group. It provides all the capabilities of the System Monitors group plus the ability to modify all system objects.


- **Web PE Users**: The Web PE (Professional Edition) Users group provides an easy way to give users access to advanced MicroStrategy Web functionality. The Web PE Users group is assigned privileges associated with advanced Web functionality. The Web PE Users group is a group within the Web SE Users group; it provides all the privileges of the Web SE Users group plus additional privileges.
Security roles

Security roles are collections of privileges which can be reused from project to project. For example, you may create a security role which allows users to access all the editors except for the Document Editor. Once you create this security role, you can save it and use it in any project registered with the server. The users associated with a particular security role can vary by project.

The following security roles are provided by default:

- **Normal Users**: the Normal Users security role has no privileges granted.
- **Power Users**: the Power Users security role has all privileges granted.

Security filters

Security filters prevent users from seeing certain data in the database. If two users with different security filters run the exact same report, they may get different results. For example, a regional manager may have a security filter that only allows her to view data from her particular region regardless of the report she runs.

A security filter has these parts:

- **Filter expression** specifies the subset of the data that a user can analyze.
- **Top range attribute** specifies the highest level of analysis to which the security filter is applied. If this is not specifically specified, then the security filter applies to every level higher than the bottom range attribute.
- **Bottom range attribute** specifies the lowest level of analysis to which this security filter is applied. If this is not specifically specified, then the security filter applies to every level lower than the top range attribute.

**Note**: When neither a top range attribute nor a bottom range attribute is specified, then the security filter is applied to every level of analysis.

A more detailed example

A store manager in London may be allowed to analyze the sales of only the London store and nothing else. If she wants to see information for market or region then she only gets the London portion of that information.

A user with the following security filter can analyze information for the London store and any level lower. Any level above the store will be changed to Store level only.

- Security Filter
  - Filter expression: Store = London
Within a project, a security filter may be specified for any user. Whenever a user submits an element browse request or a report execution request, the security filter is applied.

---

**Connection mapping**

By default, all users use the same database connection and the same database login when submitting queries to the warehouse database. **Connection mapping** allows you to map particular users to different database connections and different database logins.

---

**Note:** Connection mapping only applies to the warehouse database.

---

**To learn about...**

...the editors and managers used to configure and manage security, see the following Interfaces topics:

- Group Editor
- Project Configuration Editor
- Security Role Editor
- User Connection Monitor
- User Editor
- User Manager
- User Manager Integrity Checker

...security tasks you can perform using MicroStrategy Desktop, see the following How do I...? topics:

- Access Control Lists
• Groups
• Passwords
• Security Filters
• Security Roles
• Users
Caching topics include:
- Basic caching concepts
- Caching job results
- Pre-Calculated data
- Database connection caching
- Cache administration

**Introduction to caching**

*Caching* is the theory that once something has been processed, there is no need to process it again. For example, if someone were to ask you what the capital of Denmark is and you did not know, you would have to look it up. However, if someone asked you the same question again twenty minutes later, you would be able to immediately reply that Copenhagen is the capital of Denmark, without having to look it up again.

This same idea can be used in the MicroStrategy environment. When a user runs a report for the first time, the job is submitted to the database for processing. However, if the results of that report are cached, then the next time someone runs the report, the results can be returned immediately without having to wait for the database to process the job.

In the MicroStrategy environment, caching can be used to improve system performance in the following ways:
- by caching the results of jobs
- by pre-calculating and caching the results of common or complex computations
- by caching connections to databases
Caching job results

Any time data is brought back from the database as the result of a user request, it can be cached. There are three types of caches that allow you to do this:

- **Object caches**: Recently accessed objects are stored in memory to speed up retrieval time when object browsing.
- **Element caches**: Recently accessed elements are stored in memory to speed up retrieval time when element browsing.
- **Report caches**: Report results can be stored in memory or on disk so that frequently or recently used reports can be accessed quickly.

**Rule**: All caches are managed at the project level. This means they cannot be shared across projects, even if the exact same report cache exists in two projects on the same server.

Where are caches stored?

Caches are stored in two places:

- Caches stored on the client (MicroStrategy Desktop) are called **local caches**.
- Caches stored on the server are called **server caches**.

Object caches, element caches, and local report caches are stored in memory. Server report caches can be stored in memory and on disk. Memory caches are faster but they are limited by the amount of memory that you allow them to use. Caches stored on disk are slower but you can store much more on disk than you can in memory.

Job execution with caching

When a user submits a job request, the system first checks the local cache. If the cache is not found, the job is submitted to MicroStrategy Intelligence Server. If the cache is not found on the server or if server caching is not enabled, the job is submitted to the database as usual.

**Note**: In the case of a report execution, if the cache is found on disk but not in memory, MicroStrategy Intelligence Server loads the cache into memory from disk.
**Cache matching requirements**

In order for a cache to be used, the cache must be valid and it must match the job being executed. The following table shows what the cache matching keys are for the different cache types.

<table>
<thead>
<tr>
<th>Cache type</th>
<th>Cache matching key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object cache</td>
<td>object ID, project ID, type</td>
</tr>
<tr>
<td>Element cache</td>
<td>attribute ID, attribute version ID, security filter</td>
</tr>
<tr>
<td>Report cache</td>
<td>report ID, report version ID, template ID, template version ID, filter ID, filter version ID, security filter and version IDs of the user that created the cached report, resolution object which holds answers to prompts, user ID (if you have configured the project to check for it in the cache key)</td>
</tr>
</tbody>
</table>

**Pre-calculated data**

You can create aggregate tables in your data warehouse to store pre-calculated data. Consult with your Database Administrator to see how this strategy can be used in your system.

**Database connection caching**

Connecting to and disconnecting from databases incurs a bit of overhead which can lead to a slight but noticeable performance degradation in particularly large and busy system. To avoid this degradation, MicroStrategy Intelligence Server caches database connections. These cached connections remain open and are reused whenever possible.
Cache administration

As the administrator, you have control over the amount of memory caches are allowed to use.

For local caching, you set the maximum, total amount of memory to be used for all caches. The total memory is distributed among the caches as follows:

- 30% of the specified amount of memory is used for object caching.
- 20% is used for element caching.
- 50% is used for report caching.

Keep in mind that caches are created on a per-project basis.

To learn about...

...the editors, wizards, and monitors used to configure and manage caching, see the following Interfaces topic:

Cache Monitor

...caching tasks you can perform using MicroStrategy Desktop, see the following How do I...? topic:

Caches
Scheduling topics include:

- Scheduling introduction
- Report scheduling
- Cache refreshing

Scheduling introduction

As the administrator, it is your responsibility to create the events and schedules that users can use to schedule their reports. To create effective and useful schedules, you need to have a clear understanding of your users’ needs as well as the usage patterns of the overall system.

There are two types of schedules:

- **Time-triggered schedules**: Reports are run at a specific date and time. Time-triggered schedules are often used in systems where the warehouse is refreshed on a regular basis.
- **Event-triggered schedules**: Reports are processed based on the occurrence of an event.

Report scheduling

The most common use of scheduling in the MicroStrategy environment is to schedule reports. Ordinarily, MicroStrategy Intelligence Server processes report requests immediately. Scheduling allows you to have MicroStrategy Intelligence Server process them at a different, user-defined time.

There is no difference between a scheduled report and a report manually submitted by a user. MicroStrategy Intelligence Server executes scheduled reports in exactly the same manner, regardless of whether the report was scheduled or not. All governing parameters and error conditions apply to scheduled reports in the same way they apply to other requests.
You can schedule reports according to two types of criteria:

- time-triggered criteria
- event-triggered criteria

When a scheduled report finishes executing, a message appears in the user’s Inbox alerting him that the report is ready to be viewed. Users simply double-click the message to see the report. If the request was not completed successfully, users can right-click the message and choose Details to see the error message.

**Time-triggered report scheduling**

When a report is set to a time-triggered schedule, you define a specific date and time at which the report is to be run. You may also create recurring time-triggered schedules, which allow users to run a particular report every Sunday night, for example.

Time-triggered schedules are especially important in systems where the database refresh rate is very high or if the refresh cycle is very reliable and regular. Time-triggered schedules are also used to allow large, resource-intensive reports to run at off-peak times, such as overnight or over a weekend.

For example, in a particularly large or busy system, you may wish to limit the number and complexity of reports users may execute during the day. In this case, you should create schedules to allow users to schedule resource-intensive reports to run at a time when MicroStrategy Intelligence Server is not particularly busy, usually overnight or at some other off-peak time.

You may also choose to create recurring report execution schedules. For example, if a database load occurs every Friday night, a user may request a report to be executed each time the database is loaded, perhaps every Saturday morning.

**Event-triggered report scheduling**

You can create schedules based on the occurrence of an event. When an event is triggered, all reports tied to that event are submitted.

You define the set of relevant events and create the event-triggered schedules from which users may select when scheduling a report.

**Testing environments**

In a testing environment, you can manually trigger events using the Event Viewer. To learn about the Event Viewer, see the following topic in the Interfaces section:

Event Viewer
**Production environments**

In a production environment, it does not make sense for you to manually trigger events. Using the MicroStrategy utility FireEvent.exe (installed with the MicroStrategy SDK), you can have external systems trigger events using a command line and achieve true scheduling automation.

---

**Tip:** The following command line is an example of the syntax you must use to trigger an event with FireEvent.exe:

FireEvent -fire Event1 -srv my_server -prt 34592 -uid Administrator -pwd Hello!

In this case, you are triggering an event called "Event1" on a server called "my_server" through port "34592" using the "Administrator" login with a password "Hello!".

---

For example, suppose you want to execute several reports immediately after a database load occurs. You can have the database load routine open a remote shell on the MicroStrategy Intelligence Server machine and execute FireEvent.exe. The event you specify in the command line will be triggered just as if you manually triggered it from the Event Viewer.

---

**Cache refreshing**

Sometimes, it is not important to deliver the results of a scheduled report to the user. In some cases, it is more important to refresh a report cache, which can be shared by several users.

To do this, you create and cache the reports and provide access to them. Then you create the schedules to refresh those reports. The messages will be delivered to your inbox. Users wishing to retrieve the results can access the cache by running the shared, cached report.

Cache refreshing schedules are usually event-triggered since caches do not need refreshing unless the underlying data changes from an event like a warehouse load.

For example, suppose a set of standard weekly and monthly reports has been developed in the system. These reports should be kept in cache because they are frequently accessed. Certain tables in the database are refreshed on a weekly basis, and other tables are refreshed on a monthly basis. Whenever these tables are updated, the appropriate caches should be refreshed. Note that although the refresh occurs on a weekly or monthly schedule, the refresh does not complete at exactly the same time each week/month.
To learn about...

...the editors, wizards, and monitors used to configure and manage schedules, see the following Interfaces topics:

- Event Viewer
- Schedule Manager
- Schedule Monitor
- Schedule Wizard

...scheduling tasks you can perform using MicroStrategy Desktop, see the following How do I...? topic:

Schedules
Clustering topics include:

- Basic clustering concepts and terms
- Failover
- Load balancing
- MicroStrategy clustering architecture

**Introduction to clustering**

A **cluster** is a collection of two or more machines that provide services to a common set of clients. Each machine in a cluster is called a **node**.

Clustering is a system configuration strategy which provides the following benefits:

- Higher availability: Clustering prevents the loss of valuable time and information in the event of a failure. No single failure should cause the system to become unavailable for any length of time.
- Better performance: Clustering allows you to increase system performance by harnessing the combined processing power of multiple machines.
- Greater scalability: Clustering allows your system to grow as the user base grows and as user requirements become more varied and complex.
- Simplified management: Clustering simplifies the management of large or rapidly growing systems.

Specifically, clustering allows you to implement the following features in your system:

- Failover
- Load balancing
Failover

Failover is a must for any system where unplanned downtime is unacceptable. It ensures that the system remains available for use in the event of an application or hardware failure. When one node in the cluster fails, another node or set of nodes picks up the workload.

A complete failover strategy must provide the following services:

- Load redistribution: When a node fails, the work for which it is responsible is directed to another node or set of nodes.
- Transaction recovery: All unfinished work from the failed node is recovered and re-executed.
- State recovery: All information about the state of the failed node at the time of failure is recovered.

Tip: Since the availability of the metadata is critical to the operation of MicroStrategy Intelligence Server, you should consider implementing a failover strategy for the metadata database as well.

Load balancing

Load balancing is a strategy aimed at achieving an even distribution of work across resources. Some examples of resources are:

- The databases in the system
- MicroStrategy Intelligence Server processing threads
- Amount of RAM and disk space on a machine

For example, you may have two MicroStrategy Intelligence Server machines, each one handling half of the user requests. Since the work is evenly divided between two resources (in this case the machines are the resources) processing is faster and neither machine gets overloaded with more work than it can handle.

There are three types of load balancing:

- Database load balancing: Refers to maintaining an even load on each database in the system. Since MicroStrategy Intelligence Server manages the database connections for the system, it can make sure that no database has more work than it can handle.
- Internal MicroStrategy Intelligence Server load balancing: Refers to optimizing the allocation of processing threads within MicroStrategy Intelligence Server. User requests must be processed quickly and efficiently, but not in such a way as to overload the server.
• Distributed processing: Refers to distributing the workload of a large system across multiple physical machines.

**MicroStrategy clustering architecture**

In a MicroStrategy system, clustering is most important in a 4-tier environment. The clustering architecture for a 4-tier MicroStrategy system provides both load balancing and failover benefits:

1. MicroStrategy Web users send requests from their web browsers.
2. A third party IP redistribution tool such as Cisco Local Router or Microsoft Windows Load Balancing Service is used to distribute requests coming from web clients among web servers.
3. MicroStrategy load balancers communicate with each other to maintain up to date information about the state of the other load balancers and the load (number of users) on the MicroStrategy Intelligence Servers.
4. Based on information collected about the state of the other load balancers and the load on the MicroStrategy Intelligence Servers, the load balancers distribute the requests among the MicroStrategy Intelligence Servers.
The MicroStrategy Intelligence Servers receive the requests and process them. In addition, the MicroStrategy Intelligence Servers communicate with each other to maintain metadata integrity and cache synchronization across the system.

If any of the web server nodes or MicroStrategy Intelligence Server nodes fails, the workload is distributed to the other nodes in the system.

**Rule:** The MicroStrategy Intelligence Servers in a cluster must be identically configured. They must use the same server definition and they must have the same projects registered.

**Metadata synchronization**

Any time a MicroStrategy Intelligence Server makes a change to an object in the metadata, the other servers in the cluster need to know about the change. When a metadata object is changed, the other servers are alerted and they delete the object from their memory cache. This ensures that all users access the same metadata objects regardless of where their requests are sent.

**Cache synchronization**

Any time a MicroStrategy Intelligence Server creates a report cache, the other servers in the cluster are notified. When the same report is submitted to the other servers in the cluster, the report cache created on the first server will be used (as long as the cache is accessible from the other servers).

For cache synchronization to work, the servers must have access to the cache directories. There are two ways in which you can set up cache synchronization in a cluster. See the following How do I...? topic for details:

Caches

**To learn about...**

...the monitors used to manage clustering, see the following Interfaces topic:

Cluster Monitor

...clustering tasks you can perform using MicroStrategy Desktop, see the following How do I...? topic:
MicroStrategy Intelligence Servers
MicroStrategy Web is available in three different editions, each having an associated set of privileges. To grant each user access to one of these Web editions, you may need multiple copies of one or more of them: the number of users assigned to any one edition is based on your license agreement.

Assigning privileges: MicroStrategy Web editions

**Note:** User groups and associated privileges as described below apply only to

- new projects created using MicroStrategy 7.0 SP2
- existing projects for which the metadata has been updated to 7.0 SP2

MicroStrategy 7 provides

- **Web Analyst**, which offers maximum functionality to the end user
- **Web Reporter**, which includes a subset of the Web Analyst functionality
- **Web Viewer**, which provides an enterprise-reporting version of Web containing a subset of Web Reporter functionality

The table that follows describes the privileges available in each edition. The following applies to the use of this table:

- The information is provided to help you understand what privileges can be granted to a given user under each edition.
- A user assigned to a given edition is entitled to a complete set (or identified subset) of the privileges listed for that edition.
- If a user is assigned to multiple user groups, the privileges of those groups are additive, and determine the edition usage of that particular user (for instance, if a user is a member of both the Finance and the Accounting user groups, privileges for that user are equivalent to the cumulative set of privileges assigned to those two groups).
Note: In the table, an “X” denotes access to the functionality, a blank denotes no access to the function.

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Privileges</th>
<th>Web Analyst</th>
<th>Web Reporter</th>
<th>Web Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>browse and view reports and documents</td>
<td>Web User</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>run live reports</td>
<td>Web User</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>prompts on reports and documents</td>
<td>Web User</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>incremental fetch of large data sets</td>
<td>Web User</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>drill down (simple drill)</td>
<td>Web User</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>toggle view mode between grid and graph</td>
<td>Web User</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>view filter detail</td>
<td>Web User</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>investigative workflow (drill to template)</td>
<td>Web User</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>format a grid using built-in style options</td>
<td>Web User</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>graph interaction and modification</td>
<td>Web User</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>sorting</td>
<td>Web User</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>print</td>
<td>Web Print Mode</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>change user options</td>
<td>Web Change User Options</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>search for reports, documents, folders</td>
<td>Web Object Search</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>view and add to History List</td>
<td>Web History List</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>view report details</td>
<td>Web Report Details</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>delete objects</td>
<td>Web Delete Object</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>export report to various formats</td>
<td>Web Export</td>
<td>X</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Assigning privileges: MicroStrategy Web editions

The MicroStrategy 7 security model enables you to set up user groups that can have subgroups within them, thus creating a hierarchy. The following applies to the creation of user subgroups:

- A child subgroup automatically inherits privileges assigned to its parent group.
- In addition to inherited privileges, a child subgroup can be assigned other privileges.

User groups corresponding to the three MicroStrategy 7 Web Editions have been predefined with the appropriate privilege sets. These user groups are available under the User Group folder within the Administration folder for your project.

---

**Note:** You need project administration privileges to view and modify user-group definitions.

---

### Assigning user privileges

Refer to your license agreement for reference as you determine how each user is assigned to a given privilege set. MicroStrategy 7 defines user groups in terms of the three Web editions (Web Analyst, Web Reporter, Web Viewer), based on the privilege set assigned to each. For instance, if you assign to a user in a Web Reporter group a privilege available only to a Web Analyst, MicroStrategy considers this user to be a Web Analyst user. In some cases you can, however, assign a subset of privileges belonging to a given edition to a user who has privileges for that edition without violating your license agreement.
The **License Manager** tool (MaLicMgr.exe), available in the common files directory, enables self-audit of your user base and allows you to quickly understand how to use your license. The access path is `\Programs files\common files\MicroStrategy\MaLicMgr.exe`.

---

**Notes:**

- The Web User privilege allows users to drill down on a report. Although this privilege is available to **Web Viewer** users in MicroStrategy 7.0 SP2, this user group will not be granted the privilege in subsequent versions of the product. In addition, the following functionality associated with Web User privileges will not be available to Web Viewer users in the future:
  - toggle view mode between grid and graph views
  - View Filter Details
  - Investigative Workflow (Drill to Template)
  - grid formatting using built-in style choices
  - Graph Interactions and Modification
  - Sorting

- The Web History List privilege allows users to add reports to a history list. Although this privilege is available to **Web Reporter** users in MicroStrategy 7.0 SP2, this user group will not be granted the privilege in subsequent versions of the product.

- In versions of MicroStrategy Web subsequent to 7.0 SP2, the Web Report Manipulation function will be divided into multiple capabilities, with multiple associated privileges: Web Reporter users will be able to sort reports and toggle between Page By elements; Web Analyst users will have access to full data manipulation capabilities.

---

As the Administrator, you are responsible for administering the MicroStrategy Web environment. User and group security privileges are configured through MicroStrategy Desktop, but there are a few other administrative tasks you must do in MicroStrategy Web.

MicroStrategy Web administration topics include:

- The Web administration privilege
- MicroStrategy Web Administrator page
- Default project options for MicroStrategy web
The Web administration privilege

The Web administration privilege is granted to users and groups with the User Editor and Group Editor in MicroStrategy Desktop. It determines:

- whether a user can see the link to the Administrator page on the MicroStrategy Web Home page
- whether a user can set default project options in the Preferences section of MicroStrategy Web

MicroStrategy Web Administrator page

The Administrator page allows you to connect and disconnect MicroStrategy Web to MicroStrategy Intelligence Servers. It also lets you set MicroStrategy Web governors such as server and request time-outs and the maximum number of connections MicroStrategy can make to a MicroStrategy Intelligence Server.

If you have the appropriate privileges, you can find the link to the Administrator page on the MicroStrategy Web home page.

Controlling access to the Administrator page

In order to prevent users from accessing the Administrator page, you should limit access to the page in the following ways:

- using the Web administration privilege
- using Microsoft IIS and Windows NT security

Web administration privilege

The link to the Administrator page appears only if one of the following criteria is true:

- You are logged in to a project and have the Web administration privilege.
- MicroStrategy Web is not connected to any MicroStrategy Intelligence Servers.

In this case, there is no way to tell whether you have the Web administration privilege because there is no MicroStrategy Intelligence Server to verify your credentials. However, once you connect MicroStrategy Web to a MicroStrategy Intelligence Server, you will no longer see the link unless you log in to a project in which you have the Web administration privilege.
**Microsoft IIS and Windows NT security**

The Web administration privilege can limit access to the Administrator page from within MicroStrategy Web, but it does not prevent a user from simply typing the URL in a web browser. To prevent this, you must limit access to the file itself using Microsoft IIS and Windows NT security.

**Default project options for MicroStrategy Web**

In the Preferences section of MicroStrategy Web, you can set the default options for your project(s) by clicking Project Defaults. This link only appears if you have the Web administration privilege.

Any changes you make to these options will become the default settings for the current project, for all MicroStrategy Web projects if you so choose.

**To learn about...**

...the page used to configure and manage MicroStrategy Web, see the following Interfaces topic:

MicroStrategy Web Administrator page

...administrative tasks you can perform using MicroStrategy Web, see the following How do I...? topic:

MicroStrategy Web
Topics for this section include:

- Cache Monitor
- Cluster Monitor
- Database Connection Monitor
- Database Instance Editor
- Database Instance Manager
- Database Instance Wizard
- Diagnostics Configuration Editor
- Event Viewer
- Group Editor
- Job Monitor
- Job Prioritization Wizard
- MicroStrategy Server Configuration Editor
- MicroStrategy Server Service Manager
- MicroStrategy Web administration page
- Project Configuration Editor
- Project Monitor
- Project Mover Wizard
- Schedule Manager
- Schedule Monitor
- Schedule Wizard
- Security Role Editor
- User Connection Monitor
- User Editor
- User Manager
• User Manager Integrity Checker
What is it?
The Cache Monitor allows you to view and manage report caches.

How do I access it?
You can find the Cache Monitor for a particular project source in the project source’s Administration hierarchy.

What can I do with it?
The Cache Monitor allows you to:
• view the status of all report caches
• load report caches from disk
• unload report caches to disk
• delete report caches
For instructions on completing one of the above tasks, refer to the following How do I...? topic:
• Caches

What should I know before I use it?
Before you begin using the Cache Monitor, you should:
• have system monitoring privileges to view cache information
• have system administration privileges to manipulate caches
• understand how caching works
For more information on the above topics, refer to the following concepts:
• Security
• Caching
Cache Monitor layout

To view details, choose Details from the View menu. The Cache Monitor provides you with the following information about database connections for the project source:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Information displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Name</td>
<td>Name of the cached report</td>
</tr>
<tr>
<td>Project Name</td>
<td>Name of the project in which the report resides</td>
</tr>
<tr>
<td>Status</td>
<td>Cache status is displayed using some combination of the following letters:</td>
</tr>
<tr>
<td></td>
<td>R = Ready</td>
</tr>
<tr>
<td></td>
<td>P = Processing</td>
</tr>
<tr>
<td></td>
<td>I = Invalid</td>
</tr>
<tr>
<td></td>
<td>E = Expired</td>
</tr>
<tr>
<td></td>
<td>L = Loaded</td>
</tr>
<tr>
<td></td>
<td>U = Updated</td>
</tr>
<tr>
<td></td>
<td>D = Dirty</td>
</tr>
<tr>
<td></td>
<td>F = Filed</td>
</tr>
<tr>
<td>Last Update</td>
<td>Date and time at which the cache was updated</td>
</tr>
<tr>
<td>Cache Size</td>
<td>Size of the cache in KB</td>
</tr>
<tr>
<td>Expiration</td>
<td>Date and time at which the cache is set to expire</td>
</tr>
<tr>
<td>Type</td>
<td>Displays either Matching or History.</td>
</tr>
<tr>
<td></td>
<td>Matching caches are report caches that may be accessed during normal report execution.</td>
</tr>
<tr>
<td></td>
<td>They may or may not be referenced by history list messages.</td>
</tr>
<tr>
<td></td>
<td>History caches are expired or invalid caches</td>
</tr>
<tr>
<td></td>
<td>which are still referenced by unread messages in the history list.</td>
</tr>
<tr>
<td>Cache ID</td>
<td>Unique alpha-numeric identifier for the cache</td>
</tr>
</tbody>
</table>
The following additional information can be displayed by choosing **Complete Information** from the right-click menu:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Information displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hit Count</td>
<td>Number of times the cache has been accessed</td>
</tr>
<tr>
<td>Creation Time</td>
<td>Date and time at which the cache was created</td>
</tr>
<tr>
<td>Last Hit Time</td>
<td>Date and time at which the cache was last accessed</td>
</tr>
<tr>
<td>File Name</td>
<td>Full path and file name of the cache</td>
</tr>
<tr>
<td>Waiting List</td>
<td>Displays the ID of any jobs in the waiting list for the cache</td>
</tr>
</tbody>
</table>

Right-clicking a report cache brings up a menu with the following choices:

- **Quick View**: Opens the Quick View for a report cache.
- **View**: Allows you to change the view.
- **Line Up Icons**: If you are using the Large Icons or Small Icons view, this automatically arranges the icons for you.
- **Refresh**: Refreshes the information display.
- **Filter by Project**: Sorts the information by project.
- **Complete information**: If you are using the Details view, this displays the five additional columns described above.
- **Show history Caches**: Select this to see history caches in the **Cache Monitor**.
- **Delete**: Deletes the selected report cache(s).
- **Load from disk**: Loads the selected report cache from disk and stores it in memory.
- **Unload to disk**: Unloads the selected report cache from memory and saves it to disk.
Cluster Monitor

What is it?
The Cluster Monitor allows you to manage and see the status of MicroStrategy Intelligence Servers in a cluster.

How do I access it?
You can find the Cluster Monitor for a particular project source in the project source’s Administration hierarchy.

What can I do with it?
The Cluster Monitor allows you to:
• view the workload of each machine in a cluster
• add additional machines to a cluster
• remove machines from a cluster
For instructions on completing one of the above tasks, refer to the following How do I...? topic:
MicroStrategy Intelligence Servers

What should I know before I use it?
Before you begin using the Cluster Monitor, you should:
• have system monitoring privileges to view cluster information
• have system administration privileges to add or remove machines
For more information on the above topics, refer to the following concept:
Clustering
Cluster Monitor layout

To view details, choose Details from the View menu. The Cluster Monitor provides you with the following information about machines in the cluster:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Information displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine Name</td>
<td>Name of the MicroStrategy Intelligence Server machine.</td>
</tr>
<tr>
<td>Workload</td>
<td>Workload of the MicroStrategy Intelligence Server. Workload is calculated by the number of users currently connected to the server.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Communication protocol used by the MicroStrategy Intelligence Server machine.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number used by the MicroStrategy Intelligence Server machine.</td>
</tr>
</tbody>
</table>

Right-clicking a machine name brings up a menu with the following choices:

- **View**: Allows you to change the view.
- **Line up icons**: If you are using the Large Icons or Small Icons view, this automatically arranges the icons for you.
- **Refresh**: Refreshes the information display.
- **Join cluster**: Allows you to add a machine to the cluster.
- **Leave cluster**: Allows you to remove a machine from the cluster.
Database Connection Monitor

What is it?
The **Database Connection Monitor** allows you to view and manage busy and cached connections to databases.

How do I access it?
You can find the Database Connection Monitor for a particular project source in the project source’s Administration hierarchy.

What can I do with it?
The Database Connection Monitor allows you to:

- view the status of all busy and cached database connections
- delete/disconnect a connection

For instructions on completing one of the above tasks, refer to the following **How do I...?** topic:

Database Connections

What should I know before I use it?
Before you begin using the Database Connection Monitor, you should:

- understand how database connectivity works
- be familiar with the database instances, database connections, and database logins that exist in the system
- have system monitoring privileges to view database connection information
- have system administration privileges to manage database connections

For more information on the above topics, refer to the following concepts:

- Database connectivity
- Security
Database Connection Monitor layout

To view details, choose Details from the View menu. The Database Connection Monitor provides you with the following information about connections to databases from a project source:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Information displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection ID</td>
<td>Numeric identifier for a particular connection</td>
</tr>
<tr>
<td>Status</td>
<td>Connections can be one of the following statuses:</td>
</tr>
<tr>
<td></td>
<td>Busy: The connection is currently busy with a job</td>
</tr>
<tr>
<td></td>
<td>Cached: The connection is not busy and is available to process a job</td>
</tr>
<tr>
<td>Database Instance</td>
<td>The database instance being used to make the connection to the database</td>
</tr>
<tr>
<td>Database Connection</td>
<td>The database connection being used to make the connection to the database</td>
</tr>
<tr>
<td>User Name</td>
<td>When a connection is busy, this displays the user name of the person whose job is being executed</td>
</tr>
<tr>
<td>Database Login</td>
<td>The database login being used to make the connection to the database</td>
</tr>
</tbody>
</table>

Right-clicking a connection brings up a menu with the following choices:

- **Quick View**: Opens the Quick View for a connection.
- **View**: Allows you to change the view.
- **Line Up Icons**: If you are using the Large Icons or Small Icons view, this automatically arranges the icons for you.
- **Refresh**: Refreshes the information display.
- **Complete information**: If you are using the Details view, this displays the three additional columns described above.
- **Delete**: Closes the selected connection.
Database Instance Editor

What is it?

The Database Instance Editor allows you to create and modify database instances and their associated database connections and database logins.

How can I access it?

1. Select the Database Instance Manager.
2. To create a new database instance, go to the File menu, point to New, then choose Database Instance. To modify an existing database instance, highlight the database instance and choose Edit from the File menu.

Tip: There is also a Database Instance Wizard which provides a quick and easy way to create new database instances.

Access the Database Instance Wizard via the right-click menu in the Database Instance Manager.

What can I do with it?

The Database Instance Editor allows you to:

• create or modify database instances
• create, delete, or modify database connections, database logins, and job prioritization schemes
• configure advanced ODBC settings, database connection caching, and intermediate table storage
• map a database connection to an ODBC DSN
• specify the default database connection for a database instance
• specify the default database login for a database connection
• set the maximum number of connections allowed for a particular database instance
• upgrade the VLDB options to be used for a particular database type

For instructions on completing one of the above tasks, refer to the following **How do I...?** topics:

• Database Instances
• Database Connections
• Database Logins
• Job Prioritizations

**What should I know before I use it?**

Before you begin using the Database Instance Editor, you should:

• understand ODBC and related concepts such as DSNs, database drivers, and driver execution modes
• be familiar with database connections and database logins
• know what, if any, database table prefixes are required for your databases
• understand job prioritizations and how they apply to your system
• understand VLDB properties
• have system administration privileges

For more information on the above topics, refer to the following topics:

• Database connectivity
• Appendix C: VLDB properties

**Database Instance Editor layout**

The Database Instance Editor has the following tabs:

• General
• Advanced
• Job Prioritization

**Database Instance Editor: General tab**

The **General** tab allows you to:

• specify the database instance name
• specify the type of database to which the database instance refers
• upgrade database type and VLDB properties
Upgrade database type

In the General tab of the Database Instance Editor, the database connection type specifies the type of database that the database instance represents, for example, Oracle 8.0 or IBM DB2 UDB 7. This setting ensures that the appropriate default VLDB properties are used for the database type. The settings are read from the Database.PDS file supplied by MicroStrategy. This file is located in the MicroStrategy common files folder, which by default is

C:\Program Files\Common Files\MicroStrategy

Database Instance Editor: Advanced tab

The Advanced tab allows you to specify:

- the database name and table space name required for intermediate table storage, if any
- the primary database instance to be used for database gateway support

Database Instance Editor: Job Prioritization tab

The Job Prioritization tab allows you to:

- create, delete, or modify job prioritization schemes
- change the number of connections used for each priority

Click New to launch the Job Prioritization Wizard, which allows you to create new job prioritizations. Right-click a job prioritization entry to modify or delete the selected entry.

For more information, refer to the following Interface chapter:

Job Prioritization Wizard

Upgrade database type

Click Delete to remove the selected database connection. To create a new database connection, click New. To modify an existing database connection, select the one to modify and click Modify.
As database vendors periodically update their database servers, MicroStrategy will periodically update the Database.PDS file to account for new or changed functionality for the database servers. Click **Upgrade** to open the **Upgrade Database Type** dialog and update the VLDB properties.

For more details about upgrading VLDB settings, refer to the following **How Do I...?** topic:

Database instances

### Database connections

In the General tab of the Database Instance editor, if you click **New** or **Modify**, the **Database Connections** dialog box opens.

This dialog has the following tabs:

- General
- Advanced

#### Database Connections window: General tab

The General tab allows you to:

- provide a name for the database connection
- map the database connection to an ODBC DSN
- specify the default database login for the database connection
- create, delete, or modify a database login

Click **Delete** to delete the selected database login. To create a new database login, click **New**. To modify an existing database login, select the one you wish to modify and click **Modify**.

#### Database Connections window: Advanced tab

The advanced tab allows you to configure:

- advanced ODBC settings such as database driver mode, driver execution mode, extended fetch, maximum cancel attempt time, and maximum query execution time
- database connection caching options
CHAPTER 13

Database Instance Manager

What is it?

The Database Instance Manager lists all of the database instances defined for a particular project source.

How do I access it?

You can find the Database Instance Manager for a particular project source in the project source’s Administration hierarchy.

What can I do with it?

The Database Instance Manager allows you to:

• open the Database Instance Editor which allows you to create or modify database instances, database connections, and database logins
• open the Database Instance Wizard which allows you to quickly create a new database instance and define the database connection and database login with which it is associated
• open the VLDB Properties Editor which allows you to change the default VLDB properties associated with a database instance
• rename a database instance
• delete a database instance

For instructions on completing one of the above tasks, refer to the following How do I...? topics:

• Database Instances
• Database Connections
• Database Logins

What should I know before I use it?

Before you begin using the Database Instance Manager you should:

• know what database instances exist in your system and which database(s) they represent
have system administration privileges

For more information on the above topics, refer to the following topics:

- Database connectivity
- Appendix C: VLDB properties

## Database Instance Manager layout

To view details choose **Details** from the **View** menu, the Database Instance Manager provides you with the following information about the databases instances defined for a project source:

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the database instance</td>
</tr>
<tr>
<td>Owner</td>
<td>User who created the database instance</td>
</tr>
<tr>
<td>Modification Time</td>
<td>Last date and time at which the database instance was modified</td>
</tr>
<tr>
<td>Description</td>
<td>If you included a description in the database instance definition, it is displayed here</td>
</tr>
</tbody>
</table>

Right-clicking a database instance brings up a menu with the following choices:

- **Edit**: Opens the Database Instance Editor for the selected database instance
- **VLDB Properties**: Opens the VLDB Properties editor for the selected database instance
- **Prioritization**: Opens the Database Instance Editor with the Job Prioritization tab selected
- **Delete**: Deletes the selected database instance
- **Rename**: Allows you to rename the selected database instance
- **Properties**: Opens the Properties window for the selected database instance

A right-click anywhere else in the Database Instance Manager display brings up a menu with the following options:

- **View**: Allows you to change the view
- **Refresh**: Refreshes the information display
- **New**: Point to **New** then to **Database Instance** to open the Database Instance Editor and create a new database instance
- **Database Instance Wizard**: Launches the Database Instance Wizard, which allows you to create a new database instance
CHAPTER 14

Database Instance Wizard

What is it?
The Database Instance Wizard allows you to quickly create a new database instance and an associated database connection and database login.

How do I access it?
From the Administration menu, choose Database Instance Wizard.

What can I do with it?
The Database Instance Wizard allows you to:
• create a new database instance and an associated database connection and database login

For instructions on completing the above task, refer to the following How do I...? topic:
Database instances

What should I know before I use it?
Before you begin using the Database Instance Wizard, you should:
• know the type and login information for the database for which you wish to create a database instance
• have created an ODBC DSN for the database
• have system administration privileges

For more information on the above topics, refer to the following concept:
Database Connectivity
Database Instance Wizard layout

The Database Instance Wizard consists of the following pages:

• Introduction
• Database Instance Definition
• Database Connection Definition
• Summary

Click Next to advance to the next page of the wizard. Click Back to go back to the previous page. Click Cancel at any time to exit the wizard without saving any changes.

Introduction

This page provides a brief summary of the steps required to create a database instance. You can choose not to display this page again in the future.

Database Instance Definition

This page allows you to enter a name and a description for the database instance you are creating.

In addition, you must select the database type on this page. The wizard will set defaults for the VLDB settings based on the database type you choose.

Database Connection Definition

On this page you create the default database connection and the default database login for the database instance.

You create the database connection by specifying the ODBC DSN that points to the database for which you are creating the database instance.

You create the database login by specifying the login and password information for the database. You may choose either to enter a login and password or to use Windows NT authentication.

Summary

This page provides a summary of the selections you made while creating the database instance. Review the information and click Finish to create the database instance.
CHAPTER 15

Diagnostics Configuration Editor

What is it?

The Diagnostics Configuration Editor allows you to specify for which components you want tracing information. It also allows you to choose the output format and level of detail for the tracing information.

How do I access it?

There are two ways to access the Diagnostics Configuration Editor, depending on where you are using MicroStrategy Desktop in relation to MicroStrategy Server:

• If MicroStrategy Server is running on a remote machine, you can only access the editor from the Tools menu by choosing Diagnostics. Any changes you make will not take effect until the server is restarted.

• If MicroStrategy is running on the local machine, you can access the editor from the Administration menu by choosing Diagnostics Configuration. In this case, your changes will take effect immediately.

What can I do with it?

The Diagnostics Configuration Editor allows you to:

• specify which components to trace
• determine the output format for the tracing information
• specify the name, location, and maximum size of the log file

For instructions on completing one of the above tasks, refer to the following How do I...? topic:

Diagnostics

What should I know before I use it?

Before you begin using the Diagnostics Configuration Editor, you should:

• Know how diagnostics logging works
• Have a general idea of which MicroStrategy Desktop components you wish to trace, depending on the problem you are troubleshooting
• Understand that you cannot run diagnostics for products installed on a different machine

For more information on these topics, refer to the following topic:
Appendix B: Diagnostics

Diagnostics Configuration Editor layout

The Diagnostics Configuration Editor has the following tabs:
• Trace
• Advanced
• Errors

**Note:** Any changes you make to settings in the Diagnostics Configuration Editor only apply to MicroStrategy products installed on the machine on which you are working. You cannot make changes to diagnostics settings for products on a remote machine.

You will see only diagnostic information for components installed on the machine from which you are working. For example, if you choose to trace client connection on the client machine, you will not see any information about client connection activities that take place in MicroStrategy Intelligence Server.

You must quit and restart MicroStrategy Desktop or stop and restart MicroStrategy Intelligence Server for the diagnostics settings to take affect.

Diagnostics Configuration Editor: Trace tab

The Trace tab allows you to specify the MicroStrategy Desktop components to trace. In addition, you can trace information about some common processes like report execution and object browsing.

Select the appropriate check boxes for the components you wish to trace.

Diagnostics Configuration Editor: Advanced tab

The Advanced tab provides extremely low level tracing options for specific components within MicroStrategy Intelligence Server.
**Rule:** You should not use the options in the Advanced tab unless instructed to do so by MicroStrategy Technical Support.

---

**Diagnostics Configuration Editor: Errors tab**

The Errors tab allows you to choose the output format for the tracing information. You have the following options:

- **Select Debug Monitor** to output active trace information directly to the Log Viewer.
- **If you select Log file to create a log file, you can also**
  - select **Append to file** to append the new log file to the end of an existing log file.
  - select **Circular log file** to overwrite an existing log file from the beginning after the maximum file size (specified in the File size box) is reached.
- **Select Warning messages to log warning messages in addition to the standard log file messages.**

---

**Diagnostics Configuration Editor toolbar and menu options**

The following toolbar and menu options are specific to the Diagnostic Configuration Editor:

<table>
<thead>
<tr>
<th>Location and Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools menu</td>
<td></td>
</tr>
<tr>
<td>Clear All</td>
<td>Clears all selected check boxes</td>
</tr>
<tr>
<td>Toolbar</td>
<td></td>
</tr>
<tr>
<td>Clear All</td>
<td>Clears all selected check boxes</td>
</tr>
</tbody>
</table>
What is it?

The Event Viewer allows you to manage events for event-based schedules.

How do I access it?

From the Administration menu, choose Events.

What can I do with it?

The Event Viewer allows you to:
• create, rename, trigger and delete events

For instructions on completing the above task, refer to the following How do I...? topic:
Schedules

What should I know before I use it?

Before you begin using the Event Viewer, you should:
• know what events you wish to use for event-based scheduling
• have system administration privileges

For more information on the above topics, refer to the following concepts:
• Scheduling
• Security

Event Viewer layout

The Event Viewer displays the name and description of all events that you create.
To create a new event, right-click in the display and select New. To trigger an event, right-click the event you wish to trigger and select Trigger.
Right-clicking an event brings up a menu with the following choices:

- **New**: Creates a new event
- **Delete**: Deletes the selected event
- **Rename**: Renames the selected event
- **Trigger**: Triggers the selected event
- **Properties**: Opens the Properties window for the selected event

### Event Viewer toolbar and menu options

The following toolbar and menu options are specific to the Event Viewer:

<table>
<thead>
<tr>
<th>Location and Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>File menu</td>
<td></td>
</tr>
<tr>
<td>Trigger</td>
<td>Triggers the selected event. All event-based schedules associated with the event are executed.</td>
</tr>
<tr>
<td>Toolbar</td>
<td></td>
</tr>
<tr>
<td>Trigger event immediately</td>
<td>Triggers the selected event. All event-based schedules associated with the event are executed.</td>
</tr>
</tbody>
</table>
CHAPTER 17

Group Editor

**What is it?**

The Group Editor allows you to create and modify user groups.

**How do I access it?**

1. Select the User Manager.
2. To create a new group, go to the File menu, point to New, then choose Group. To modify an existing group, right-click the group you wish to modify and choose Edit.

**What can I do with it?**

The Group Editor allows you to:

- create or modify groups
- add users to or remove users from a group
- create a new user via the User Editor
- add groups to or remove groups from a group
- assign privileges to or revoke privileges from a group

For instructions on completing one of the above tasks, refer to the following How do I...? topics:

- Groups
- Users

**What should I know before I use it?**

Before you begin using the Group Editor, you should:

- understand the basic security requirements of your system
- know which privileges provide access to which application functionality
- have system administration privileges

For more information on the above topics, refer to the following concept:
Security

**Group Editor layout**

The Group Editor has the following tabs:
- General
- Privileges

**Group Editor: General tab**

The General tab allows you to:
- specify the name of the group
- create a description for the group
- add users to the group
- remove users from the group
- create a new user via the User Editor

Click **Add** to add users to the group. Click **Remove** to remove the selected user(s) from the group. To create a new user, click **New User** and the User Editor appears. To learn more about the User Editor, see the following Interface topic:

User Editor

**Group Editor: Privileges tab**

The privileges tab allows you to assign privileges to the group. For a complete list and definition of the available privileges, see the following appendix:

Appendix D: Permissions and Privileges

---

**Note:** Any users or groups that are members of the group you are editing will inherit the privileges you assign to the group.
Job Monitor

**What is it?**

The Job Monitor allows you to see all jobs currently executing in a particular project source.

**How do I access it?**

You can find the Job Monitor for a particular project source in the project source’s Administration hierarchy.

**What can I do with it?**

The Job Monitor allows you to:

- view the status of all currently executing jobs
- view the SQL for an executing job
- cancel an executing job

For instructions on completing one of the above tasks, refer to the following How do I...? topics:

- Jobs
- SQL

**What should I know before I use it?**

Before you begin using the Job Monitor, you should:

- understand basic job processing concepts
- know what job prioritizations exist, if any
- have system monitoring privileges to view information in the Job Monitor
- have system administration privileges to stop a job from executing using the Job Monitor
For more information on the above topics, refer to the following concepts:

- Job Processing
- Security

**Job Monitor layout**

To view details, choose **Details** from the **View** menu. The Job Monitor provides you with the following information about currently executing jobs for the project source:

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job ID</td>
<td>Numeric identifier assigned to the job</td>
</tr>
<tr>
<td>User</td>
<td>Name of the user who submitted the job</td>
</tr>
<tr>
<td>Status</td>
<td>Displays one of the following statuses:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Canceled</strong>: the job is being cancelled</td>
</tr>
<tr>
<td></td>
<td>• <strong>Executing</strong>: the job is currently executing</td>
</tr>
<tr>
<td></td>
<td>• <strong>Ready to execute</strong>: the job is in the queue</td>
</tr>
<tr>
<td></td>
<td>waiting to begin executing</td>
</tr>
<tr>
<td></td>
<td>• <strong>Error</strong>: an error was encountered while</td>
</tr>
<tr>
<td></td>
<td>processing the job</td>
</tr>
<tr>
<td></td>
<td>• <strong>Waiting for autoprompt</strong>: the job is on hold</td>
</tr>
<tr>
<td></td>
<td>until the user answers a prompt</td>
</tr>
<tr>
<td>Description</td>
<td>Current state of the job execution</td>
</tr>
<tr>
<td>Project ID</td>
<td>ID of the project from which the job was</td>
</tr>
<tr>
<td></td>
<td>submitted</td>
</tr>
</tbody>
</table>

The following additional information can be displayed by choosing **Complete Information** from the right-click menu:

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>Name of the project from which the job was submitted</td>
</tr>
</tbody>
</table>
Right-clicking a job ID brings up a menu with the following choices:

- **Quick View**: Opens the Quick View for a job
- **View**: Allows you to change the view
- **Line Up Icons**: If you are using the Large Icons or Small Icons view, this automatically arranges the icons for you
- **Refresh**: Refreshes the information display
- **Filter by User**: Sorts the information by user
- **Complete information**: If you are using the Details view, this displays the four additional columns described above
- **Delete**: Cancels the selected job
CHAPTER 19

Job Prioritization Wizard

What is it?

The Job Prioritization Wizard guides you through the process of creating job prioritizations.

How do I access it?

There are two ways to access the Job Prioritization Wizard: from the Database Instance Manager and from the Project Monitor.

1. To access the wizard from the Database Instance Manager:
   ◊ Select the Database Instance Manager.
   ◊ Right-click the database instance for which you wish to create job prioritizations and select Prioritization. The Database Instance Editor appears with the Job Prioritization tab selected.
   ◊ Click New to open the Job Prioritization Wizard.

2. To access the wizard from the Project Monitor:
   • Select the Project Monitor.
   • Right-click the project for which you wish to create job prioritizations and select Prioritization. The Database Instance Editor appears with the Job Prioritization tab selected.
   • Click New to open the Job Prioritization Wizard.

What can I do with it?

The Job Prioritization Wizard allows you to:
• create job prioritizations based on groups, projects, and/or job cost

For instructions on completing the above task, refer to the following How do I...? topic:
Job prioritizations
What should I know before I use it?

Before you begin using the Job Prioritization Wizard, you should:

• understand the usage patterns for the databases in your system
• know what variables you wish to use to define job prioritizations
• have system administration privileges

For more information on the above topics, refer to the following concepts:

• Job Processing
• Security

Job Prioritization Wizard layout

The Job Prioritization Wizard consists of the following pages:

• Priority Options
• Priority By Job Cost
• Priority By User Group
• Priority By Project
• Summary

Note: Depending on how you choose to define the job prioritizations, you may or may not see all five pages. For example, if you choose to define priority based only on job cost, you will not see the Priority By User Group or Priority By Project pages.

Click Next to advance to the next page of the wizard. Click Back to go back to the previous page. Click Cancel at any time to exit the wizard without saving any changes.

Priority Options

The first page of the wizard allows you to choose the variables that will be used to define the prioritization scheme. There are three choices:

• Cost
• User group
• Project
**Priority By Job Cost**

On this page you define the cost ranges for Light, Medium, and Heavy.

For example, suppose you create the following cost groupings:

- Light: 0-400
- Medium: 401-800
- Heavy: 801-1000

Then, on the last page of the wizard, you assign the cost groupings the following priority:

- Light: high priority
- Medium: medium priority
- Heavy: low priority

In this case, if a user runs a report with a cost of 900, it will be given a low priority.

**Priority By User Group**

On this page you select the groups for which you wish to define job priorities.

For example, if you want all reports run by users in the System Administrators group to have high priority, then add the System Administrators group to the **Selected Groups** list.

**Priority By Project**

On this page you select the projects by which you wish to define job priority.

For example, if you want all reports that come from the VMall project to have low priority, then add the VMall project to the **Selected Projects** list.

**Summary**

This page displays all the combinations of priority variables based on your cost, user group, and project selections. Right-click an entry in the table to change the priority or to delete it.

For example, if you want all reports run by users in the System Administrators group to have high priority, regardless of report cost or project, then set the priority of all the entries that have the System Administrators group to High.

Click **Finish** to save the job prioritizations.
MicroStrategy Server Configuration Editor

**What is it?**

The MicroStrategy Server Configuration Editor is used to modify advanced MicroStrategy Server settings, register projects, and load projects.

**How do I access it?**

From the Administrator menu, choose Configure MicroStrategy Server.

**What can I do with it?**

Through the MicroStrategy Server Configuration Editor you can:
- edit the description of the MicroStrategy Server
- change the communication protocol, port number, and number of connection threads
- choose whether to use the NT Performance Monitor
- choose whether to allow scheduling
- set server level governors
- configure backup settings
- configure inbox settings
- register a project

For instructions on completing one of the above tasks, refer to the following How do I...? topics:
- Governors
- Projects
- Schedules
- MSTR Intelligence Servers
What should I know before I use it?

Before you begin using the editor, you should:

• know what the inbox is and how it works
• know what governors are and how they should apply to the system
• understand the backup requirements for the system
• have system administration privileges

For more information on the above topics, refer to the following concept:
Administration Fundamentals

MicroStrategy Server Configuration Editor layout

The editor has the following tabs:

• General
• Advanced
• Projects

MicroStrategy Server Configuration Editor: General tab

The General tab allows you to:

• edit the server description
• configure communications options
• choose whether to use the NT Performance Monitor
• choose whether to allow scheduling

MicroStrategy Server Configuration Editor: Advanced tab

The Advanced tab allows you to:

• set server level governors
• configure backup option
MicroStrategy Server Configuration Editor:
Projects tab

The Projects tab allows you to register and load MicroStrategy 6.x and MicroStrategy 7 projects on the server.
MicroStrategy Intelligence Server
Service Manager

What is it?
The Service Manager allows you to configure and manage MicroStrategy Intelligence Server Windows NT services.

How do I access it?
Go to the Windows NT Start menu, point to Programs, then to MicroStrategy 7, then Intelligence Server, then MicroStrategy Service Manager.

Note: The Service Manager is only available on machines on which you have installed MicroStrategy Intelligence Server.

What can I do with it?
Through the Service Manager, you can:
• view the status of a MicroStrategy Intelligence Server
• start and stop the MicroStrategy Intelligence Server service
• start and stop the MicroStrategy Listener service
• set the service startup type
For instructions on completing one of the above tasks, refer to the following How do I...? topic:
MicroStrategy Intelligence Servers

What should I know before I use it?
Before you begin using the Service Manager, you should:
• Have NT administrator privileges on the machine on which the service is running
MicroStrategy Web Administrator page

What is it?
The Web Administrator page allows you to configure and manage MicroStrategy Web connections to MicroStrategy Intelligence Servers.

How do I access it?
Click Go to the Administrator page on the MicroStrategy Web Home page.

Rule: In order to see this link, you must be logged in to a project in which you have the Web Administration privilege.

What can I do with it?
Through the Web Administrator page, you can:
• connect MicroStrategy Web to MicroStrategy Intelligence Servers
• disconnect MicroStrategy Web from MicroStrategy Intelligence Servers
• view all the MicroStrategy Intelligence Servers available on the network
• set the MicroStrategy Web start mode, port number, and the initial and maximum number of connections allowed from MicroStrategy Web to a MicroStrategy Intelligence Server
• set web server and request timeouts
• view the MicroStrategy Web error log

For instructions on completing one of the above tasks, refer to the following How do I...? topics:
• MicroStrategy Intelligence Servers
• MicroStrategy Web
**What should I know before I use it?**

Before you begin using the Web Administrator page, you should:

- have the Web Administration privilege
- have a general idea of the workload you expect for MicroStrategy Web

For more information on the above topics, refer to the following concepts:

- Security
- MicroStrategy Web administration

**Administrator page layout**

The Administrator page has the following major sections:

- Connected servers list
- Unconnected servers list
- Available servers list
- Web Server box

**Connected servers list**

The Connected servers list provides you with the following information about the MicroStrategy Intelligence Servers to which MicroStrategy Web is currently connected.

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>ID of the cluster to which the MicroStrategy Intelligence belongs</td>
</tr>
<tr>
<td>Server name</td>
<td>Name of the MicroStrategy Intelligence Server</td>
</tr>
<tr>
<td>Start mode</td>
<td>Displays either Auto or Manual:</td>
</tr>
<tr>
<td></td>
<td>• Auto means that MicroStrategy Web will automatically connect to the MicroStrategy Intelligence Server when Microsoft IIS starts</td>
</tr>
<tr>
<td></td>
<td>• Manual means that you have to manually connect MicroStrategy Web to the MicroStrategy Intelligence Server</td>
</tr>
<tr>
<td>Loaded</td>
<td>The number of loaded connections</td>
</tr>
</tbody>
</table>
The Unconnected servers list provides you with the following information about the MicroStrategy Intelligence Servers to which MicroStrategy Web has been recently connected.

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Busy</td>
<td>The number of busy connections to the MicroStrategy Intelligence Server</td>
</tr>
<tr>
<td>Free</td>
<td>The number of free connections to the MicroStrategy Intelligence Server</td>
</tr>
<tr>
<td>Maximum pool size</td>
<td>The maximum number of connections MicroStrategy Web can make to the MicroStrategy Intelligence Server</td>
</tr>
<tr>
<td>Action</td>
<td>Click Disconnect to disconnect MicroStrategy Web from the MicroStrategy Intelligence Server.</td>
</tr>
<tr>
<td>Properties</td>
<td>Click Modify to modify the start mode or the maximum pool size</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server name</td>
<td>Name of the MicroStrategy Intelligence Server</td>
</tr>
<tr>
<td>Start mode</td>
<td>Displays either Auto or Manual:</td>
</tr>
<tr>
<td></td>
<td>• Auto means that MicroStrategy Web will automatically connect to the MicroStrategy Intelligence Server when Microsoft IIS starts</td>
</tr>
<tr>
<td></td>
<td>• Manual means that you have to manually connect MicroStrategy Web to the MicroStrategy Intelligence Server</td>
</tr>
<tr>
<td>Initial pool size</td>
<td>The number of available connections initially established to a MicroStrategy Intelligence Server. After that, some connection become “busy” as requests are made, other remain “free.”</td>
</tr>
</tbody>
</table>
Available servers list

The Available servers list (click Show All Available Servers if this list is not displayed) provides you with the following information about the available MicroStrategy Intelligence Servers to which MicroStrategy Web can connect:

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum pool size</td>
<td>The maximum number of connections MicroStrategy Web can make to the MicroStrategy Intelligence Server</td>
</tr>
<tr>
<td>Action</td>
<td>Click Connect to connect MicroStrategy Web to the MicroStrategy Intelligence Server.</td>
</tr>
<tr>
<td>Properties</td>
<td>Click Modify to modify the start mode, port number, initial pool size and maximum pool size</td>
</tr>
</tbody>
</table>

Web Server box

The Web Server box allows you to set the following timeouts:

- Server busy timeout
- Request timeout
CHAPTER 23

Project Configuration Editor

What is it?

The Project Configuration Editor allows you to configure numerous project level settings such as governing, connection mapping, and security roles.

How do I access it?

In the Project Monitor, right-click the project you wish to configure and choose Configure Project.

What can I do with it?

Through the Project Configuration Editor, you can

• edit a description for the project
• modify the warehouse database instance and its associated VLDB properties
• set project level governors
• configure project level caching options
• create, modify, and delete connection mappings
• configure statistics collection for the project
• create, modify, delete, and apply security roles
• create and modify security filters
• configure SQL generation options
• advanced options such as the document directory, prompt styles, element browsing governors, and analytical engine settings

For instructions on completing one of the above tasks, refer to the following How do I...? topics:

• Caches
• Database Connections
• Database Instances
• Governors
What should I know before I use it?

Before you begin using the Project Configuration Editor, you should

- know what governors are and understand the governing requirements for your system
- understand how caching works
- know the security requirements of your system so you can create connection mappings, security roles, and security filters
- know how statistics are recorded and which statistics you need to record for your system
- have system administration administrative privileges

For more information on the above topics, refer to the following topics:

- Administration Fundamentals
- Caching
- Database Connectivity
- Security
- Appendix A: Statistics

Project Configuration Editor layout

The Project Configuration Editor has the following tabs:

- General
- Governing
- Caching
- Connection Mapping
- Statistics
- Security Roles
- Security Filter
- SQL Generation
- Advanced
Project Configuration Editor: General tab

The *General* Tab allows you to

- create or edit a description of the project
- view the date and time at which the project was created and when it was last changed
- modify the VLDB properties for the warehouse database instance

Click **VLDB Properties** to modify the warehouse database instance VLDB properties via the **VLDB Properties Editor**.

Project Configuration Editor: Governing tab

The *Governing* tab allows you to set the following project level governors:

- report execution time
- number of result rows
- jobs per user account
- jobs per user session
- jobs per project
- user sessions per project

These governors are only applied to the particular project for which you set them. Other projects registered with the server could have different values for these governors.

Project Configuration Editor: Caching tab

The *Caching* tab allows you to

- enable or disable report caching
- set the cache file directory
- set the report cache duration
- limit the amount of disk space and RAM used for report caching
- limit the amount of RAM used for object caching and element caching
- purge all element and object caches
Project Configuration Editor: Connection Mapping tab

The **Connection Mapping** tab allows you to create, modify and delete connection mappings. Click **New** to create a new connection mapping. Click **Delete** to delete the selected connection mapping. Click **Modify** to modify the selected connection mapping.

Project Configuration Editor: Statistics tab

The **Statistics** tab allows you to
- select the database instance used for statistics
- purge the statistics tables
- determine which statistics to record

Click **New** to create a new database instance for the statistics tables via the Database Instance Editor. Click **Modify** to modify the current database instance you are using for the statistics tables.

Click **Purge now** to purge the statistics database of all information created between the selected dates.

Project Configuration Editor: Security Roles tab

The **Security Roles** tab allows you to
- view the existing security roles
- access the **Security Roles Viewer**, which allows you to create, modify and delete security roles
- assign a security role to a group or to individual users

Click **View** to view the existing security roles.

Project Configuration Editor: Security Filter tab

The **Security Filter** tab allows you to assign security filters to groups or to individual users.

Click **Import** to import a filter to be used as a security filter. Click **Clear** to remove the imported filter.

Click **Add** to add a top range or bottom range attribute. Click **Remove** to remove the selected top or bottom range attributes.
**Project Configuration Editor: SQL Generation tab**

The *SQL Generation* tab allows you to

- define attributes weights to be used when creating a temporary table index
- configure options for the Warehouse Catalog
- set the default behavior of the attribute and fact creation tools
- determine whether the system should check for invalid characters in custom column names

**Project Configuration Editor: Advanced tab**

The *Advanced* tab allows you to

- set the document directory
- modify the prompt styles available for web
- limit the maximum number of elements that can be displayed at one time in Folder List
- configure analytical engine settings
CHAPTER 24

Project Monitor

What is it?
The Project Monitor allows you to monitor and manage projects.

How do I access it?
You can find the Project Monitor for a particular project source in the project source’s Administration hierarchy.

What can I do with it?
Through the Project Monitor you can:
• access the Project Configuration Editor
• load and unload projects
• change a project’s status
• access the Job Prioritization Wizard
• register projects

For instructions on completing one of the above tasks, refer to the following How do I...? topics:
• Projects
• Job Prioritizations

What should I know before I use it?
Before you begin using the Project Monitor, you should:
• have system monitoring privileges to view project information
• have system administration privileges to change a project’s mode

For more information on the above topics, refer to the following concepts:
• Administration Fundamentals
• Security
Project Monitor layout

To view details, choose Details from the View menu. The Project Monitor provides you with the following information about projects in this project source:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Information Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>Name of the project</td>
</tr>
<tr>
<td>Project ID</td>
<td>Numeric identifier for the project</td>
</tr>
</tbody>
</table>
| Status      | Displays one of the following project statuses:  
|             | • Loaded               
|             | • Unload Pending       
|             | • Execution Idle       
|             | • Request Idle         
|             | • Full Idle            
|             | • Unloaded             |

Right-clicking a project brings up a menu with the following choices:

- **Configure Project**: Opens the Project Configuration Editor for the selected project
- **View**: Allows you to change the view
- **Line up icons**: If you are using the Large Icons or Small Icons view, this automatically arranges the icons for you
- **Refresh**: Refreshes the information display
- **Unload**: Unloads the selected project(s)
- **Idle/Resume**: Opens the Idle/Resume widow for the selected project
- **Prioritization**: Opens the Database Instance Editor with the Job Prioritization tab selected
- **Register projects**: Opens the Server Configuration Editor with the Projects tab selected
The Project Mover Wizard guides you through the process of moving MicroStrategy 7 projects from one database platform to another.

How do I access it?

1. Locate the PROJECTMOVER.EXE file. By default, the .exe file can be found in the following path:
   C:\Program Files\Common Files\MicroStrategy\Demo\PROJECTMOVER.EXE
2. Double-click the PROJECTMOVER.EXE file to launch the wizard.

What can I do with it?

The Project Mover Wizard enables you to transfer MicroStrategy 7 projects to different database platforms. For example, using the Project Mover Wizard, you can transfer an entire MicroStrategy 7 project to Oracle 8.0, Microsoft SQL Server, or to any other supported platform. The Project Mover Wizard

- automatically creates repositories and converts database information to one of the supported formats.
- configures transferred projects so you can work with them “out of the box.”
- lets you run your SQL script(s) before and after your data warehouse is transferred.

What should I know before I use it?

Using Project Mover, you can transfer your MicroStrategy 7 projects to the following platforms:

- Oracle 7.3.x, 8.0, 8.1x, 8i
- IBM DB2 UDB 5.2, 6.1
- Microsoft SQL Server 7.0
Project Mover Layout

The Project Mover Wizard consists of the following pages:

- Introduction
- Transfer Options
- Project Selection
- Metadata Repository Location
- Warehouse Location
- Metadata Repository Connection
- Summary

Introduction

This page provides a brief description of the Project Wizard’s functions. You can choose to skip this screen the next time you run Project Wizard.

Transfer Options

This page allows you to specify the source files for your metadata and warehouse data. Project Mover will copy information from the selected source files to the target files.

**Note:** Project Mover does not allow you to transfer warehouse data without also transferring metadata.

Project Selection

Use this page to verify the project you want to transfer.

Metadata Repository Location

On this page, the wizard prompts you to select a target data source name (DSN) for the metadata repository. Repository information is transferred from the source files to the specified target. Optionally, you can specify a new data source from this page by clicking the New button.
Warehouse Location

On this page, the wizard prompts you for a target Data Source Name (DSN) for the project’s data warehouse. Information will be transferred from the source files to the specified target DSN. This page also lets you create a new data source by clicking the New button.

Metadata Repository Connection

Use this page to enter a project source name. The name you enter will be used to identify your metadata repository connection in the MicroStrategy Desktop and in MicroStrategy Web.

Summary

This page displays the items to be transferred, the source files, and the destination(s) for those items, the target Data Source Names (DSNs).

If the information on this page is incorrect, you may go back to any of the previous pages to make corrections. After you have checked your settings, click the Transfer button to begin the transfer process. The Project Mover displays the progress so you can track the transfer process.
Schedule Manager

**What is it?**

The **Schedule Manager** lists all of the schedules defined for a particular project source.

**How do I access it?**

You can find the Schedule Manager for a project source in the project source’s Administration section.

**What can I do with it?**

Through the Schedule Manager you can:

- launch the Schedule Wizard, which allows you to create a new schedule or modify an existing schedule
- delete schedules
- launch the Event Viewer, which allows you to create, modify, and trigger events for event-based schedules

For instructions on completing one of the above tasks, refer to the following **How do I...?** topic:

Schedules

**What should I know before I use it?**

Before you begin using the Schedule Manager, you should:

- understand the scheduling requirements of your users
- have system administration privileges

For more information on the above topics, refer to the following concepts:

- Scheduling
- Security
Schedule Manager layout

To viewing details, choose Details from the View menu. The Schedule Manager provides you with the following information about the databases instances defined for a project source:

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the schedule</td>
</tr>
<tr>
<td>Owner</td>
<td>User who created the schedule</td>
</tr>
<tr>
<td>Modification Time</td>
<td>Last date and time at which the schedule was modified</td>
</tr>
<tr>
<td>Description</td>
<td>If you included a description in the schedule definition, it is displayed here</td>
</tr>
</tbody>
</table>

Right-clicking a schedule brings up a menu with the following choices:

- **Edit**: Opens the **Schedule Wizard**
- **Delete**: Deletes the selected schedule
- **Rename**: Allows you to rename the selected schedule
- **Properties**: Opens the **Properties** window for the selected schedule

A right-click anywhere else in the Schedule Manager dialog box brings up a menu with the following options:

- **View**: Allows you to change the view
- **Refresh**: Refreshes the information display
- **Events**: Opens the Event Viewer
- **New**: Point to **New**, then to **Schedule** to open the Schedule Wizard
CHAPTER 27

Schedule Monitor

What is it?
The Schedule Monitor lists all of the schedule requests for a particular project source.

How do I access it?
You can find the Schedule Monitor for a project source in the project source’s Administration section.

What can I do with it?
Through the Schedule Monitor you can
• view all of the schedule requests in the system
• delete schedule requests
For instructions on completing one of the above tasks, refer to the following How do I...? topic:
Schedules

What should I know before I use it?
Before you begin using the Schedule Monitor, you should
• understand the scheduling requirements of your users
• have system monitoring privileges to view schedule information
• have system administration privileges to create, edit, or delete schedules
• users must have schedule request privileges to schedule a report
For more information on the above topics, refer to the following concepts:
• Scheduling
• Security
Schedule Monitor layout

To view details, choose Details from the View menu. The Schedule Monitor provides you with the following information about the schedule requests in a project source:

- **Request Name**: The request name provides you with the following information:
  - Name of the user who created the schedule request
  - Name of the report that is scheduled
  - Name of the schedule associated with the schedule request

- **Schedule Name**: Name of the schedule associated with the schedule request

- **Schedule Type**: Displays either time-triggered or event-triggered

- **Project Name**: Project from which the schedule request was made

- **User Name**: Name of the user who made the schedule request

- **Next Update**: If the schedule is time-triggered, this displays the next date and time at which the schedule will be triggered
  If the schedule is event-triggered, this displays the name of the event that triggers the schedule

Right-clicking a schedule request brings up a menu with the following choices:

- **Quick View**: Opens the Quick View for a schedule request
- **View**: Allows you to change the view
- **Line Up Icons**: If you are using the Large Icons or Small Icons view, this automatically arranges the icons for you
- **Refresh**: Refreshes the information display
- **Filter by User**: Sorts the information by user
- **Filter by Project**: Sorts the information by project
- **Delete**: Cancels the selected schedule request
**Note:** Clicking **Expire** in the Quick View window is the same as deleting a schedule request by right-clicking the request and choosing **Delete**.
CHAPTER 28

Schedule Wizard

What is it?
The Schedule Wizard allows you to create schedules.

How do I access it?
To access the Schedule Wizard, you must have the Schedule Manager selected. On the File menu, point to New, then choose Schedule or you can click New Schedule on the main toolbar.

What can I do with it?
Through the Schedule Wizard you can
- create a new schedule or modify an existing one
- launch the Event Editor which allows you to create, modify, delete, and trigger events

For instructions on completing one of the above tasks, refer to the following How do I...? topic:
- Schedules

What should I know before I use it?
Before you begin using the Schedule Wizard, you should
- understand the scheduling requirements of the system
- have system administration privileges

For more information on the above topics, refer to the following concepts:
- Scheduling
- Security
Schedule Wizard layout

The Schedule Wizard consists of the following pages:

- Welcome
- Name & Description
- Type
- Validity Range
- Recurrence Pattern
- Recurrence Pattern (Preview)
- Event Selection
- Summary

Note: The pages you see depend on the type of schedule you choose to create. For example, if you choose to create a time-triggered schedule, you will not see the Event Selection page.

Click Next to advance to the next page of the wizard. Click Back to go back to the previous page. Click Cancel at any time to exit the wizard without saving any changes.

Welcome

This page provides a brief summary of the steps required to create a schedule. You can choose to not display this page again in the future.

Name & Description

This page allows you to enter a name and description for the schedule you are creating. A schedule name is required, but a description is optional.

Type

On this page you choose to create either an event-triggered schedule or a time-triggered schedule.
Validity Range

This page allows you to define the length of time during which the schedule will be active and available to users. The start date determines the first day on which the schedule will be active. The end date is the last day on which the schedule will be active.

Note: If you choose not to specify an end date, the schedule will remain active until you either delete the schedule or edit the schedule definition and specify an end date.

Recurrence Pattern

This page only appears if you are creating a time-triggered schedule. Specify the dates and times at which the schedule will run.

Recurrence Pattern (Preview)

This page only appears if you are creating a time-triggered schedule. Based on your selections on the previous page, this page displays up to the next 20 times that the schedule will run.

Event Selection

This page only appears if you are creating an event-triggered schedule. Select the event that you want to trigger the schedule.

Click Events to launch the Event Viewer, which allows you to edit an event or create a new one. For more information refer to the following Interface topic: Event Viewer

Summary

The final page of the Schedule Wizard displays a summary of the selections you made while creating the schedule. Review the information and click Finish to save your changes.
CHAPTER 29

Security Role Editor

What is it?
The Security Role Editor allows you to create and edit security roles.

How do I access it?
From the Administration menu, choose Security Roles.

What can I do with it?
Through the Security Role Editor you can create, modify, and delete security roles.
For instructions on completing one of the above tasks, refer to the following How do I...? topic:
Security Roles

What should I know before I use it?
Before you begin using the Security Role Editor, you should
• have system administration privileges
• understand the security requirements of your system
• know which privileges provide access to which application functionality
For more information on the above topics, refer to the following concept:
Security

Security Role Editor layout
When you open the Security Role Editor, the first window you see is the Security Roles window. This window lists the security roles that are defined for the project source. Click New to create a new security role. Click Delete to delete the selected security role(s). Click Modify to modify the selected security role.
Clicking **New** or **Modify** opens the **Security Role Editor** window. This window allows you to:

- edit the name of the security role
- edit the description
- select the privileges to associate with the security role
What is it?

The User Connection Monitor allows you to see the status of all user connections to a project source.

How do I access it?

You can find the User Connection Monitor for a particular project source under the project source’s Administration hierarchy.

What can I do with it?

Through the User Connection Monitor you can
• view information about all connected users, active and idle
• disconnect users

For instructions on completing one of the above tasks, refer to the following How do I...? topic:

Users

What should I know before I use it?

Before you begin using the User Connection Monitor, you should
• have system monitoring privileges to view user connection information
• have system administration privileges to disconnect other users

For more information on the above topics, refer to the following concept:

Security
**User Connection Monitor layout**

To view details, choose **Details** from the **View** menu. The User Connection Monitor provides you with the following information about users currently connected to the project source:

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Login ID with which the user is connected</td>
</tr>
<tr>
<td>Network Address</td>
<td>Network address from which the user is connected</td>
</tr>
<tr>
<td>Project</td>
<td>When a user connects to the server, this displays &lt;Server&gt;. When a user accesses a project, this displays the name of the project as well</td>
</tr>
<tr>
<td>Open jobs</td>
<td>Number of jobs the user has open</td>
</tr>
<tr>
<td>Source</td>
<td>User connections can come from one of the following sources:</td>
</tr>
<tr>
<td></td>
<td>• Desktop</td>
</tr>
<tr>
<td></td>
<td>• System console</td>
</tr>
<tr>
<td></td>
<td>• Web</td>
</tr>
<tr>
<td>Time connected</td>
<td>Date and time at which the user connected</td>
</tr>
<tr>
<td>First job in session</td>
<td>Date and time at which the user ran his first job after logging in</td>
</tr>
<tr>
<td>Last job in session</td>
<td>Date and time at which the user last ran a job</td>
</tr>
</tbody>
</table>

Right-clicking a user connection brings up a menu with the following choices:

- **Quick View**: Opens the Quick View for a user connection
- **View**: Allows you to change the view
- **Line Up Icons**: If you are using the Large Icons or Small Icons view, this automatically arranges the icons for you
- **Refresh**: Refreshes the information display
- **Disconnect User**: Disconnects the selected users
User Editor

What is it?
The User Editor allows you to create and modify users.

How do I access it?
1. Select the User Manager.
2. Locate the user you wish to modify or locate the group to which you wish to add a new user.
3. To create a new user, go to the File menu, point to New, then choose User. To modify an existing user, right-click the group you wish to modify and choose Edit.

What can I do with it?
Through the User Editor, you can
• create new users or modify existing users
• enable or disable user accounts
• link a user to a Windows NT user
• remove or change the link between a user and a Windows NT user
• change a user’s password
• set password expiration criteria
• add a user to or remove a user from a group
• assign privileges to or revoke privileges from a user

For instructions on completing one of the above tasks, refer to the following How do I...? topics:
• Users
What should I know before I use it?

Before you begin using the User Editor, you should
• understand the basic security requirements of the system
• know which privileges provide access to which application functionality
• have administrative privileges
For more information on the above topics, refer to the following concept:
• Security

User Editor layout

The User Editor has the following tabs:
• General
• Privileges
• Groups

User Editor: General tab

The General tab allows you to
• specify a login ID, a full name and a description for the user
• link the user to a Windows NT user
• remove or change the link between a user and a Windows NT user
• specify a password
• set password expiration criteria
• enable or disable the account

User Editor: Privileges tab

The privileges tab allows you to select the privileges you wish to assign to the user.

User Editor: Groups tab

The groups tab allows you to specify to which group(s) the user belongs.
CHAPTER 32

User Manager

What is it?
The User Manager allows you to manage and organize all the users and groups for a particular project source.

How do I access it?
You can find the User Manager for a particular project source under the project source’s Administration hierarchy.

What can I do with it?
Through the User Manager, you can
• organize users and groups
• create, modify, and delete users via the User Editor
• create, modify, and delete groups via the Group Editor
• duplicate users and groups
• import users and groups from Windows NT or from a text file
• link users to Windows NT users
• access the User Manager Integrity Checker

For instructions on completing one of the above tasks, refer to the following How do I...? topics:
• Users
• Groups

What should I know before I use it?
Before you begin using the User Manager, you should
• have system administration privileges
• understand the security requirements of your system

For more information on the above topics, refer to the following concept:
Security

User Manager layout

To view details, choose Details from the View menu. The User Manager provides you with the following information about the users and groups defined in the project source:

<table>
<thead>
<tr>
<th>Column</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop Login</td>
<td>For users, this displays the login ID. For groups, this displays the group name.</td>
</tr>
<tr>
<td>Name</td>
<td>For users, this displays the full name. For groups, this displays the group name.</td>
</tr>
<tr>
<td>Owner</td>
<td>Displays the full name of the user who created the user or group.</td>
</tr>
<tr>
<td>Account Status</td>
<td>For users, this displays either Enabled or Disabled. This column is blank for groups.</td>
</tr>
<tr>
<td>Description</td>
<td>Displays the description of the user or group, if one exists.</td>
</tr>
</tbody>
</table>
Chapter 33

User Manager Integrity Checker

What is it?

The User Manager Integrity Checker detects and fixes corruption in the configuration. Corruptions usually occur when a user or group is deleted but its links to other objects still exist.

How do I access it?

From the Administration menu, choose User Manager Integrity Checker.

What can I do with it?

Through the User Manager Integrity Checker, you can

- find and fix corruptions for users and groups

For instructions on completing the above task, refer to the following How do I...? topics:

- Users
- Groups

What should I know before I use it?

Before you begin using the User Manager Integrity Checker, you should

- have system administration privileges

For more information on the above topic, refer to the following concept:

- Security

User Manager Integrity Checker layout

The User Manager Integrity Checker is a single dialog. Select the appropriate check boxes and click Start to run the check. Click Stop to stop the check at any time. Click Fix to fix any corruptions the checker finds.
How do I...?

• Access control lists
• Caches
• Database connections
• Database instances
• Database logins
• Governors
• Groups
• Job prioritizations
• Jobs
• MicroStrategy Intelligence Servers
• MicroStrategy Web
• Passwords
• Projects
• Schedules
• Security filers
• Security roles
• SQL
• Statistics
• Users
Access control lists

Modify an object’s access control list

Steps

1. In the Folder List, locate and select the object whose access control list you wish to modify.
2. From the File menu, choose Properties. The Properties dialog appears.
3. Make modifications to the access control list in the Security tab. Click Add to add a new user or group to the list. Click Delete to remove a user or group from the list.
4. Click OK.

Take ownership of an object

Steps

1. Locate and select the object of which you wish to take ownership.
2. From the File menu, choose Properties. The Properties dialog appears.
4. Click OK.

View an object’s access control list

Steps

1. Locate and select the object whose access control list you wish to modify.
2. From the File menu, choose Properties. The Properties dialog appears.
3. You can view the access control list in the Security tab.
CHAPTER 37

Caches

Configure cache memory usage

Steps

1. In the Project Monitor, select the project you wish to configure.
2. From the Administration menu, choose Configure Project. The Project Configuration Editor opens.
3. Configure cache memory usage in the Caching tab. You can set the maximum amount of memory to be used for report caches, object caches, and element caches.
4. Click OK to save your changes.

Note

You must re-start the server before changes to caching settings take affect.

Configure caching in a MicroStrategy Intelligence Server cluster

Caching for clustered servers can be implemented using one of the following two approaches:

Approach 1: Steps

1. In the Caching tab of the Project Configuration Editor, set the cache directory to the following shared directory

\machine name\shared directory name

where machine name is the name of the machine on which the caches are stored and shared directory name is the name of the directory where caches are stored.
Make sure this cache directory is writeable. Caches are automatically shared in that directory, and each MicroStrategy Intelligence Server creates its own subdirectory.

2. Make sure the MicroStrategy Intelligence Server service runs under a network account that has write access to this shared cache directory.

3. Once the servers are running, you can cluster them using the Cluster Manager.

**Approach 2: Steps**

1. In the **Caching** tab of the **Project Configuration Editor**, set the cache directory to 
   \Caches\server definition name

2. On each server machine, share the following directory as **ClusterCaches**:
   Microstrategy\Intelligence Server\Caches\server definition name

3. Once the servers are running, you can cluster them using the Cluster Manager.

---

### Configure report cache duration

**Steps**

1. In the **Project Monitor**, select the project you wish to configure.

2. From the **Administration** menu, choose **Configure Project**. The **Project Configuration Editor** opens.

3. In the **Caching** tab, set the report cache duration.

4. Click **OK** to save your changes.

**Note**

You must restart the server before changes to caching settings take affect.

---

### Delete a report cache

**Steps**

In the **Cache Monitor**, select the cache you wish to delete and press DELETE.
Disable MicroStrategy Intelligence Server caching

**Steps**

1. Select the project for which you wish to disable server caching.
2. From the Administration menu, choose Configure Project. The Project Configuration Editor opens.
3. In the Caching tab, clear the Enable report server caching check box.
4. Click OK to save your changes.

**Note**
You must restart the server before changes to caching settings will take affect.

Enable MicroStrategy Intelligence Server caching

**Steps**

1. Select the project for which you wish to enable server caching.
2. From the Administration menu, choose Configure Project. The Project Configuration Editor opens.
3. On the Caching tab, select the Enable server caching check box to enable server caching.
4. Click OK.

**Note**
You must re-start the server before changes to caching settings will take affect.

Load a report cache from disk

**Steps**

1. In the Cache Monitor, select the caches you wish to load from disk.
2. From the Administration menu, choose Load from disk.

**Rule**
You cannot load an invalid cache from disk.
Unload a report cache to disk

**Steps**

1. In the **Cache Monitor**, select the cache you wish to save to disk.
2. From the **Administration** menu, choose **Unload to disk**.
CHAPTER 38

Database Connections

Change the default database login for a database connection

**Steps**
1. Open the Database Instance Editor.
2. In the General tab, select the database connection for which you want to change the default database login.
3. Click Modify. The Database Connections dialog box opens.
4. In the General tab, select a database login from the Database login box or click New to create a new one.
5. Click OK to save your changes. You are returned to the Database Instance Editor.
6. Close the Database Instance Editor.

Change the default ODBC DSN for a database connection

**Steps**
1. Open the Database Instance Editor.
2. In the General tab, select the database connection you wish to change.
3. Click Modify. The Database Connections dialog box opens.
4. In the General tab, select a DSN from the Local system ODBC data sources list to be the default.
5. Click OK to save your changes. You are returned to the Database Instance Editor.
6. Exit the Database Instance Editor.
Create a database connection

Steps

1. Open the Database Instance Editor.
2. In the General tab, click New. The Database Connections dialog box opens.
3. In the General tab, do the following:
   ◊ Type a name for the database connection in the Database connection name box.
   ◊ Select a default DSN from the list of Local system ODBC data sources.
   ◊ Select a default database login from the Database login list.
   ◊ If you wish, you can modify the default ODBC and connection caching settings in the Advanced tab.
4. Click OK to save the new database connection. You are returned to the Database Instance Editor.
5. Click OK to save the database instance in addition to the database connection. Otherwise, just click Cancel to exit the Database Instance Editor.

Notes

• Database connections are created automatically when you create a new database instance with the Database Instance Wizard. If you want to create a new database connection without creating a new database instance you need to use the Database Instance Editor.
• When you create or modify a database login or database connection, make sure the default database login and database connection are set correctly before you exit the Database Instance Editor.

Delete a database connection

Steps

1. Open the Database Instance Editor.
2. In the General tab, select the database connection you want to delete.
3. Click Delete.
4. Click OK.
**Disconnect a connection to a database**

**Steps**

In the **Database Connection Monitor**, right-click the connection ID you wish to disconnect and choose **Delete**.

**Modify a database connection**

**Steps**

1. Open the **Database Instance Editor**.
2. In the **General** tab, select the database connection you wish to modify and click **Modify**. The **Database Connection Editor** opens.
3. Make the necessary changes to the database connection definition.
4. Click **OK** to save your changes. You are returned to the **Database Instance Editor**.
5. Click **OK**.

**Note**

When you create or modify a database login or database connection, make sure the default database login and database connection are set correctly before you exit the **Database Instance Editor**.

**Modify advanced ODBC options for a database connection**

**Steps**

1. Open the **Database Instance Editor**.
2. In the **General** tab, select the database connection you wish to modify and click **Modify**. The **Database Connection Editor** opens.
3. In the **Advanced** tab, make the necessary changes to the ODBC options.
4. Click **OK**. You are returned to the **Database Instance Editor**.
5. Click **OK**.

Disconnect a connection to a database
Modify database connection caching options

Steps
1. Open the Database Instance Editor.
2. In the General tab, select the database connection you wish to modify from the Database connection list.
3. Click Modify. The Database Connection Editor opens.
4. In the Advanced tab, make the necessary changes to the database connection caching options.
5. Click OK to save your changes. You are returned to the Database Instance Editor.
6. Click OK.

Rename a database connection

Steps
1. Open the Database Instance Editor.
2. In the General tab, select the database connection you wish to rename from the Database connection list.
3. Click Modify. The Database Connection Editor opens.
4. Type the new name in the Database connection name box.
5. Click OK to save your changes. You are returned to the Database Instance Editor.
6. Click OK.
Change the default database connection for a database instance

Steps
1. In the Database Instance Manager, right-click the database instance you wish to change and choose Edit. The Database Instance Editor opens.
2. In the General tab, select a default database connection in the Database connection (default) box.
3. Click OK.

Create a database instance

There are two ways to create a database instance. Refer to one of the following How do I...? topics to learn how to create a database instance:

How do I create a database instance using the Database Instance Editor?

How do I create a database instance using the Database Instance Wizard?

Create a database instance with the Database Instance Editor

Steps
1. In the Folder List, select the Database Instance Manager.
2. On the File menu, point to New, then choose Database Instance. The Database Instance Editor opens.
3. Specify a name, a connection type, and the default database connection for the database instance.
4. If you wish, check the **Restrict each Database Connection to one warehouse query at a time** check box. This option allows you to TBD.

5. Select a default database connection or click **New** to create a new one. Refer to the following **How do I...?** topics for instructions about creating a database connection:

   How do I create a database connection?

6. If you wish, configure intermediate table storage and database gateway support on the **Advanced** tab.

7. If you wish, you can create a job prioritizations on the **Job Prioritization** tab. For details about creating job prioritizations, see the following **How do I...?** topic:

   How do I create a job prioritization?

8. When you are finished, click **OK** to create the database instance.

---

**Create a database instance with the Database Instance Wizard**

**Steps**

1. In the **Folder List**, select the **Database Instance Manager**.

2. From the **Administration** menu, choose **Database Instance Wizard**.

3. The **Database Instance Wizard** opens to the **Introduction** page.

4. Read the introduction and click **Next**.

5. On the **Database Instance Definition** page, provide the following information:

   ◊ **Name**: Type a name for the new database instance.
   
   ◊ **Description**: Type a description of the new database instance.
   
   ◊ **Type**: Choose the type of database that the database instance will access.

6. Click **Next**.
On the **Database Connection Definition** page, provide the following information:

◊ **Local system data source**: From the list of DSNs, select the DSN the database connection will use.

◊ **Database login and Password**: Type the login ID and password used to access the database.
   
   If you wish to use Windows NT (Trusted) authentication, check the **Use network login ID (Windows NT authentication)** check box. Any login ID and password information you entered will be ignored and Windows NT authentication will be used instead.

8. Click **Next**.

9. Review the information on the **Summary** page and click **Finish** to create the database instance.

### Delete a database instance

**Steps**

In the **Database Instance Manager**, right-click the database instance you want to delete and choose **Delete**.

### Modify a database instance

**Steps**

1. In the **Database Instance Manager**, right-click the name of the database instance you wish to modify and choose **Edit**. The **Database Instance Editor** opens.

2. Make the appropriate changes to the database instance definition.

3. Click **OK**.

---

*Delete a database instance* 151
CHAPTER 40

Database logins

Change the database login for particular user

Steps
1. Select the project in which you wish to change the database login for a user.
2. From the Administration menu, choose Configure Project. The Project Configuration Editor opens.
3. In the Connection Mapping tab, click New to create a new connection mapping. The Connection Mappings dialog box opens.
4. In the User list, select the user for whom you wish to specify a database login.
5. In the Warehouse Connection box, select the warehouse connection to be used.
6. In the Database Login box, select the database login to be used.
7. Click OK. You are returned to the Project Configuration Editor.
8. Click OK.

Create a database login

Steps
1. Open the Database Instance Editor.
2. In the General tab, click Modify (or click New if you want to create anew database connection, too). The Database Connections dialog box opens.
3. In the General tab, click New. The Database logins dialog box opens.
4. Type a name for the new database login in the Database login box.
5. If you wish to specify the login ID and password, type them in the appropriate boxes. If you wish to use Windows NT authentication to access the database, select the Use network login ID (Windows NT authentication) check box.

6. Click OK to save the new database login. You are returned to the Database Connections window.

7. Click OK. You are returned to the Database Instance Editor.

8. Click OK to exit the Database Instance Editor.

Notes

• Database logins are created automatically when you create a new database instance with the Database Instance Wizard. If you want to create a new database login without creating a new database instance you need to use the Database Instance Editor.

• When you create or modify a database login or database connection, make sure the default database login and database connection are set correctly before you exit the Database Instance Editor.

Delete a database login

Steps

1. Open the Database Instance Editor.

2. In the General tab, click New. The Database Connections window opens.

3. In the Database login list, select the database login you wish to delete and click Delete.

4. Click OK. You are returned to the Database Instance Editor.

5. Click OK.

Modify a database login

Steps

1. Open the Database Instance Editor.

2. In the General tab, click New. The Database Connections dialog box opens.

3. Select the database login you wish to modify from the Database login list and click Modify.
4. Make the appropriate changes to the database login definition.

5. Click OK. You are returned to the Database Connections window.

6. Click OK. You are returned to the Database Instance Editor.

7. Click OK to exit the Database Instance Editor.

Note

When you create or modify a database login or database connection, make sure the default database login and database connection are set correctly before you exit the Database Instance Editor.
CHAPTER 41

Diagnostics

Color code information in a log file

Steps

1. In the Log Viewer, open the log file you wish to color code.
4. In the first column on the Code by bar, select the variable by which you wish to color code the log file.
5. In the second column, select the operator you wish to use to color code the log file.
6. In the third column, enter the argument for the operator. Depending on the operator you choose, you may need to enter two arguments. If necessary, enter the second one in the fourth column.
7. Click Text to specify the font type.
8. Click F to specify the foreground color.
9. Click B to specify the background color.
10. Click OK.

Tip

For example, suppose you want all log entries containing the Process ID 75 to appear bold and in red. You would follow these steps:

1. In the Code by bar, select Process ID in the first column.
2. Select is (equals) in the second column.
3. Type 75 in the third column.
4. Click Text. The Font dialog box opens.
5. In the Font style list, select Bold.
6. Click OK.
7. Click F. The Color dialog box appears.
8. Choose a red color and click OK.
9. Click OK.

Create a log file

Steps
1. From the Tools menu, choose Diagnostics. The Diagnostics Configuration Editor opens.
2. In the Trace tab, select the check boxes corresponding to the components for which you wish to create a log file.
3. Check the Log file check box.
4. Specify the other log file options such as the location where the log file will be saved, the name of the log file, and the maximum size.
5. Click Save and Close.
6. In MicroStrategy Desktop, perform the task for which you are creating a log file.

Tip
For example, if you want to create a log for the Fact Editor, you would follow these steps:
1. Select the Fact Editor check box in the Trace tab of the Diagnostics Configuration Editor
2. Click Save and Close.
3. Return to MicroStrategy Desktop and use the Fact Editor. A log file will be produced containing information about the activities you performed in the Fact Editor.

Filter information in a log file

Steps
1. In the Log Viewer, open the log file you wish to filter.
3. Click Add Filter Set. The Filter Logs dialog box opens.
4. Click Add. A **Filter by** bar appears.

5. In the first column on the **Filter by** bar, select the variable by which you wish to filter the log file.

6. In the second column, select the operator you wish to use to filter the log file.

7. In the third column, enter the argument for the operator. Depending on the operator you chose, you may need to enter two arguments. If necessary, enter the second one in the fourth column.

8. Click **OK**. You are returned to the **Filter Sets** dialog.

9. Click **OK**.

## Save a log file

**Steps**

**To save the log file without any sorts, filters, or color codes you may have created:**

1. Click **Save Logs As** on the log window toolbar. The **Save As** dialog box opens.

2. Provide a name for the log file and save it in the desired location.

**To save the log file and preserve any sorts, filters, or color codes you may have created:**

1. Click **Save Filtered Logs As** on the log window toolbar. The **Save As** dialog box opens.

2. Provide a name for the log file and save it in the desired location.

## Save a log file color code

**Steps**

1. Click **Code Logs** on the log window toolbar. The **Code Logs** dialog box opens.

2. Click **Save**. The **Save As** dialog box opens.

3. Provide a name for the color code and save it in the desired location.
Note

Log file color codes are saved with a .lgc file extension.

Save a log file filter

Steps
1. Click Filter Logs on the log window toolbar. The Filter Sets dialog box opens.
2. Click Add Filter Set. The Filter Logs dialog box opens.
3. Click Save. The Save As dialog box opens.
4. Provide a name for the filter and save it in the desired location

Note

Log file filters are saved with a .lgf file extension.

Save a log file sort

Steps
1. Click Sort Logs on the log window toolbar. The Sort Logs dialog box opens.
2. Click Save. The Save As dialog box opens.
3. Provide a name for the sort and save it in the desired location.

Note

Log file filters are saved with a .lgf file extension.

Sort information in a log file

Steps
1. In the Log Viewer, open the log file you wish to sort.
2. On the toolbar, click Sort Logs. The Sort Logs dialog box opens.
3. Click Add. A Sort by bar appears.
4. In the first column on the Sort by bar, select the variable by which you wish to sort the log file.

5. In the second column, select either ascending or descending.

6. Click OK.

View active tracing information

Steps
1. From the Tools menu, choose Diagnostics. The Diagnostics Configuration Editor opens.
2. On the Trace tab, select the check boxes corresponding to the components you wish to trace.
3. In the Errors tab, select the Debug monitor check box.
4. Click Save and Close.
5. Open the Log File Viewer.
6. From the Window menu of the Log File Viewer, choose Debug Monitor. The Debug Monitor window appears.
7. In MicroStrategy Desktop, perform the task you wish to trace.
8. The tracing information appears in the Debug monitor window as the process happens in MicroStrategy Desktop.
CHAPTER 42

Governors

Limit report execution time

Steps
1. Select the project in which you wish to limit report execution time.
2. From the Administration menu, choose Configure Project. The Project Configuration Editor opens.
3. On the Governing tab, set the Report execution time governor in the Warehouse result set governing options.
4. Click OK to save your changes.

Limit the number of jobs per project

Steps
1. Select the project in which you wish to limit the number of jobs.
2. From the Administration menu, choose Configure Project. The Project Configuration Editor opens.
3. On the Governing tab, set the Jobs per project governor in the Job governing options.
4. Click OK to save your changes.

Limit the number of jobs per user account

Steps
1. Select the project in which you wish to limit the number of jobs per user account.
2. From the Administration menu, choose Configure Project. The Project Configuration Editor opens.
3. On the **Governing** tab, set the **Jobs per user account** governor in the **Job governing** options.

4. Click **OK** to save your changes.

### Limit the number of jobs per user session

**Steps**

1. Select the project in which you wish to limit the number of jobs per user session.

2. From the **Administration** menu, choose **Configure Project**. The **Project Configuration Editor** opens.

3. On the **Governing** tab, set the **Jobs per user session** governor in the **Job governing** options.

4. Click **OK** to save your changes.

### Limit the number of user sessions per project

**Steps**

1. Select the project in which you wish to limit the number of user sessions per project.

2. From the **Administration** menu, choose **Configure Project**. The **Project Configuration Editor** opens.

3. On the **Governing** tab, set the **User sessions per project** governor in the **User session governing** options.

4. Click **OK** to save your changes.
CHAPTER 43

Groups

Add members to a group

These steps assume that the user(s) and/or group(s) you wish to add have already been created. For details about creating users or groups, see the following How do I...? topics:

How do I create a user?
How do I create a group?

Steps
1. In the User Manager, locate and select the group to which you wish to add a member.
2. From the File menu, choose Edit. The Group Editor opens.
3. Click Add. The Add members dialog box opens.
4. Add users and groups by selecting them from the Available members list and clicking > to move them to the Selected members list.
5. Click OK. You are returned to the Group Editor.
6. Click OK to save your changes.

Create a group

Steps
1. In the Folder List, select the User Manager.
2. On the File menu, point to New then choose Group. The Group Editor appears.
3. On the General tab, type a name and description for the group. If you wish, click Add to add members to the group. You do not have to add members now, you can always add them later.
4. On the **Privileges** tab, select the privileges you wish to grant the group and its members.

5. Click **OK** to create the group.

### Import a group from Windows NT

**Steps**

1. In the **Folder List**, select the **User Manager**.

2. On the **Administration** menu, point to **Import**, then choose **NT Group**. The **Import NT Group** dialog box opens.

3. On the **General** tab, select the **NT domain** from which you wish to import a group.

4. Select the groups you wish to import. Select them by highlighting them in the **NT Users** list and moving them to the **Desktop users and groups** list by clicking >.

5. If you wish, on the **Default Settings** tab, configure default settings for the groups you import. These settings apply to all users in the groups you are importing. You can always change these settings later using the **User Editor**.

6. If you wish, on the **Privileges** tab, select the privileges granted to the groups you import. You can always change the privileges later using the **Group Editor**.

7. Click **OK** to import the groups.

### Import users and groups from a text file

**Steps**

1. On the **Administration** menu, point to **Import**, then choose **From File**. The **Import Users/Groups From File** dialog box opens.

2. Click ... to locate the .udf file from which you wish to import users and groups. The **Open** dialog box opens.

3. Locate and select the .udf file and click **Open**. You are returned to the **Import Users/Groups From File** dialog box.

4. Click **Load** to load the information from the file into the dialog.

5. If you wish to remove some users or groups from the list, select them and click **Delete**. To undo a delete, you have to reload the file.

6. Choose a password option in the **Password** box and provide the appropriate information.
7. If you wish, on the Privileges tab, select the privileges granted to the users and groups you import. You can always change the privileges later using the User Editor and the Group Editor.

8. Click OK to import the users and groups.

**Rule**

Any line in the .udf file beginning with # will be ignored. Each entry in the .udf file MUST have the following format to be valid:

```
IsGroup:Login:Full Name:Description:group1,group2,...:xyz
```

The above fields are interpreted as follows:

- *IsGroup* can be a 1 or a 0.
  - 1 denotes a group entry. The *Login* and *xyz* fields are ignored.
  - 0 denotes a user entry. The *Login* and *Full Name* fields must be provided
- *Full Name* is the full name of the user or group.
- *Description* is the description of the user or group.
- *group1,group2* ... indicates the membership of the new user or group.
- *xyz* are separate values. Each can be a 1 or a 0.
  - If x is 1 then the account is disabled.
  - If y is 1 then the user cannot change his password and z is ignored.
  - If z is 1 then the user must change his password the first time he logs in.

**Tip**

Here are some examples of valid entries in a .udf file:

1::ACME:Whole Company::<br>1::Technology:This is our technology group:ACME::<br>0:Joe:John Doe:Standard user: Standard group,Technology:000<br>0:John:John Smith::ACME,Public:110<br>0:Admin:Mike John:The system administrator:ACME,Technology:001

**Modify a group**

**Steps**

1. In the User Manager, select the group you wish to modify.
2. From the File menu, choose Edit. The Group Editor opens.
Remove members from a group

Steps

1. In the User Manager, select the group from which you wish to remove a member.
2. From the File menu, choose Edit. The Group Editor opens.
3. In the Members list, select the users and groups that you wish to remove and click Remove.
4. Click OK.
Create a job prioritization

**Steps**

1. Decide which of the variables (cost, user group, and project) you wish to use to determine job priority. The steps are different depending on which variables you use.

2. In the **Database Instance Manager**, select the database instance for which you wish to create a job prioritization. Note that job prioritizations only apply to warehouse database instances.

3. From the **Administration** menu, choose **Prioritization**. The **Database Instance Editor** opens with the **Job Prioritization** tab selected.

4. Click **New**. The **Job Prioritization Wizard** opens.

5. Follow the steps presented by the **Job Prioritization Wizard**.

6. Click **Finish** at the end of the wizard to create the job prioritization.

For specific details about creating a job prioritization based on each variable type, see the following How do I topics:

- How do I create a job prioritization based on cost?
- How do I create a job prioritization based on group?
- How do I create a job prioritization based on project?

**Rule**

You can create a job prioritization for any database instance, but it will only be used if the database instance represents a warehouse database, as opposed to a metadata or a statistics database.
Create a job prioritization based on cost

Steps
1. Select the database instance for which you wish to create a job prioritization.
2. From the Administration menu, choose Prioritization. The Database Instance Editor opens with the Job Prioritization tab selected.
4. On the Priority Options page, select the Cost check box and click Next.
5. On the Priority by Job Cost page, set the cost ranges you wish to use and click Next.
6. Review the information on the Summary page. Right-click a priority entry to change the priority or to delete it.
7. Click Finish to create the prioritizations.

Rule
You can create a job prioritization for any database instance, but it will only be used if the database instance represents a warehouse database as opposed to a metadata or a statistics database.

Create a job prioritization based on group

Steps
1. Select the database instance for which you wish to create a job prioritization.
2. From the Administration menu, choose Prioritization. The Database Instance Editor opens with the Job Prioritization tab selected.
4. On the Priority Options page, select the User group check box and click Next.
5. On the Priority by User Group page, select the groups you wish to use for prioritization. Select groups by highlighting them in the Available Groups list and moving them to the Selected Groups list by clicking >.
6. Click Next.
7. Review the information on the Summary page. Right-click a priority entry to change the priority or to delete it.
8. Click Finish to create the prioritizations.
**Rule**

You can create a job prioritization for any database instance, but it will only be used if the database instance represents a warehouse database as opposed to a metadata or a statistics database.

**Create a job prioritization based on project**

**Steps**

1. Select the database instance for which you wish to create a job prioritization.
2. From the Administration menu, choose Prioritization. The Database Instance Editor opens with the Job Prioritization tab selected.
4. On the Priority Options page, select the Project check box and click Next.
5. On the Priority by Project page, select the projects you wish to use for prioritization. Select projects by highlighting them in the Available Projects list and moving them to the Selected Projects list by clicking >.
6. Click Next.
7. Review the information on the Summary page. Right-click a priority entry to change the priority or to delete it.
8. Click Finish to create the prioritizations.

**Rule**

You can create a job prioritization for any database instance, but it will only be used if the database instance represents a warehouse database as opposed to a metadata or a statistics database.

**Delete a job prioritization**

**Steps**

1. In the Database Instance Manager, select the database instance for which you wish to delete a job prioritization.
2. From the Administration menu, choose Prioritization. The Database Instance Editor opens with the Job Prioritization tab selected.
3. Right-click the job prioritization you wish to delete and choose Delete.
4. Click OK.
Modify a job prioritization

Steps

1. Select the database instance for which you wish to modify a job prioritization.

2. From the Administration menu, choose Prioritization. The Database Instance Editor opens with the Job Prioritization tab displayed.

3. To add a new prioritization, click New. To modify an existing prioritization, right-click the one you wish to modify and choose the appropriate option.

4. Click OK to save your changes.
Jobs

Cancel an executing job

Steps

1. In the Administration hierarchy, select the Job Monitor.
2. Select the job you wish to cancel and press DELETE.
3. A dialog appears asking you to confirm this action. Click Yes to cancel the job or click No to allow it to continue.
CHAPTER 46

MicroStrategy Intelligence Servers

Add an additional MicroStrategy Intelligence Server to a cluster

Steps
1. In the Folder List, select the Cluster Monitor.
2. From the Administration menu, choose Join cluster. The Cluster Manager window appears.
3. Type the name of the MicroStrategy Intelligence Server you wish to add to the cluster or click ... to browse for one.
4. Click OK to add the MicroStrategy Intelligence Server.

Rule
The MicroStrategy Intelligence Servers in a cluster must be identically configured. They must use the same server definition and they must have the same projects registered.

Allow anonymous access to a MicroStrategy Intelligence Server

Steps
1. In the Folder List, right-click the Administration icon and select Properties. The Properties dialog opens.
2. In the Security tab, click Add.
3. In the dialog that opens, select the Public group.
4. In the Access Permission list, select Connect.
5. Click OK. You are returned to the Properties dialog.
6. Click OK. Users can now connect to the server using a guest account (anonymous authentication).

**Configure MicroStrategy Intelligence Server**

**Steps**

1. From the Administration menu, choose Configure MicroStrategy Intelligence Server. The MicroStrategy Intelligence Server Configuration Editor opens.
2. Make the appropriate changes to the server configuration and click OK to save your changes.

**Display a list of available MicroStrategy Intelligence Servers with Test Listener**

**Steps**

1. Click Get List. A list of available servers appears in the Available servers list box.
2. Select the Hide down machines check box to hide servers that are not running.

**Note**

The status display at the top of the dialog box shows the number of servers found on your subnetwork. If you check the Hide down machines check box, the display area shows only those machines that are up and running.

**Ping a MicroStrategy Intelligence Server with Test Listener**

**Steps**

1. Click Get List, then double-click a server name from the Available servers list. Or, enter the server name in the Server box.
2. Click Ping. The Status area at the top of the dialog box displays the results of the Ping. Details about the selected server are displayed in the bottom portion of the dialog box.

*Note*

The Available servers list only displays servers in your subnetwork. If you want to ping a server that is not on the list, for example, one that is on a different area of the network, enter the server’s name in the Server text box and click Ping.

**Remove a MicroStrategy Intelligence Server from a cluster**

**Steps**

In the Cluster Monitor, right-click the server you wish to remove and choose Leave cluster.

**Refresh MicroStrategy Intelligence Server status**

**Steps**

In the Folder List, right-click Administration and choose Refresh.

**Start MicroStrategy Intelligence Server**

**Steps**

In the Folder List, right-click the Administration icon and choose Start Server.
Stop MicroStrategy Intelligence Server

**Steps**

1. In the **Folder List**, right-click the **Administration** icon and choose **Stop Server**.
2. A dialog appears asking you to confirm the action. Click **Yes** to stop the server or click **No** to cancel the action.

View details about a MicroStrategy Intelligence Server using Test Listener

**Steps**

1. Click **Get List**, then double-click a server name from the **Available servers** list. The name of the selected server appears in the **Server** box. Details about the server are displayed in the bottom portion of the dialog box.

You can also enter a server name in the **Server** box and click **Details**. Information about the selected server appears in the bottom portion of the dialog box.

View the MicroStrategy Intelligence Server workload

**Steps**

From the **Administration** menu choose **Server summary**.
Connect MicroStrategy Web to a MicroStrategy Intelligence Server

If the MicroStrategy Intelligence Server is listed in the Unconnected servers list:

**Steps**

1. Go to the MicroStrategy Web Administrator page.
2. Click Connect in the Action column.
3. The MicroStrategy Intelligence Server moves from the Unconnected servers list to the Connected servers list.

If the MicroStrategy Intelligence Server is not listed in the Unconnected servers list but you know the name of it:

**Steps**

1. Go to the MicroStrategy Web Administrator page.
2. Type the name of the MicroStrategy Intelligence Server in the Add a server manually box and click Connect.
3. The MicroStrategy Intelligence Server appears in the Connected servers list.

If you do not know the name of the MicroStrategy Intelligence Server:

**Steps**

1. Go to the MicroStrategy Web Administrator page.
2. Click Show All Available Servers. A list of all available MicroStrategy Intelligence Servers appears.
3. Locate the MicroStrategy Intelligence Server to which you wish to connect and click Add. The Server property detail box opens.
4. Make any necessary changes to the properties and click **Connect**.
5. The MicroStrategy Intelligence Server appears in the **Connected servers** list

**Disconnect MicroStrategy Web from a MicroStrategy Intelligence Server**

**Steps**

1. Go to the MicroStrategy Web Administrator page.
2. Locate the server name in the list of **Connected servers** and click **Disconnect** in the **Action** column.
3. The MicroStrategy Intelligence Server moves from the **Connected servers** list to the **Unconnected servers** list.
Change a user’s password

**Steps**
1. Select the user whose password you wish to change.
2. From the *File* menu, choose *Edit*. The *User Editor* opens.
3. Type the new password in the *Password* box.
4. Type it again in the *Confirm password* box. This guards against spelling mistakes in the password.
5. Click *OK* to save your changes.

Configure password expiration criteria

**Steps**
1. In the *User Manager*, locate and select the user whose password expiration criteria you wish to configure.
2. From the *File* menu, choose *Edit*. The *User Editor* opens.
3. If they are selected, clear the *User cannot use standard authentication to logon* and the *User cannot change password* check boxes.
4. You configure the expiration criteria in the *Password expiration* box. Select *Never* if you the user’s password to never expire. Select *Date/# of days* to have the user’s password expire on a certain day.
5. Click *OK* to save your changes.

**Rule**

Password expiration criteria is applied only if the user is allowed to use standard authentication and change his password.
Projects

Change a project’s status

Steps
1. In the Project Monitor, select the project whose status you wish to change.
2. From the Administration menu, choose Idle/Resume. The Idle/Resume dialog box opens.
3. Select or clear the appropriate check boxes.
4. Click OK to change the project’s status.

Configure a project

Steps
1. In the Project Monitor, select the project you wish to configure.
2. From the Administration menu, choose Configure Project. The Project Configuration Editor opens.
3. Make the appropriate changes to the project configuration and click OK.

Allow anonymous access to a project

Steps
1. Configure anonymous access to the MicroStrategy Intelligence Server on which the project is registered. See the following How do I...? topic for details:
   How do I configure anonymous access to a MicroStrategy Intelligence Server?
2. In the Project Monitor, select the project for which you wish to configure anonymous access.
3. From the Administration menu, choose Configure Project. The Project Configuration Editor opens.

4. On the Security Roles tab, select a security role from the list. All guest users will inherit the privileges of the security role you chose.

5. In the Available Groups list, select the Public group and click > to add it to the Selected users and groups list.

6. Click OK. Guest users can now access the project.

Load a project

These steps assume that the project has already been registered with the MicroStrategy Intelligence Server. For details about registering a project, see the following How do I...? topic:

Register a MicroStrategy Desktop project

**Steps**

1. In the Project Monitor, select the project you wish to load.

2. From the Administration menu, choose Load.

Register a 6.x project

**Steps**

1. From the Administration menu, choose Register projects. The MicroStrategy Intelligence Server Configuration Editor opens with the Projects tab selected.

2. Click Browse.

3. Locate the .DSS file for the 6.X project you wish to register and click Open.

4. Click OK.

Register a MicroStrategy Desktop project

**Steps**

1. From the Administration menu, choose Register projects. The MicroStrategy Server Configuration Editor opens with the Projects tab selected.
2. Select the check box corresponding to the project that you wish to register.

3. Double-click in the Load at Startup column to choose whether or not you want the project to be loaded automatically when the server starts.

4. Click OK.

Unload a project

Steps

1. In the Project Monitor, select the project you wish to unload.

2. From the Administration menu, choose Unload.

3. A dialog appears asking you to confirm the action. Click Yes to unload the project or click No to cancel the action.
Create a schedule

Steps
1. Decide whether to create a time-triggered schedule or an event-triggered schedule. The steps are different depending on the type of schedule you choose to create.
2. In the Folder List, select the Schedule Manager.
3. From the File menu, point to New, and then choose Schedule. The Schedule Wizard opens.
4. Follow the steps presented by the Schedule Wizard.
5. Click Finish at the end of the wizard to create the new schedule.

For specific details about creating a time-triggered or event-triggered schedule, see one of the following How do I...? topics:

How do I create an event-triggered schedule?
How do I create a time-triggered schedule?

Create a time-triggered schedule

Steps
1. In the Folder List, select the Schedule Manager.
2. From the File menu, point to New, then choose Schedule. The Schedule Wizard opens.
3. Read the introduction and click Next.
4. On the Name & Description page, type a name for the schedule in the Name box. Type a description in the Description box or you can choose to use the schedule’s summary information as the description.
5. Click Next.
6. On the **Type** page, select **Time-triggered** and click **Next**.

7. On the **Validity Range** page, define the start date and end date for the schedule (or, you can choose **No end date**) and click **Next**.

8. On the **Recurrence Pattern** page, define the recurrence pattern and the **Time to trigger** and click **Next**.

9. Based on the options you chose, the **Schedule Wizard** displays the dates and times at which the schedule will be triggered, up to 20. Review the information and click **Next**.

10. The last window shows a summary of the schedule you created. Review the summary information and click **Finish** to create the schedule.

### Create an event

**Steps**

1. From the **Administration** menu, choose **Events**. The **Event Viewer** opens.

2. From the **File** menu, choose **New**.

3. Type the name of the event you wish to create and press ENTER. The event is created and appears in the list of events.

4. Exit the **Event Viewer**.

### Create an event-triggered schedule

**Steps**

1. In the **Folder List**, select the **Schedule Manager**.

2. From the **File** menu, point to **New**, and then choose **Schedule**. The **Schedule Wizard** opens.

3. Read the introduction and click **Next**.

4. On the **Name & Description** page, type a name for the schedule in the **Name** box. Type a description in the **Description** box or you can choose to use the schedule’s summary information as the description.

5. Click **Next**.

6. On the **Type** page, select **Event-triggered** and click **Next**.

7. On the **Validity Range** page, define the start date and end date for the schedule (or, you can choose **No end date**) and click **Next**.
8. On the Event Selection page, select the event that will trigger the schedule and click Next.

9. The Summary page shows a summary of the schedule you created. Review the summary information and click Finish to create the schedule.

Delete a schedule

Steps

1. Delete all schedule requests that are tied to the schedule you wish to delete. For details, see the following How do I...? topic:
   How do I delete a schedule request?

2. In the Schedule Manager, select the schedule you wish to delete and press DELETE.

Rule

You cannot delete a schedule until all of its associated schedule requests are deleted.

Delete a schedule request

Steps

In the Schedule Monitor, select the schedule requests you wish to delete and press DELETE.

Note

Users are not notified if their schedule request is deleted.

Delete an event

Steps

1. From the Administration menu, choose Events. The Event Viewer opens.
2. Select the events you wish to delete and press DELETE.
Rule

You cannot delete an event unless all associated schedules are deleted first. For details about deleting a schedule, see the following How do I...? topic:

How do I delete a schedule?

Modify a schedule

Steps

1. In the Schedule Manager, select the schedule you wish to modify.
2. From the File menu, choose Edit. The Schedule Wizard opens.
3. Use the Schedule Wizard to make the appropriate changes to the schedule definition.
4. At the end of the Schedule Wizard, review the summary information in the Summary page and click Finish to save your changes.

Note

If you do not click Finish, your changes will still be saved.

Rename a schedule

Steps

1. In the Schedule Manager, select the schedule you wish to rename and press F2.
2. Type the new name and press ENTER.

Note

Renaming a schedule does not affect schedule requests. The requests will automatically be updated to reflect the new schedule name.

Rename an event

Steps

1. From the Administration menu, choose Events. The Event Viewer opens.
2. Select the event you wish to rename and press F2.

3. Type the new name and press ENTER. The renamed event appears in the list.

4. Exit the Event Viewer.

**Trigger an event**

**Steps**

1. From the Administration menu, choose Events. The Event Viewer opens.
2. Select the event(s) you wish to trigger.
3. From the File menu, choose Trigger.
4. Exit the Event Viewer.
CHAPTER 51

Security Filters

Apply a security filter to a user

Steps

1. Select the project in which you wish to apply a security filter.
2. From the Administration menu, choose Configure Project. The Project Configuration Editor opens.
3. On the Security Filter tab, choose the user to which you wish to apply a security filter.
4. Click Import. The Select a Filter dialog box appears.
5. In the Select a Filter dialog box, locate the filter definition you wish to use and click Open. You are returned to the Project Configuration Editor.
6. If you wish, click Add to specify a top range attribute or a bottom range attribute.
7. Click OK.

Notes

- If you do not specify a top range attribute, then the security filter applies to every level higher than the bottom range attribute.
- If you do not specify a bottom range attribute, then the security filter applies to every level lower than the top range attribute.
- If neither a top range attribute nor a bottom range attribute is specified, the security filter is applied to every level of analysis.
**Rule**

For a user to appear in the list of users and groups, the user must be specified as a member of a security role. To learn how to do this, see the following *How do I...?* topic:

Apply a security role to a user
CHAPTER 52

Security roles

Apply a security role to a group

Steps
1. Select the project in which you wish to apply a security role to a group.
2. From the Administration menu, choose Configure project. The Project Configuration Editor opens.
3. On the Security Roles tab, select a security role from the list.
4. Add groups by selecting them from the Available groups list and clicking > to move them to the Selected users and groups list.
5. Click OK.

Apply a security role to a user

Steps
1. Select the project in which you wish to apply a security role to a user.
2. From the Administration menu, choose Configure project. The Project Configuration Editor opens.
3. On the Security Roles tab, select a security role from the list.
4. Select the Show users check box.
5. Add users by selecting them from the Available users and groups list and clicking > to move them to the Selected users and groups list.
6. Click OK.
Create a security role

Steps
1. In the Folder List, select the project in which you wish to create a security role.
2. From the Administration menu, choose Configure Project. The Project Configuration Editor opens.
5. Type a name and description for the security role.
6. Select the privileges you wish to include in the security role from the Available privileges list.
7. Click OK to create the security role. You are returned to the Security Roles dialog box.
8. Click OK. You are returned to the Project Configuration Editor. The security role is now available for you to use.
9. Click OK.

Delete a security role

Steps
1. In the Folder List, select the project from which you wish to delete a security role.
2. From the Administration menu, choose Configure project. The Project Configuration Editor opens.
4. Select the security roles you wish to delete and click Delete.
5. Click OK. You are returned to the Project Configuration Editor.
6. Click OK.
Modify a security role

**Steps**

1. Select the project in which you wish to modify a security role.
2. From the Administration menu, choose Configure project. The Project Configuration Editor opens.
4. Select the security role you wish to modify and click Modify. The Security Role Editor opens.
5. Make the appropriate changes to the security role definition and click OK. You are returned to the Security Roles dialog box.
6. Click OK. You are returned to the Project Configuration Editor.
7. Click OK.

Rename a security role

**Steps**

1. Select the project in which you wish to rename a security role.
2. From the Administration menu, choose Configure project. The Project Configuration Editor opens.
4. Select the security role you wish to rename and click Modify. The Security Role Editor opens.
5. Type a new name in the Name box and click OK. You are returned to the Security Roles dialog box.
6. Click OK. You are returned to the Project Configuration Editor.
7. Click OK.
View SQL for an executing job

Steps

1. In the Job Monitor, select the job for which you wish to see the SQL.
2. From the Administration menu, choose Quick View. The Quick View dialog box for the job you selected opens.
3. The SQL is the last item in the Quick View dialog box.
Configure statistics collection

Steps
1. In the Project Monitor, select the project you wish to configure.
2. From the Administration menu, choose Configure project. The Project Configuration Editor open.
3. On the Statistics tab, select the database instance that represents the database in which the statistics tables are stored.
4. Select the Log information about check box.
5. Select the appropriate check boxes to choose which statistics you wish to record.
6. Click OK.

Purge statistics

Steps
1. Select the project for which you wish to purge statistics.
2. From the Administration menu, choose Configure project. The Project Configuration Editor opens.
3. On the Statistics tab, select the dates for which you wish to purge statistics.
4. Click Purge now.
5. Click OK.
CHAPTER 55

Users

Create a user

Steps
1. In the User Manager, select the group in which you wish to create a user.
2. On the File menu, point to New, then choose User. The User Editor opens.
3. Enter the appropriate information in the General tab.
4. In the Privileges tab, select the privileges you wish the user to have.
5. In the Groups tab, select the groups to which the user will belong.
6. Click OK to save the user.

Note
The user privileges you grant may be extended depending on the groups to which the user belongs.

Delete a user

Steps
1. In the User Manager, select the user you wish to delete and press DELETE.
2. A dialog box opens asking you to confirm the action. Click OK to continue or click No to cancel the action.

Disable a user

Steps
1. In the User Manager, select the user you wish to disable.
2. From the File menu, choose Edit. The User Editor opens.
3. Select the **Account disabled** check box.
4. Click **OK**.

### Disconnect a user

**Steps**

1. In the **User Connection Monitor**, select the user you wish to disconnect and press DELETE.
2. A dialog appears asking you to confirm the action. Click **OK** to continue or click **No** to cancel the action.

**Note**

You can disconnect users from a project while still leaving them connected to the server. If you disconnect a user from the server, they are also disconnected from any projects they were using.

### Enable a user

**Steps**

1. In the **User Manager**, select the user you wish to enable.
2. From the **File** menu, choose **Edit**. The **User Editor** opens.
3. Clear the **Account disabled** check box.
4. Click **OK**.

### Import a user from Windows NT

**Steps**

1. In the **Folder List**, select the **User Manager**.
2. On the **Administration** menu, point to **Import**, then choose **NT User**. The **Import NT User** dialog box opens.
3. On the **General** tab, select the **NT domain** from which you wish to import a user.
4. Select the users you wish to import. Select users by highlighting them in the **NT Users** list and moving them to the **Desktop users** list by clicking `>`.
5. If you wish, on the Default Settings tab, configure default settings for the users you import. You can always change these settings later using the User Editor.

6. If you wish, on the Privileges tab, select the privileges granted the users you import. You can always change the privileges later using the User Editor.

7. Click OK to import the users.

Link a user to a Windows NT user

Steps

1. In the User Manager, select the user you wish to link to a Windows NT user.

2. From the File menu, choose Edit. The User Editor opens.

3. Click ... (to the right of the Link NT User box). The Link NT User dialog box opens.

4. In the NT Domain list, select the Windows NT domain in which the Windows NT user is located.

5. In the NT Users list, select the Windows NT user to which you wish to link the user.

6. Click OK.

Note

To remove the link to a Windows NT user, click Clear then click OK. The user will no longer be able to use Windows NT authentication to access a project source.

Modify a user

Steps

1. In the User Manager, select the user to you wish to modify.

2. From the File menu, choose Edit. The User Editor opens.

3. Make the appropriate modifications and click OK.
Topics for this section include:

- Statistics
- Diagnostics
- VLDB settings
- Permissions and privileges
- Administrative Utilities
Statistics are the record of historical information which MicroStrategy Intelligence Server gathers about jobs and user connections. Statistics are recorded for all report jobs executed through MicroStrategy Intelligence Server, not just the report jobs that are currently available. Statistics provide useful information for:

- **tuning the whole system**: In addition to improving MicroStrategy Intelligence Server performance, you may want to improve the performance of the overall system. Statistics can help you tune the system by revealing query access patterns, what objects are most frequently accessed, which queries take a long time to execute, and which reports may need to be cached or scheduled.

- **troubleshooting**: Detailed information about the performance of the system is key in identifying potential problems and solving existing issues.

Statistics tables are stored in the statistics database. You create the tables in the statistics database using the Configuration Wizard.

---

**Note:**

- The statistics tables can be stored in SQL Server, Teradata, or Oracle.
- Statistics are also recorded for report executions that access a report cache.

---

**The statistics schema**

The statistics tables schema looks like this:
The USER_STATS table has a one-to-many relationship to all the HEADER tables (ELEMENT_BROWSE_HEADER, MD_REQUEST_HEADER, and JOB_HEADER).

The HEADER tables have one-to-one relationships to all the STATS tables (ELEMENT_BROWSE_STATS, MD_REQUEST_STATS, and JOB_STATS).
The JOB_STATS table has a one-to-many relationship to the STEP_STATS table.

**Statistics table**

The following table contains the table and columns, their meaning and datatype for SQL Server, Oracle 7 and 8, and DB2.

<table>
<thead>
<tr>
<th>Table/Column</th>
<th>Meaning</th>
<th>Datatype: SQL Server</th>
<th>Datatype: Oracle 7, 8</th>
<th>Datatype: DB2</th>
</tr>
</thead>
<tbody>
<tr>
<td>User_stats</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Session_ID</td>
<td>Session ID</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
</tr>
<tr>
<td>Server</td>
<td>Name of the Server</td>
<td>VARCHAR(255)</td>
<td>VARCHAR2(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Project_ID</td>
<td>Project ID</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>User_Name</td>
<td>DSS User who created session</td>
<td>VARCHAR(255)</td>
<td>VARCHAR2(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Machine</td>
<td>IP address of the machine where the MicroStrategy Server is running</td>
<td>VARCHAR(255)</td>
<td>VARCHAR2(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Connect_Time</td>
<td>Timestamp when session is opened</td>
<td>DATETIME</td>
<td>DATE</td>
<td>TIMESTAMP</td>
</tr>
<tr>
<td>Disconnect_Time</td>
<td>Timestamp when session is closed</td>
<td>DATETIME</td>
<td>DATE</td>
<td>TIMESTAMP</td>
</tr>
<tr>
<td>Jobs_header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job_ID</td>
<td>Job ID</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>Session_ID</td>
<td>Session ID</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
</tr>
<tr>
<td>Server</td>
<td>Name of the Server</td>
<td>VARCHAR(255)</td>
<td>VARCHAR2(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Project_ID</td>
<td>Project ID</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>User_Name</td>
<td>DSS User who submitted request</td>
<td>VARCHAR(255)</td>
<td>VARCHAR2(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Webmachine</td>
<td>IP address of web client</td>
<td>VARCHAR(255)</td>
<td>VARCHAR2(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Clientmachine</td>
<td>IP address of server client</td>
<td>VARCHAR(255)</td>
<td>VARCHAR2(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Table/Column</td>
<td>Meaning</td>
<td>Datatype: SQL Server</td>
<td>Datatype: Oracle 7, 8</td>
<td>Datatype: DB2</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------</td>
<td>----------------------</td>
<td>-----------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Report</td>
<td>Name of report</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Filter</td>
<td>Name of filter</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Template</td>
<td>Name of template</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>Job_Source</td>
<td>(1=desktop, 2=server administrator, 3=web administrator, 4=server, 5=project upgrade, 6=web, 7=scheduler, 8=customer application)</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
</tbody>
</table>

### Job_stats

<table>
<thead>
<tr>
<th>Table/Column</th>
<th>Meaning</th>
<th>Datatype: SQL Server</th>
<th>Datatype: Oracle 7, 8</th>
<th>Datatype: DB2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job_ID</td>
<td>Job ID</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>Session_ID</td>
<td>Session ID</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
</tr>
<tr>
<td>Project_ID</td>
<td>Project ID</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>Job_Start_Timestamp</td>
<td>Timestamp when job was created</td>
<td>DATETIME</td>
<td>DATE</td>
<td>TIMESTAMP</td>
</tr>
<tr>
<td>Resolution_Time</td>
<td>Time (ms) spent in report resolution</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolution_CPUTime</td>
<td>CPU Time (ms) spent in report resolution</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SQL_Engine_Time</td>
<td>Time (ms) spent in SQL generation</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Query_Execution_Time</td>
<td>Time (ms) spent in query execution</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analytical_ENGINE_Time</td>
<td>Time (ms) spent in analytical processing</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SQL_Engine_CPUTime</td>
<td>CPU Time (ms) spent in SQL generation</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Query_execution_CPUTime</td>
<td>CPU Time (ms) spent in query execution</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Analytical_ENGINE_CPUTime</td>
<td>CPU Time (ms) spent in analytical processing</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job_Finish_Timestamp</td>
<td>Timestamp when job was finished (destroyed)</td>
<td>DATETIME</td>
<td>DATE</td>
<td>TIMESTAMP</td>
</tr>
<tr>
<td>Table/Column</td>
<td>Meaning</td>
<td>Datatype: SQL Server</td>
<td>Datatype: Oracle 7, 8</td>
<td>Datatype: DB2</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------</td>
<td>----------------------</td>
<td>-----------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Duration</td>
<td>Duration of the entire process (in ms)</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SQL_Steps</td>
<td>Number of SQL passes</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Final_Result_Size</td>
<td>Number of rows in the result set</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job_status</td>
<td>(0=ready, 1=executing, 2=waiting, 3=completed, 4=error, 5=cancelled, 6=stopped, 7=waiting for governner, 8=waiting for autoprompt, 9=waiting for project, 10=waiting for cache, 11=waiting for children)</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>MD_request_header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request_ID</td>
<td>Job ID for object browser request</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>Session_ID</td>
<td>Session ID</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
</tr>
<tr>
<td>Server</td>
<td>Name of the ServerDefinition</td>
<td>VARCHAR(255)</td>
<td>VARCHAR2(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Project_ID</td>
<td>Project ID</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>User_Name</td>
<td>DSS User who submitted request</td>
<td>VARCHAR(255)</td>
<td>VARCHAR2(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Webmachine</td>
<td>IP address of the web client</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Clientmachine</td>
<td>IP address of the server client</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Job_Source</td>
<td>(1=desktop, 2=server administrator, 3=web administrator, 4=server, 5=project upgrade, 6=web, 7=scheduler, 8=customer application)</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>MD_request_stats</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request_ID</td>
<td>Job ID for object browser request</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>Table/Column</td>
<td>Meaning</td>
<td>Datatype: SQL Server</td>
<td>Datatype: Oracle 7, 8</td>
<td>Datatype: DB2</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>----------------------</td>
<td>-----------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Session_ID</td>
<td>Session ID</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
</tr>
<tr>
<td>Job_Start_Timestamp</td>
<td>Timestamp when job was created</td>
<td>DATETIME</td>
<td>DATE</td>
<td>TIMESTAMP</td>
</tr>
<tr>
<td>Object_Server_time</td>
<td>Time (ms) spent accessing objects</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job_Finish_Timestamp</td>
<td>Timestamp when job was finished (destroyed)</td>
<td>DATETIME</td>
<td>DATE</td>
<td>TIMESTAMP</td>
</tr>
<tr>
<td>Job_status</td>
<td>(0=ready, 1=executing, 2=waiting, 3=completed, 4=error, 5=cancelled, 6=stopped, 7=waiting for governor, 8=waiting for autoprompt, 9=waiting for project, 10=waiting for cache, 11=waiting for children)</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>Element_browse_header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Request_ID</td>
<td>Job ID for object browse request</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>Session_ID</td>
<td>Session ID</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
</tr>
<tr>
<td>Server</td>
<td>Name of the ServerDefinition</td>
<td>VARCHAR(255)</td>
<td>VARCHAR2(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Project_ID</td>
<td>Project ID</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>User_Name</td>
<td>DSS User who submitted request</td>
<td>VARCHAR(255)</td>
<td>VARCHAR2(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Webmachine</td>
<td>IP address of web client</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Clientmachine</td>
<td>IP address of server client</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
<td>VARCHAR(255)</td>
</tr>
<tr>
<td>Job_Source</td>
<td>(1=desktop, 2=server administrator, 3=web administrator, 4=server, 5=project upgrade, 6=web, 7=scheduler, 8=customer application)</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>Element_browse_stats</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table/Column</td>
<td>Meaning</td>
<td>Datatype: SQL Server</td>
<td>Datatype: Oracle 7, 8</td>
<td>Datatype: DB2</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>----------------------</td>
<td>-----------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>request_id</td>
<td>Job ID for object browse request</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>session_id</td>
<td>Session ID</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
<td>CHAR(36)</td>
</tr>
<tr>
<td>project_id</td>
<td>Project ID</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>Job_Start_Timestamp</td>
<td>Timestamp when job was created</td>
<td>DATETIME</td>
<td>DATE</td>
<td>TIMESTAMP</td>
</tr>
<tr>
<td>Resolution_Time</td>
<td>Time (ms) spent in report resolution</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SQL_Engine_Time</td>
<td>Time (ms) spent in SQL generation</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Query_execution_Time</td>
<td>Time (ms) spent in query execution</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Element_Server_Time</td>
<td>Time (ms) spent in element server</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job_Finish_Timestamp</td>
<td>Timestamp when job was finished (destroyed)</td>
<td>DATETIME</td>
<td>DATE</td>
<td>TIMESTAMP</td>
</tr>
<tr>
<td>Duration</td>
<td>Duration of the entire process (in ms)</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Final_Result_Size</td>
<td>Number of rows in the result set</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Job_status</td>
<td>(0=ready, 1=executing, 2=waiting, 3=completed, 4=error, 5=cancelled, 6=stopped, 7=waiting for governor, 8=waiting for autoprompt, 9=waiting for project, 10=waiting for cache, 11=waiting for children)</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
</tbody>
</table>

Steps_stats (query statistics)

<p>| job_id                    | Job ID for report job                                                  | INTEGER              | NUMBER(10)            | INTEGER       |
| session_id                | Session ID                                                             | CHAR(36)             | CHAR(36)              | CHAR(36)      |
| step_sequence_number      | Identifier for individual pass of SQL                                  | INTEGER              | NUMBER(10)            | INTEGER       |</p>
<table>
<thead>
<tr>
<th>Table/Column</th>
<th>Meaning</th>
<th>Datatype: SQL Server</th>
<th>Datatype: Oracle 7, 8</th>
<th>Datatype: DB2</th>
</tr>
</thead>
<tbody>
<tr>
<td>step_Duration</td>
<td>Duration of the pass (in ms)</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SQL</td>
<td>SQL statement for the pass</td>
<td>INTEGER</td>
<td>NUMBER(10)</td>
<td>INTEGER</td>
</tr>
<tr>
<td>step_type</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total_Tables_Accessed</td>
<td>How many tables this SQL accessed</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Final_Result_Size</td>
<td>Number of rows in the result set</td>
<td>FLOAT</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Diagnostics topics include:

- Log files
- Performance counters
- Active tracing
- Sample log file

Log files

Log files are records of all low-level activity. While this information could be aggregated and used for server or system analysis, it is best suited for troubleshooting a specific problem. You configure log file tracing through the Diagnostics Configuration Editor. You can view and analyze the log files using the Log Viewer.

For details, refer to the following interface topics:

- Diagnostics Configuration Editor
- Log Viewer

All log files follow the same format. Each entry in a log file has the following parts:

\[ \text{PID}: [\text{thread}][\text{date}:\text{time}][\text{module name}][\text{trace type}][\text{message}] \]

<table>
<thead>
<tr>
<th>Section</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID</td>
<td>ID of the process which performed the action</td>
</tr>
<tr>
<td>thread</td>
<td>ID of the thread which performed the action</td>
</tr>
<tr>
<td>date:time</td>
<td>Date and time at which the action happened</td>
</tr>
<tr>
<td>module name</td>
<td>Name of the MicroStrategy component which performed the action</td>
</tr>
</tbody>
</table>
Refer to the sample log file topic in this Appendix to see what a log file looks like.

**Performance counters**

Performance counters provide information for MicroStrategy Intelligence Server tuning through the analysis of server-specific variables, which are available through the Windows NT Performance Monitor. The information provided is similar to the monitoring information available through the server administration interface, but this information can be correlated to other system variables such as memory and processor usage.

**Active tracing**

The Log Viewer allows you to view active tracing information. That is, you can view the data in real-time, as it is being generated. Active tracing uses a component of the Log Viewer called the Debug Monitor. For details, refer to the following interface topic: Log Viewer

**Sample log file**

The following log file snippet was obtained by selecting the Client Connection check box in the Diagnostics Configuration Editor and then running a report called “Choose Attribute ID” in two tier:

```plaintext
272: [THR:255][05/29/2000::14:51:59:825][DSS ReportServer][Report Source Tracing]Executing ReportInstance(Name="Choose Attribute ID") with Actions=0x1f3f(Rslv GenSQL ExeSQL Alrt XTab EvalVw RslvCB GenSQLCB ExeSQLCB AlrtCB XTabCB ), Flags=0x180(OSrcCch UptOSrcCch )
```

<table>
<thead>
<tr>
<th>Section</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>trace type</td>
<td>Displays the type of the log file entry</td>
</tr>
<tr>
<td>message</td>
<td>Message about the action</td>
</tr>
</tbody>
</table>
272: [THR:255][05/29/2000::14:52:00:16][DSS ReportNetClient][Report Source Tracing]Executing ReportInstance(Name="Choose Attribute ID"
ExecFlags=0x180(OSrcCch UptOSrcCch ) ExecActn=0x180(RslvCB ) ) with Actions=0x60001f3f(Rslv GenSQL ExeSQL Alrt XTab EvalVw RslvCB GenSQLCB ExeSQLCB AlrtCB XTabCB OSrcCch UptOSrcCch ), Flags=0x180(OSrcCch UptOSrcCch )

272: [THR:255][05/29/2000::14:52:00:26][DSS ReportNetClient][Process Tracing]Requesting Resolution Server for ReportInstance(Name="Choose Attribute ID" ExecFlags=0x180(OSrcCch UptOSrcCch ) ExecActn=0x180(RslvCB ) )

272: [THR:255][05/29/2000::14:52:00:456][DSS ReportServer][Report Source Tracing]Prompts exist in ReportInstance(Name="Choose Attribute ID" ExecFlags=0x180(OSrcCch UptOSrcCch ) ExecActn=0x180(RslvCB ) )

272: [THR:255][05/29/2000::14:52:00:456][DSS ReportNetClient][Process Tracing]Prompting ReportInstance(Name="Choose Attribute ID" ExecFlags=0x180(OSrcCch UptOSrcCch ) ExecActn=0x180(RslvCB ) )

272: [THR:255][05/29/2000::14:52:00:456][DSS ReportServer][Process Tracing]Completed executing ReportInstance(Name="Choose Attribute ID" ExecFlags=0x180(OSrcCch UptOSrcCch ) ExecActn=0x180(RslvCB ) )

272: [THR:255][05/29/2000::14:52:00:456][DSS ReportServer][Report Source Tracing]Executed ReportInstance(Name="Choose Attribute ID" ExecFlags=0x180(OSrcCch UptOSrcCch ) ExecActn=0x180(RslvCB ) )

272: [THR:255][05/29/2000::14:52:09:629][DSS ReportServer][Report Source Tracing]Answering prompts in ReportInstance(Name="Choose Attribute ID" ExecFlags=0x180(OSrcCch UptOSrcCch ) ExecActn=0x180(RslvCB ) )

272: [THR:255][05/29/2000::14:52:09:629][DSS ReportServer][Report Source Tracing]Executing ReportInstance(Name="Choose Attribute ID" ExecFlags=0x180(OSrcCch UptOSrcCch ) ExecActn=0x180(RslvCB ) ) with Actions=0x60001f3f(Rslv GenSQL ExeSQL Alrt XTab EvalVw RslvCB GenSQLCB ExeSQLCB AlrtCB XTabCB OSrcCch UptOSrcCch ), Flags=0x180(OSrcCch UptOSrcCch )
This log file conveys the following information:

1. Entry for [05/29/2000::14:51:59:825] shows that a report instance has been created for a report named as "Choose Attribute ID".
2. Entry for [05/29/2000::14:52:00:16] shows that the report execution has started in the Report Executor.
3. Entry for [05/29/2000::14:52:00:26] shows that the Resolution Server is now examining the report instance.
4. Entry for [05/29/2000::14:52:00:456] shows that the report instance has prompts that need to be resolved.
5. Entry for [05/29/2000::14:52:09:629] shows that we are answering prompts.
6. Entry for [05/29/2000::14:52:09:629] shows that we are requesting execution of the report instance which has prompt answers.
7. Entry for [05/29/2000::14:52:09:639] shows that the report executor is executing the report instance.
11. Entry for [05/29/2000::14:52:09:690] shows that the report executor is requesting for SQL Generation for ReportInstance - a call is made to the SQL Engine at this point.
VLDB properties (sometimes called VLDB settings) allow you to customize the SQL which MicroStrategy generates. You can manipulate things like SQL join types, SQL inserts, table creation properties, and so on. Use the VLDB Properties Editor to change the defaults to alter the syntax of a SQL statement and take advantage of unique, database-specific optimizations.

Some of the qualities that make these properties valuable are:

• Optimization: Take advantage of database-specific settings to further enhance the performance of queries.

• Flexibility: VLDB properties are available at multiple levels, so that the SQL generated for one report, for example, may be manipulated separately from the SQL generated from another, similar report.

• Complete database support: VLDB properties allow you to easily incorporate and take advantage of new database platforms and versions.

VLDB Hierarchy

VLDB properties can be set at various levels in the MicroStrategy architecture. The following diagram shows the how VLDB properties set for one object take precedence over those set for another:
The arrows depict the overwrite authority of the levels, with the report level having the greatest authority. For example, if a VLDB property is set one way for a report and the same property is set differently for the database instance, the one set on the report takes precedence.

Properties set at the report level override properties at every other level. Properties set at the template level override those set at the metric level, the database instance level, and the DBMS level, and so on.

**Note:** There are limited number of properties that can be applied for each level. Only the DBMS level has all of the possible properties.

---

**VLDB Properties Editor**

You can access the VLDB Properties Editor in the following ways:
Only when you access the VLDB Properties Editor from the Database Instance Manager will you see all the properties. The rest of the access methods have a limited number of properties depending which ones make sense for the object from which you accessed the VLDB Properties Editor.

The **VLDB Properties Editor** has the following sections:

- **VLDB Settings list**. Shows the list of folders into which the VLDB properties are grouped. Expand a folder to see the individual properties.
- **SQL preview box**. This shows a sample SQL statement and how it changes when you change a property.
- **Options and Parameters box**. This is where you set or change the parameters that affect the SQL syntax.

**Tip:** When you change a property from its default, a check mark appears on the folder in which the property is located and on the property itself.
VLDB Properties

All VLDB properties are grouped into the following "property sets:"

- Analytical Engine
- Governing
- Indexing
- Joins
- Metrics
- Pre/Post Statements
- Query Optimizations
- Select/Insert
- Tables

### Analytical Engine

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible Values</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Null On Top</td>
<td>Determines where NULL values appear when you sort data.</td>
<td>• Display NULL values in bottom while sorting</td>
<td>Display NULL values in bottom while sorting</td>
</tr>
<tr>
<td>Evaluation Ordering</td>
<td>Determines the order in which the Analytical Engine resolves different types of calculations.</td>
<td>• 6.x Evaluation Order</td>
<td>6.x Evaluation Order</td>
</tr>
<tr>
<td>Null checking for Analytical Engine</td>
<td>This determines whether or not NULL is interpreted as the number 0 when the Analytical Engine does calculations. True means the engine will convert NULL to 0.</td>
<td>• True</td>
<td>TRUE</td>
</tr>
</tbody>
</table>

### Governing

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible Values</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Results Set Row Limit</td>
<td>Limits the maximum number of rows that can be returned to the Analytical Engine from the database.</td>
<td>User defined</td>
<td>No Limit</td>
</tr>
</tbody>
</table>
## Indexing

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible Values</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index PostString</td>
<td>A string that will be appended at the end of CREATE INDEX statement. For example: IN INDEXSPACE</td>
<td>User defined</td>
<td>NULL</td>
</tr>
<tr>
<td>Index Qualifier</td>
<td>String to parse in between the CREATE and INDEX words. For example: CLUSTERED</td>
<td>User defined</td>
<td>NULL</td>
</tr>
</tbody>
</table>
| Intermediate Table Index | Determine whether and when to create index for intermediate table. You should create a primary index for Teradata and a partition key for DB2 UDB/EEE | • No primary index (Teradata), no partition key (DB2 UDB/EEE), no secondary index  
  • Create Primary index (Teradata)/Partition key (DB2 UDB/EEE)  
  • Create Primary index (Teradata)/Partition key (DB2 UDB/EEE) and secondary index on intermediate table  
  • Create table, insert into table, create index on intermediate table (all platforms other than Teradata and DB2/UDB EEE) | No primary index (Teradata), no partition key (DB2 UDB/EEE), no secondary index |
| Max Columns in Index | Determine the maximum number of columns that could be included in partition key or index. | User defined                                                                    | No Limit                                                                      |

## Joins

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible Values</th>
<th>Default Value</th>
</tr>
</thead>
</table>
| Base Table Join for Template | Controls whether two fact tables will be directly joined together. If you choose Temp Table Join, the engine will calculate results independently from each fact table and place those results into two intermediate tables. These intermediate tables will then be joined together. | • Temp Table Join  
  • Fact Table Join | Temp Table Join |
| Cartesian Join Warning | Action that occurs when the engine generates a report that contains a Cartesian join. | • Execute without warning  
  • Abort execution without warning | Execute without warning |
### Metrics

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible Values</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute Non-Agg Metric Query Type</td>
<td>The engine can either perform the non-aggregation calculation with a sub-query or place the results that would have been selected from a sub-query into an intermediate table and join that table to the rest of the query.</td>
<td>• Use SubQuery • Use temp table</td>
<td>Use SubQuery</td>
</tr>
<tr>
<td>Compute Non-Agg After Analytics</td>
<td>This setting will control whether the non-aggregation calculation is performed before or after an Analytical Engine calculation. For example, should the engine rank the stores and then perform a non-aggregation calculation or should the engine perform the non-aggregation calculation first.</td>
<td>• Calculate non-aggregation metric before Analytical Engine Processing • Calculate non-aggregation metric after Analytical Engine Processing</td>
<td>Calculate non-aggregation metric before Analytical Engine Processing</td>
</tr>
<tr>
<td>COUNT Compound Attribute</td>
<td>Compound attributes are usually counted by concatenating they keys of all of the attributes that form the key. If the database platform does not support COUNT on concatenated strings, this setting should be enabled.</td>
<td>• COUNT expression enabled • COUNT expression disabled</td>
<td>COUNT expression enabled</td>
</tr>
</tbody>
</table>
| COUNT (column) Support | Some database platforms do no support count on a column (COUNT(COL)). This setting will convert the COUNT(COL) statement to a COUNT(*). | • Use COUNT(column)  
• Use COUNT(*) | Use COUNT(column) |
|---|---|---|---|
| Metric Join Type | Type of join used in a metric. | • Equi-Join  
• Outer-Join | Equi-Join |
| Null Check | Indicates how to handle arithmetic operations with null values. | • Do nothing  
• Check for NULL values in all queries  
• Check for NULL values in temp table join only | Check for NULL values in temp table join only |
| Null Display | One or two user-defined strings (one for each NULL case, separated by commas) displayed where null values occur in a report. The first NULL case comes directly from the database as a result of a query. The second NULL case comes from cross-tabulation of the report. | User defined | NULL |
| Separate COUNT DISTINCTs | Indicates how to handle COUNT (and other aggregation functions) when DISTINCT is present in the SQL. | • One pass  
• Use same pass for multiple count (or any aggregation function) distincts but the column being counted must be the same  
• Use only one distinct per pass | One pass |
| Zero Check | Indicates how to handle division by zero. | • Do nothing  
• Check for zero values in all queries  
• Check for zero values in temp table join only | Check for zero values in all queries |
### Pre/Post Statements

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible Values</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert MidStatement</td>
<td>SQLs issued between multiple insert statements. For the first 4 statements, each contains single SQL. The last statement can contain multiple SQLs concatenated by <code>;</code>.</td>
<td>User defined</td>
<td>Null</td>
</tr>
<tr>
<td>Insert PreStatement</td>
<td>SQLs issued after create before first insert only for explicit temp table creation. For the first 4 statements, each contains single SQL. The last statement can contain multiple SQLs concatenated by <code>;</code>.</td>
<td>User defined</td>
<td>Null</td>
</tr>
<tr>
<td>Report PostStatement</td>
<td>SQLs issued after Report Block. For the first 4 statements, each contains single SQL. The last statement can contain multiple SQLs concatenated by <code>;</code>.</td>
<td>User defined</td>
<td>Null</td>
</tr>
<tr>
<td>Report PreStatement</td>
<td>SQLs issued before Report Block. For the first 4 statements, each contains single SQL. The last statement can contain multiple SQLs concatenated by <code>;</code>.</td>
<td>User defined</td>
<td>Null</td>
</tr>
<tr>
<td>Table PostStatement</td>
<td>SQLs issued after creating new table and insert. For the first 4 statements, each contains single SQL. The last statement can contain multiple SQLs concatenated by <code>;</code>.</td>
<td>User defined</td>
<td>Null</td>
</tr>
<tr>
<td>Table PreStatement</td>
<td>SQLs issued before creating new table. For the first 4 statements, each contains single SQL. The last statement can contain multiple SQLs concatenated by <code>;</code>.</td>
<td>User defined</td>
<td>Null</td>
</tr>
</tbody>
</table>

### Query Optimizations

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible Values</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply Filter to All</td>
<td>Indicate during which pass the report filter will apply.</td>
<td>• Apply filter to passes which only touch warehouse tables</td>
<td>Apply filter to passes which only touch warehouse tables</td>
</tr>
<tr>
<td>Passes</td>
<td></td>
<td>• Apply filter to all passes including final pass</td>
<td></td>
</tr>
<tr>
<td>Dimensionality Model</td>
<td>Determine the way of dimensionality replacement for non parent-child related attributes in same dimension.</td>
<td>• Use relational model to consider dimensionality replacement</td>
<td>Use relational model to consider dimensionality replacement</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use dimensional model to consider dimensionality replacement</td>
<td></td>
</tr>
</tbody>
</table>
### Rank Method

This setting determines how ranking is used.

- 6.x Style Ranking
- 7.0 Ranking
- Database level ranking

### Sub Query Type

Type of sub query used in engine-generated SQL.

- WHERE EXISTS (SELECT *...)
- WHERE EXISTS (SELECT col1,col2...)
- WHERE COL1 IN (SELECT s1.COL1...)
- WHERE (COL1,COL2)IN (SELECT s1.COL1, s1.COL2...)
- Use temporary table

### WHERE Clause Driving Table

Tables used for qualifications in the Where clause.

- Use Lookup Table
- Use Fact Table

### Select/Insert

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible Values</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bulk Insert String</td>
<td>Whether multiple insert statements will be issued in ODBC call, and if together, what is the string to connect the multiple insert statements.</td>
<td>User defined</td>
<td>NULL</td>
</tr>
<tr>
<td>Date Format</td>
<td>Format for date in engine-generated SQL</td>
<td>User defined</td>
<td>mm/dd/yyyy</td>
</tr>
<tr>
<td>GROUP BY Non-ID Attribute</td>
<td>The way to handle columns for Non_ID attributes.</td>
<td>• Use Max</td>
<td>Use Max</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use Group By</td>
<td></td>
</tr>
<tr>
<td>SELECT PostString</td>
<td>String to be appended to all SELECT statements generated by the engine, for example, FOR FETCH ONLY</td>
<td>User defined</td>
<td>NULL</td>
</tr>
<tr>
<td>SQL Hint</td>
<td>SQL Hint pattern. This string is placed after the SELECT statement.</td>
<td>User defined</td>
<td>NULL</td>
</tr>
<tr>
<td>UNION Multiple INSERTs</td>
<td>This setting allows the engine to UNION multiple insert statements into the same temporary table</td>
<td>• Do not use UNION</td>
<td>Do not use UNION</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use UNION</td>
<td></td>
</tr>
</tbody>
</table>
## Tables

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible Values</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute ID Constraint</td>
<td>Column constraints (for example, NULL or NOT NULL) put on ID form of attribute.</td>
<td>User defined</td>
<td>NULL</td>
</tr>
<tr>
<td>Commit Level</td>
<td>Where to issue commit statement after creating intermediate table.</td>
<td>• No Commit • PostDDL • PostDML • PostDDL &amp; DML</td>
<td>No Commit</td>
</tr>
<tr>
<td>Create Post String</td>
<td>String appended after the CREATE TABLE statement.</td>
<td>User defined</td>
<td>NULL</td>
</tr>
<tr>
<td>Drop Temp Table Method</td>
<td>Determine when to drop intermediate objects.</td>
<td>• Drop after final pass • Do nothing</td>
<td>Drop after final pass</td>
</tr>
<tr>
<td>Fallback Table Type</td>
<td>If the engine cannot generate a derived table or common table, this determines the type of table that is generated instead.</td>
<td>• Permanent table • True temporary table</td>
<td>Permanent table</td>
</tr>
<tr>
<td>Intermediate Table Type</td>
<td>Type of intermediate (temp) table to create.</td>
<td>• Permanent table • Derived table • Common table expression • True temporary table • Temporary view</td>
<td>Permanent table</td>
</tr>
<tr>
<td>Table Creation Type</td>
<td>Method to create intermediate table.</td>
<td>• Explicit table • Implicit table</td>
<td>Explicit table</td>
</tr>
<tr>
<td>Table Descriptor</td>
<td>String to be placed after the word TABLE in the CREATE TABLE statement</td>
<td>User defined</td>
<td>NULL</td>
</tr>
<tr>
<td>Table Option</td>
<td>String to be placed after the table name in the CREATE TABLE statement.</td>
<td>User defined</td>
<td>NULL</td>
</tr>
<tr>
<td>Table Prefix</td>
<td>String to be prefixed to a table name (i.e., CREATE TABLE prefix.TableName).</td>
<td>User defined</td>
<td>NULL</td>
</tr>
<tr>
<td>Table Qualifier</td>
<td>Key words placed right before “table”.</td>
<td>User defined</td>
<td>NULL</td>
</tr>
<tr>
<td>Table Space</td>
<td>String appended after the CREATE TABLE Statement but before any Primary Index/Partition key definitions.</td>
<td>User defined</td>
<td>NULL</td>
</tr>
</tbody>
</table>
## Default VLDB properties for specific databases

The following table shows the default properties for particular database platforms. Any properties not explicitly listed in the table remain set the standard default value.

<table>
<thead>
<tr>
<th>Database Platform</th>
<th>Property Set</th>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2/390 V5</td>
<td>Joins</td>
<td>Max Tables In Join</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Metrics</td>
<td>Separate COUNT DISTINCTs</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DB2/390 V6</td>
<td>Joins</td>
<td>Max Tables In Join</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>Metrics</td>
<td>Separate COUNT DISTINCTs</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DB2/390 V7</td>
<td>Metrics</td>
<td>Separate COUNT DISTINCTs</td>
<td>Use same pass for multiple count (or any aggregation function) distincts but the column being counted must be the same</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True Temporary Table</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
</tr>
<tr>
<td>DB2/400 V4R3</td>
<td>Joins</td>
<td>Max Tables In Join</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>Select/Insert</td>
<td>UNION Multiple INSERTs</td>
<td>Use UNION</td>
</tr>
<tr>
<td>DB2/400 V4R4</td>
<td>Joins</td>
<td>Max Tables In Join</td>
<td>97</td>
</tr>
<tr>
<td></td>
<td>Select/Insert</td>
<td>UNION Multiple INSERTs</td>
<td>Use UNION</td>
</tr>
<tr>
<td></td>
<td>Joins</td>
<td>Max Tables In Join</td>
<td>256</td>
</tr>
<tr>
<td>DB2/400 V4R5</td>
<td>Query Optimizations</td>
<td>Apply Filter to All Passes</td>
<td>Apply filter to all passes including final pass</td>
</tr>
<tr>
<td>DB2/UDB V5</td>
<td>Indexing</td>
<td>Intermediate Table Type</td>
<td>Create Primary index (Teradata)/Partition key (DB2 UDB/EEE)</td>
</tr>
<tr>
<td>------------</td>
<td>------------------</td>
<td>--------------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Select/Insert</td>
<td>UNION Multiple INSERTs</td>
<td>Use UNION</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>Derived Table</td>
</tr>
<tr>
<td>DB2/UDB V6</td>
<td>Indexing</td>
<td>Intermediate Table Index</td>
<td>Create Primary index (Teradata)/Partition key (DB2 UDB/EEE)</td>
</tr>
<tr>
<td></td>
<td>Select/Insert</td>
<td>UNION Multiple INSERTs</td>
<td>Use UNION</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>Derived Table</td>
</tr>
<tr>
<td>DB2/UDB V7</td>
<td>Query Optimizations</td>
<td>Rank Method</td>
<td>Database level ranking</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Fallback Table Type</td>
<td>True temporary table</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>Derived Table</td>
</tr>
<tr>
<td>INFORMIX 7</td>
<td>Joins</td>
<td>Join Type</td>
<td>Join89</td>
</tr>
<tr>
<td></td>
<td>Metrics</td>
<td>COUNT Compound Attribute</td>
<td>COUNT expression disabled</td>
</tr>
<tr>
<td></td>
<td>Metrics</td>
<td>Separate COUNT DISTINCTs</td>
<td>Use only one distinct per pass</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
</tr>
<tr>
<td>INFORMIX 8</td>
<td>Joins</td>
<td>Join Type</td>
<td>Join89</td>
</tr>
<tr>
<td></td>
<td>Metrics</td>
<td>COUNT Compound Attribute</td>
<td>COUNT expression disabled</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
</tr>
<tr>
<td>INFORMIX 9</td>
<td>Joins</td>
<td>Join Type</td>
<td>Join89</td>
</tr>
<tr>
<td></td>
<td>Metrics</td>
<td>COUNT Compound Attribute</td>
<td>COUNT expression disabled</td>
</tr>
<tr>
<td></td>
<td>Metrics</td>
<td>Separate COUNT DISTINCTs</td>
<td>Use only one distinct per pass</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
</tr>
<tr>
<td>Database</td>
<td>Joins</td>
<td>Join Type</td>
<td>Join89</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------</td>
<td>---------------</td>
<td>----------</td>
</tr>
<tr>
<td>MICROSOFT ACCESS 97</td>
<td>Metrics</td>
<td>Null Check</td>
<td>Do nothing</td>
</tr>
<tr>
<td></td>
<td>Metrics</td>
<td>Zero Check</td>
<td>Do nothing</td>
</tr>
<tr>
<td>MICROSOFT SQL SERVER 2000</td>
<td>Joins</td>
<td>Max Tables In Join</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Drop Temp Table Method</td>
<td>Do nothing</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
</tr>
<tr>
<td>MICROSOFT SQL SERVER 7</td>
<td>Joins</td>
<td>Max Tables In Join</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>Select/Insert</td>
<td>UNION Multiple INSERTs</td>
<td>Use UNION</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
</tr>
<tr>
<td>ORACLE 7</td>
<td>Joins</td>
<td>Join Type</td>
<td>Join89</td>
</tr>
<tr>
<td></td>
<td>Query Optimizations</td>
<td>Sub Query Type</td>
<td>WHERE (COL1, COL2) IN (SELECT s1.COL1, s1.COL2...)</td>
</tr>
<tr>
<td></td>
<td>Select/Insert</td>
<td>UNION Multiple INSERTs</td>
<td>Use UNION</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
</tr>
<tr>
<td>ORACLE 8</td>
<td>Joins</td>
<td>Join Type</td>
<td>Join89</td>
</tr>
<tr>
<td></td>
<td>Query Optimizations</td>
<td>Sub Query Type</td>
<td>WHERE (COL1, COL2) IN (SELECT s1.COL1, s1.COL2...)</td>
</tr>
<tr>
<td></td>
<td>Select/Insert</td>
<td>UNION Multiple INSERTs</td>
<td>Use UNION</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
</tr>
<tr>
<td>ORACLE 8I</td>
<td>Joins</td>
<td>Join Type</td>
<td>Join89</td>
</tr>
<tr>
<td></td>
<td>Query Optimizations</td>
<td>Sub Query Type</td>
<td>WHERE (COL1, COL2) IN (SELECT s1.COL1, s1.COL2...)</td>
</tr>
<tr>
<td></td>
<td>Select/Insert</td>
<td>UNION Multiple INSERTs</td>
<td>Use UNION</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
</tr>
<tr>
<td></td>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
</tr>
</tbody>
</table>

Default VLDB properties for specific databases 235
<table>
<thead>
<tr>
<th></th>
<th>Joins</th>
<th>Join Type</th>
<th>Join89</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORACLE 8I R2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Query Optimizations</td>
<td>Rank Method</td>
<td>Database level ranking</td>
<td></td>
</tr>
<tr>
<td>Query Optimizations</td>
<td>Sub Query Type</td>
<td>Use UNION</td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
<td></td>
</tr>
<tr>
<td>RED BRICK 5.1</td>
<td></td>
<td>DSS Star Join</td>
<td>Partial Star Join, for attributes only appearing in SELECT or WHERE</td>
</tr>
<tr>
<td>Metrics</td>
<td>Separate COUNT DISTINCTs</td>
<td>Use only one distinct per pass</td>
<td></td>
</tr>
<tr>
<td>Select/Insert</td>
<td>UNION Multiple INSERTs</td>
<td>Use UNION</td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td>Attribute ID Constraint</td>
<td>NOT NULL</td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
<td></td>
</tr>
<tr>
<td>RED BRICK 6</td>
<td></td>
<td>DSS Star Join</td>
<td>Partial Star Join, for attributes only appearing in SELECT or WHERE</td>
</tr>
<tr>
<td>Metrics</td>
<td>Separate COUNT DISTINCTs</td>
<td>Use only one distinct per pass</td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td>Attribute ID Constraint</td>
<td>NOT NULL</td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
<td></td>
</tr>
<tr>
<td>SYBASE ASE 11.5</td>
<td></td>
<td>Join Type</td>
<td>Join89</td>
</tr>
<tr>
<td>Joins</td>
<td></td>
<td>Max Tables In Join</td>
<td>16</td>
</tr>
<tr>
<td>Select/Insert</td>
<td>UNION Multiple INSERTs</td>
<td>Use UNION</td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
<td></td>
</tr>
<tr>
<td>SYBASE ASE 12</td>
<td></td>
<td>Join Type</td>
<td>Join89</td>
</tr>
<tr>
<td>Joins</td>
<td></td>
<td>Max Tables In Join</td>
<td>50</td>
</tr>
<tr>
<td>Tables</td>
<td>Intermediate Table Type</td>
<td>True temporary table</td>
<td></td>
</tr>
<tr>
<td>Tables</td>
<td>Table Creation Type</td>
<td>Implicit Table</td>
<td></td>
</tr>
<tr>
<td>Database</td>
<td>Indexing</td>
<td>Max Columns in Index</td>
<td>Join Type</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------</td>
<td>----------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>SYBASE IQ 12</td>
<td>Max Tables in Join</td>
<td>1</td>
<td>SQL 89 Inner Join and SQL 92 Outer Join</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fallback Table Type</td>
<td></td>
<td>True temporary table</td>
</tr>
<tr>
<td></td>
<td>Intermediate Table Type</td>
<td></td>
<td>True temporary table</td>
</tr>
<tr>
<td></td>
<td>Table Creation Type</td>
<td></td>
<td>Implicit Table</td>
</tr>
<tr>
<td>TANDEM NONSTOP SQL/MP</td>
<td>Max Tables in Join</td>
<td>15</td>
<td>SQL 89 Inner Join and SQL 92 Outer Join</td>
</tr>
<tr>
<td></td>
<td>COUNT Compound Attribute</td>
<td></td>
<td>COUNT expression disabled</td>
</tr>
<tr>
<td></td>
<td>Separate COUNT DISTINCTs</td>
<td></td>
<td>Use same pass for multiple count (or any aggregation function) distincts but the column being counted must be the same</td>
</tr>
<tr>
<td>TERA DATA V2R2</td>
<td>Intermediate Table Index</td>
<td>Create Primary index (Teradata)/Partition key (DB2 UDB/EEE)</td>
<td>SQL 89 Inner Join and SQL 92 Outer Join</td>
</tr>
<tr>
<td></td>
<td>Max Tables in Join</td>
<td>15</td>
<td>SQL 89 Inner Join and SQL 92 Outer Join</td>
</tr>
<tr>
<td></td>
<td>Separate COUNT DISTINCTs</td>
<td></td>
<td>Use same pass for multiple count (or any aggregation function) distincts but the column being counted must be the same</td>
</tr>
<tr>
<td></td>
<td>Intermediate Table Type</td>
<td>Derived table</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TERADATA V2R3</td>
<td>TERADATA V2R4</td>
<td></td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------</td>
<td>---------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Indexing</strong></td>
<td>Intermediate Table Index</td>
<td>Intermediate Table Index</td>
<td></td>
</tr>
<tr>
<td><strong>Joins</strong></td>
<td>Join Type</td>
<td>Join Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SQL 89 Inner Join and SQL 92 Outer Join</td>
<td>SQL 89 Inner Join and SQL 92 Outer Join</td>
<td></td>
</tr>
<tr>
<td><strong>Joins</strong></td>
<td>Max Tables In Join</td>
<td>Max Tables In Join</td>
<td></td>
</tr>
<tr>
<td></td>
<td>64</td>
<td>64</td>
<td></td>
</tr>
<tr>
<td><strong>Metrics</strong></td>
<td>Separate COUNT DISTINCTs</td>
<td>Separate COUNT DISTINCTs</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use same pass for multiple count (or any aggregation function) distincts but the column being counted must be the same</td>
<td>Use same pass for multiple count (or any aggregation function) distincts but the column being counted must be the same</td>
<td></td>
</tr>
<tr>
<td><strong>Select/Insert</strong></td>
<td>Bulk Insert String</td>
<td>Bulk Insert String</td>
<td></td>
</tr>
<tr>
<td></td>
<td>:</td>
<td>:</td>
<td></td>
</tr>
<tr>
<td><strong>Select/Insert</strong></td>
<td>UNION Multiple INSERTs</td>
<td>UNION Multiple INSERTs</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use UNION</td>
<td>Use UNION</td>
<td></td>
</tr>
<tr>
<td><strong>Tables</strong></td>
<td>Fallback Table Type</td>
<td>Fallback Table Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>True temporary table</td>
<td>True temporary table</td>
<td></td>
</tr>
<tr>
<td><strong>Tables</strong></td>
<td>Intermediate Table Type</td>
<td>Intermediate Table Type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Derived table</td>
<td>Derived table</td>
<td></td>
</tr>
</tbody>
</table>
Permissions and Privileges

Topics for this appendix include:
• Permission groupings
• Permissions for server objects
• Privileges

Permission groupings

When you edit an object’s access control list using the object’s **Properties** dialog, you have the option of using a predefined grouping of permissions or you can create a custom grouping. The following table lists the predefined groupings and the specific permissions each one grants:

<table>
<thead>
<tr>
<th>Grouping</th>
<th>Permissions granted</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>• Browse</td>
</tr>
<tr>
<td></td>
<td>• Use/Execute</td>
</tr>
<tr>
<td></td>
<td>• Read</td>
</tr>
<tr>
<td>Modify</td>
<td>• Browse</td>
</tr>
<tr>
<td></td>
<td>• Use/Execute</td>
</tr>
<tr>
<td></td>
<td>• Read</td>
</tr>
<tr>
<td></td>
<td>• Write</td>
</tr>
<tr>
<td></td>
<td>• Delete</td>
</tr>
<tr>
<td>Full Control</td>
<td>• Browse</td>
</tr>
<tr>
<td></td>
<td>• Use/Execute</td>
</tr>
<tr>
<td></td>
<td>• Read</td>
</tr>
<tr>
<td></td>
<td>• Write</td>
</tr>
<tr>
<td></td>
<td>• Delete</td>
</tr>
<tr>
<td></td>
<td>• Control</td>
</tr>
</tbody>
</table>
## Permissions for server objects

Server objects have different groupings of permissions than other objects in the system. The following table lists the groupings available for server objects, the permissions each one grants and the tasks each allows you to perform on the server:

<table>
<thead>
<tr>
<th>Grouping</th>
<th>Permissions granted</th>
<th>Allows you to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>All permissions are assigned to “Default”</td>
<td></td>
</tr>
<tr>
<td>Custom...</td>
<td>Allows you to create a custom combination of permissions</td>
<td></td>
</tr>
</tbody>
</table>

### Grouping: Connect

- **Permissions granted**: Browse
- **Allows you to**: Connect to the server

### Grouping: Monitoring

- **Permissions granted**: Browse, Read
- **Allows you to**: View server definition properties, View statistics settings, Use the Job Monitor, Use the Database Connection Monitor, Use the User Connection Monitor, Use the Schedule Monitor, Use the Cache Monitor

### Grouping: Administration

- **Permissions granted**: Browse, Use/Execute, Read
- **Allows you to**: Start/stop the server, Apply runtime settings, Update diagnostics at runtime, Cancel jobs, Idle/resume a project, Disconnect user, Schedule reports, Delete schedules, Trigger events, Perform cache administration
Privileges

The following table lists all of the privileges available in the MicroStrategy environment:

<table>
<thead>
<tr>
<th>Type of privilege</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration</td>
<td>Bypass all object security access checks</td>
<td>Gives you full control over all objects regardless of the object access permissions granted to you</td>
</tr>
<tr>
<td></td>
<td>Server administration functionality</td>
<td>Gives you access to all administrative functionality</td>
</tr>
<tr>
<td>Architect</td>
<td>Architect functions</td>
<td>Allows you to use the architect functions</td>
</tr>
<tr>
<td></td>
<td>Create schema objects</td>
<td>Allows you to create schema objects</td>
</tr>
<tr>
<td></td>
<td>Update schema</td>
<td>Allows you to modify a current project schema</td>
</tr>
<tr>
<td>Type of privilege</td>
<td>Privilege</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Desktop application</td>
<td>Create application objects</td>
<td>Allows you to create application objects</td>
</tr>
<tr>
<td></td>
<td>Schedule request</td>
<td>Allows you to schedule a report</td>
</tr>
<tr>
<td></td>
<td>Use consolidation editor</td>
<td>Allows you to use the consolidation editor</td>
</tr>
<tr>
<td></td>
<td>Use custom group editor</td>
<td>Allows you to use the custom group editor</td>
</tr>
<tr>
<td></td>
<td>Use document editor</td>
<td>Allows you to use the document editor</td>
</tr>
<tr>
<td></td>
<td>Use filter editor</td>
<td>Allows you to use the filter editor</td>
</tr>
<tr>
<td></td>
<td>Use metric editor</td>
<td>Allows you to use the metric editor</td>
</tr>
<tr>
<td></td>
<td>Use prompt editor</td>
<td>Allows you to use the prompt editor</td>
</tr>
<tr>
<td></td>
<td>Use report editor</td>
<td>Allows you to use the report editor</td>
</tr>
<tr>
<td></td>
<td>Use server cache</td>
<td>Allows you to use the server cache</td>
</tr>
<tr>
<td></td>
<td>Use template editor</td>
<td>Allows you to use the template editor</td>
</tr>
<tr>
<td>Type of privilege</td>
<td>Privilege</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Web</td>
<td>Web administration</td>
<td>Allows you to access the MicroStrategy Web Administrator page</td>
</tr>
<tr>
<td></td>
<td>Web change user options</td>
<td>Allows you to change user options</td>
</tr>
<tr>
<td></td>
<td>Web create new report</td>
<td>Allows you to access the Create Report page</td>
</tr>
<tr>
<td></td>
<td>Web delete objects</td>
<td>Allows you to delete reports or documents</td>
</tr>
<tr>
<td></td>
<td>Web drilling</td>
<td>Allows you to drill on reports</td>
</tr>
<tr>
<td></td>
<td>Web export</td>
<td>Allows you to use the MicroStrategy Web export functionality</td>
</tr>
<tr>
<td></td>
<td>Web object search</td>
<td>Allows you to search for objects</td>
</tr>
<tr>
<td></td>
<td>Web print mode</td>
<td>Allows you to use printing functionality</td>
</tr>
<tr>
<td></td>
<td>Web report details</td>
<td>Allows you to view the Report Details page</td>
</tr>
<tr>
<td></td>
<td>Web report manipulations</td>
<td>Allows you to perform report manipulations</td>
</tr>
<tr>
<td></td>
<td>Web report SQL</td>
<td>Allows you to view reports in SQL</td>
</tr>
<tr>
<td></td>
<td>Web save to My Reports</td>
<td>Allows you to save to the My Reports folder</td>
</tr>
<tr>
<td></td>
<td>Web save to Shared Reports</td>
<td>Allows you to save to the Shared Reports folder</td>
</tr>
<tr>
<td></td>
<td>Web user</td>
<td>Allows you to connect to the MicroStrategy system through MicroStrategy Web</td>
</tr>
<tr>
<td></td>
<td>Web view history list</td>
<td>Allows you to view the History List page</td>
</tr>
</tbody>
</table>
Administrative utilities include:

- License Manager
- Log Viewer
- Test Listener

License Manager

**What is it?**


**How do I access it?**

Run `Malicmgr.EXE`, found in `C:\Program Files\Common Files\MicroStrategy` (that is where MicroStrategy 7 common files are installed by default).

**What can I do with it?**

The License Manager serves two main purposes:

- It determines the number of product licenses in use by a specified user group. From this information, you can determine whether you have the required number of licenses.
- It allows you to upgrade licenses without reinstalling the products (for example, upgrading from an evaluation version to a workgroup edition).
For instructions on completing the above tasks, refer to the following License Manager How do I...? topics in this appendix:

- License Manager How do I...?

What should I know before I use it?

Before you begin using the License Manager, you should know:

- A project source must be pointing to the server (3-tier project source) or repository (2-tier project source) you are using.

- The License Manager counts the number of licenses based on the number of users with at least one privilege for a given product. The user created by default with the repository (Administrator or any new name given to this user) is not considered in the count.

- The License Manager counts both enabled and disabled users. Disabled users are noted for reference; however, only enabled users need be considered in your license count.

- The License Manager is not used for user or privilege manipulation; such changes are accomplished through MicroStrategy Administration, in the MicroStrategy Desktop.

License Manager layout

The main window of the License Manager is used to determine the number of licenses in use for a product(s) and consists of three main columns: Available Groups, a list of the available products, and the number of licenses in use by those groups for those products. A secondary Product Information window displays related user and privilege details.

From the main window of the License Manager, you can upgrade your current licenses by choosing Licenses from the File menu. A secondary window displays the currently installed products and allows you to enter a new CD key (provided by MicroStrategy) to automatically upgrade licenses without having to reinstall products.

License Manager How do I...? topics

Determine the number of licenses in use for a product(s)

Steps

1. Open the License Manager.
2. From the File menu, choose Connect; the Login dialog box opens.
3. Select a Project Source and type your login ID and password.
4. Click OK to activate and access the tool.
5. From the Available Groups list, select the check box corresponding to the specific user group you wish to audit. Select the Everyone check box to check all users in the system.
6. From the center column, select the check boxes corresponding to the products you wish to check or click Select All.
7. Click Audit.
8. The number of licenses in use for each product specified is displayed in the right column.

**Determine a user's privileges for a product(s)**

**Steps**
1. Open the License Manager.
2. From the File menu, choose Connect; the Login dialog box opens.
3. Select a Project Source and type your login ID and password.
4. Click OK to activate and access the tool.
5. From the Available Groups list, select Everyone or the specific user group to audit.
6. From the center column, select the products to check or click Select All.
7. Click Audit.
8. The number of licenses in use for each product specified is displayed in the right column. Click on a product or number of licenses to open the Product Information window and display details about those licenses (users/groups and privileges).
9. In the Details window, click on a Current User to display the privileges the user holds for the specified product. Click on a privilege to display its description.
10. Click Print to print the details or Close to return to the main screen.

**Upgrade licenses**

**Steps**
1. Open the License Manager.
2. From the File menu, select Licenses. The Installed Products dialog box opens and displays a list of MicroStrategy products currently installed.

3. Enter the new CD key (provided by MicroStrategy) and click OK. The licenses are upgraded accordingly.

Log Viewer

What is it?

The Log Viewer is a tool designed to help you view diagnostic information generated by MicroStrategy products.

How do I access it?

1. Locate the M6LOGVWR.EXE file. By default, the .exe file can be found in the following path:
C:\Program Files\Common Files\MicroStrategy\M6LOGVWR.EXE

2. Double-click the M6LOGVWR.EXE file to launch the Log Viewer.

What can I do with it?

Through the Log Viewer you can:

- view, manipulate, and save log files
- view active tracing information

For instructions on completing one of the above tasks refer to the following How do I...? topic:
Diagnostics

What should I know before I use it?

Before you begin using the viewer, you should:

- know what log files you wish to view
- understand how to read the log files

For more information on the above topics, refer to the following topic:
Appendix B: Diagnostics
Log Viewer layout

When viewing a log file, the Log Viewer provides you with the following information:

<table>
<thead>
<tr>
<th>Column name</th>
<th>Information displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry ID</td>
<td>Line number of the log file</td>
</tr>
<tr>
<td>Process ID</td>
<td>ID of the process which performed the action</td>
</tr>
<tr>
<td>Thread ID</td>
<td>ID of the thread which performed the action</td>
</tr>
<tr>
<td>Time</td>
<td>Date and time at which the action happened</td>
</tr>
<tr>
<td>Module</td>
<td>Name of the MicroStrategy component which performed the action</td>
</tr>
<tr>
<td>Error/Trace Type</td>
<td>Displays the type of the log file entry</td>
</tr>
<tr>
<td>Message</td>
<td>Message about the action</td>
</tr>
</tbody>
</table>

Log Viewer toolbar and menu options

The following toolbar and menu options are specific to the main window of the Log Viewer.

<table>
<thead>
<tr>
<th>Location and Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window menu</td>
<td></td>
</tr>
<tr>
<td>• Cascade</td>
<td>Arranges all opened Log Viewer windows in a cascading pattern, one on top of the other with the title bars showing.</td>
</tr>
<tr>
<td>• Tile Horizontallyv</td>
<td>Arranges all opened Log Viewer windows horizontally.</td>
</tr>
<tr>
<td>• Tile Vertically</td>
<td>Arranges all opened Log Viewer windows vertically.</td>
</tr>
<tr>
<td>• Arrange Icons</td>
<td>Arranges all minimized windows along the bottom of the Log Viewer window.</td>
</tr>
<tr>
<td>• Show Registered Logs</td>
<td>Opens the Registered Logs window.</td>
</tr>
<tr>
<td>• Show Debug Monitor</td>
<td>Opens the Debug Monitor window.</td>
</tr>
<tr>
<td>Tools menu</td>
<td></td>
</tr>
</tbody>
</table>
### Location and Name | Definition
---|---
Error Lookup | Opens the Error Lookup dialog.

**Main toolbar**

<table>
<thead>
<tr>
<th>Location and Name</th>
<th>Definition</th>
</tr>
</thead>
</table>
New | Opens a new, empty log file. |
Open | Allows you to open an existing log file. |
Cascade | Arranges all opened Log Viewer windows in a cascading pattern, one on top of the other with the title bars showing. |
Tile Horizontally | Arranges all opened Log Viewer windows horizontally. |
Tile Vertically | Arranges all opened Log Viewer windows vertically. |
Arrange Icons | Arranges all minimized windows along the bottom of the Log Viewer window. |
Show Registered Logs | Opens the Registered Logs window. |
Show Debug Monitor | Opens the Debug Monitor window. |
Load preference file | Allows you to load a saved preferences file for the Log Viewer. |
Set Diagnostics Settings | Opens the Diagnostics Configuration Editor. |

The following toolbar and menu options are specific to the windows in which you view and manipulate log files.

### Location and Name | Definition
---|---
Log window toolbar |  |
Add logs | Allows you to open another log file, which will be appended to the end of the current log file. |
Save Filtered Logs As | Allows you to save the log file with any sorts, filters, and color codes you may have created. |
Save Logs As | Allows you to save the log file. Note that any sorts, filters, or color codes you may have created will not be saved with this save option. |
Close Viewer | Closes the current log file window. |
Test Listener

What is it?

Test Listener is a ping utility that allows you to check the availability of a MicroStrategy Intelligence Server on your network.

How do I access it?

1. Locate the TESTLISTENER.EXE file. This file is typically located in the following folder:
   C:\Program Files\Common Files\MicroStrategy\TESTLISTENER.EXE

2. Double-click the TESTLISTENER.EXE file icon to start Test Listener.

<table>
<thead>
<tr>
<th>Location and Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Find</td>
<td>Opens a search editor which allows you to search the log file.</td>
</tr>
<tr>
<td>• Sort Logs</td>
<td>Opens the Sort window which allows you to sort the log file.</td>
</tr>
<tr>
<td>• Filter Logs</td>
<td>Opens the Filter Sets window which allows you to filter the log file.</td>
</tr>
<tr>
<td>• Code Logs</td>
<td>Opens the Code window which allows you to color code the log file.</td>
</tr>
<tr>
<td>• Send Logs</td>
<td>Opens the Mail Logs To window which allows you to email the log file to someone.</td>
</tr>
<tr>
<td>• Print Logs</td>
<td>Allows you to print the log file.</td>
</tr>
<tr>
<td>• Column settings</td>
<td>Opens the Column settings dialog which allows you to rearrange the columns in the Log Viewer.</td>
</tr>
<tr>
<td>• Refresh contents of logs</td>
<td>Refreshes the log file display.</td>
</tr>
<tr>
<td>• Save Preferences</td>
<td>Opens a Save dialog which allows you to save your preferences to a file for use at another time.</td>
</tr>
</tbody>
</table>
**What can I do with it?**

Test Listener allows you to

- ping a MicroStrategy Intelligence Server to see if it is available
- view a list of available MicroStrategy Intelligence Servers on your subnetwork
- view information about a particular MicroStrategy Intelligence Server

**Test Listener layout**

The Test Listener interface consists of a single dialog box. This dialog box contains the following controls:

- **Hide down machines check box:** allows you to hide or show servers that are currently not functioning in the Available Servers list.
- **Get List button:** displays a list of available servers.
- **Details button:** displays information about a particular server in the
- **Ping button:** tests the availability for the server name that appears in the Server text box.
- **Close button:** quits the utility.

The interface also displays the following information:

- **Status display area:** located at the top of the dialog box, this area shows whether or not the selected server answered the ping.
- **Available Servers list:** displays the servers on your network and indicates which servers are up (functioning) and which are down (not functioning).
- **Server text box:** displays the server name that is selected in the Available Servers list.
- **Server information area:** located in the bottom portion of the dialog box, this area displays information about a specific server. This information includes:
  - Machine Name
  - IP Address
  - State
  - Version
  - Response Time, in milliseconds
Index

A
access control
  definition 29
  permissions 34
  privileges 34
access control list
  definition 35
Analytical Engine 19
auditing 29
authentication
  anonymous 33
  database authentication 33
definition 29
standard 32
Windows NT 33

B
boilerplate ii
browsing
  element browsing 25
  object browsing 25

C
Cache Monitor 63
caching
  cache matching requirements 43
  Cache Monitor 63
  cache storage 42
  database connection caching 11, 14, 43
definition 41
  element cache 42
  object cache 42
  report cache 42
  settings 107
Cluster Monitor 67
clustering
  architecture 51
cache synchronization 52
Cluster Monitor 67
definition 49
failover 50
load balancing 50
metadata synchronization 52
connection caching 11, 14
connection mapping 12, 108
connection string 10
copyright information, actual imported ii

D
data source name 10
data warehouse
  definition 12
database
  basic structure 9
catalog 9
  communicating with databases 10
database 9
database authentication 33
database connection 13, 74
database connection caching 11, 14, 43
database instance 12
database login 13
database server 9
  security 29
table 9
database connection
  Database Connection Monitor 69
definition 13
Database Connection Monitor 69
database instance
  Database Instance Editor 71
  Database Instance Manager 75
  Database Instance Wizard 77
definition 12
Database Instance Editor 71
Database Instance Manager 75
Database Instance Wizard 77
database level security
  partitioned fact tables 30
  security views 30
  split fact tables 31
database login
definition 13
diagnostics
  Debug Monitor 218
  Diagnostics Configuration Editor 79
  log files 217
  Log Viewer 248
  performance counters 218
  sample log file 218
Diagnostics Configuration Editor 79
drilling 24
DSN
  See data source name

E
editors
  Database Instance Editor 71
  Diagnostics Configuration Editor 79
  Group Editor 85
  MicroStrategy Server Configuration Editor 95
  Project Configuration Editor 105
  Security Role Editor 127
  User Editor 131
  VLDB Properties Editor 223
element browsing 25
element server 19
engine
  Analytical Engine 19
  Query Engine 19
  SQL Engine 18, 19
Event Viewer 83
events
  Event Viewer 83

F
failover 50
filters
  security filters 37

G
governing
  definition 4
  project level 5, 107
  server level 5
Group Editor 85
groups
  Group Editor 85

H
history list 7

J
job
  definition 17
  Job Monitor 87
  job processing 17
  priority 12, 26
  task 18
  user requests 18
  Job Monitor 87
  Job Prioritization Wizard 91
job processing
  basic report execution 21
  drilling 24
  element browsing 25
  execution flow 19
  job execution from MicroStrategy Web 26
  object browsing 25
  overview 17
  report execution with a prompt 23
  report execution with caching 23

L
legal information ii
License Manager 245
load balancing 12, 50
log files
  format 217
  sample log file 218
Log Viewer 248

M
managers
  Database Instance Manager 75
  MicroStrategy Server Service Manager 99
  Schedule Manager 117
User Manager 133
metadata repository
definition 12
MicroStrategy Intelligence Server
Test Listener 251
MicroStrategy Server
clustering 49
failover 50
load balancing 50
MicroStrategy Server Configuration Editor 95
shutdown 4
start-up 3
MicroStrategy Server Configuration Editor 95
MicroStrategy Server Service Manager 99
MicroStrategy Web
Administrator page 59
default project options 60
job execution from 26
Web administration privilege 59
Web Administrator page 101
monitoring
Cache Monitor 63
Cluster Monitor 67
Database Connection Monitor 69
Job Monitor 87
Project Monitor 111
Schedule Monitor 119
User Connection Monitor 129

Object browsing 25
Object Server 19
ODBC
advanced settings 74
connection string 10
data source name 10
definition 10
driver 10
driver manager 11
Open Database Connectivity
See ODBC

Performance counters 218
Priority
definition 26
Job Prioritization Wizard 91
job prioritizations 73
Privileges
types of privileges 34
Project Configuration Editor 105
Project modes
definition 5
evaluation idle 6
full idle 6
loaded 6
request idle 6
unload pending 7
unloaded 7
Project Monitor 111
Project Mover Wizard 113
Projects
Project Configuration Editor 105
Project modes 5
Project Monitor 111
Project Mover Wizard 113
registration 5

Query engine 19

Report cost 27
Report Server 19
Reports
report execution 20
report instance 20
scheduling 46
Resolution Server 18, 19

Schedule Manager 117
Schedule Monitor 119
Schedule Wizard 123
Schedules
cache refreshing 47
Event Viewer 83
event-triggered 45, 46
report scheduling 46
Schedule Manager 117
Schedule Monitor 119
Schedule Wizard 123
time-triggered 45, 46

security
access control 29, 34
access control list 35
auditing 29
authentication 29, 32
connection mapping 108
database level security 29
database views 30
groups 36
network security 32
operating system security 32
partitioned fact tables 30
permissions 239
privileges 241
security filters 37, 108
Security Role Editor 127
security roles 37, 108
split fact tables 31
users 36
security filters
settings 108
Security Role Editor 127
security roles
Security Role Editor 127
settings 108
server
element server 19
Object Server 19
Report Server 19
Resolution Server 18, 19
See also MicroStrategy Intelligence Server
service
MicroStrategy Server service 3
MicroStrategy Server Service Manager 99
SQL Engine 18, 19
statistics
definition 209
schema 209
settings 108
statistics database 12

T
task
definition 18
task list 20
Test Listener 251

U
User Connection Monitor 129
User Editor 131
User Manager 133
User Manager Integrity Checker 135
user requests
definition 18
users
User Connection Monitor 129
User Editor 131
User Manager 133
User Manager Integrity Checker 135

V
VLDB properties 12, 13, 73, 75, 107, 223
VLDB Properties Editor 223

W
Windows NT
authentication 33
Performance Monitor 218
service 3
wizards
Database Instance Wizard 77
Job Prioritization Wizard 91
Project Mover Wizard 113
Schedule Wizard 123